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Introduction

Thank you for purchasing a Panasonic product. Before you use the product, please carefully
read through the user’s manual, and understand it in detail to use the product properly.

Types of Manual

● There are different types of user’s manual for the FP7 series, as listed below. Please refer to
a relevant manual for the unit and purpose of your use.

● The manuals can be downloaded from the Panasonic website:https://
industry.panasonic.com/global/en/downloads/?tab=manual.

Unit name or purpose of
use Manual name Manual code

FP7 Power Supply Unit FP7 CPU Unit User’s Manual
(Hardware)

WUME-FP7CPUH

FP7 CPU Unit

FP7 CPU Unit Command Reference Manual WUME-FP7CPUPGR

FP7 CPU Unit User’s Manual
(Logging Trace Function)

WUME-FP7CPULOG

FP7 CPU Unit User’s Manual
(Security Function)

WUME-FP7CPUSEC

Instructions for Built-in
LAN Port

FP7 CPU Unit User’s Manual
(LAN Port Communication)

WUME-FP7LAN

FP7 CPU Unit User’s Manual
(Ethernet Expansion Function)

WUME-FP7CPUETEX

FP7 CPU Unit User’s Manual
(EtherNet/IP Communication)

WUME-FP7CPUEIP

Web Server Function Manual WUME-FP7WEB

Instructions for Built-in
COM Port

FP7 Series User’s Manual
(SCU Communication)

WUME-FP7COMFP7 Extension Cassette
(Communication)
(RS-232C / RS485 type)

FP7 Extension Cassette
(Communication)
(Ethernet Type)

FP7 Series User’s Manual
(Communication Cassette Ethernet Type)

WUME-FP7CCET

FP7 Extension (Function)
Cassette
Analog Cassette

FP7 Analog Cassette User’s Manual WUME-FP7FCA

FP7 Digital Input / Output Unit FP7 Digital Input / Output Unit User’s Manual WUME-FP7DIO

FP7 Analog Input Unit FP7 Analog Input Unit User’s Manual WUME-FP7AIH

FP7 Analog Output Unit FP7 Analog Output Unit User’s Manual WUME-FP7AOH

FP7 Thermocouple Multi-
analog Input Unit

FP7 Thermocouple Multi-analog Input Unit
FP7 RTD Input Unit
User’s Manual

WUME-FP7TCRTD
FP7 RTD Input Unit

FP7 Multi Input / Output Unit FP7 Multi Input / Output Unit User’s Manual WUME-FP7MXY

FP7 High-speed counter unit FP7 High-speed Counter Unit User’s Manual WUME-FP7HSC

FP7 Pulse Output Unit FP7 Pulse Output Unit User’s Manual WUME-FP7PG
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Unit name or purpose of
use Manual name Manual code

FP7 Positioning Unit FP7 Positioning Unit User’s Manual WUME-FP7POSP

FP7 Serial Communication
Unit FP7 Series User’s Manual (SCU Communication) WUME-FP7COM

FP7 Multi-wire Link Unit FP7 Multi-wire Link Unit User’s Manual WUME-FP7MW

FP7 Motion Control Unit FP7 Motion Control Unit User’s Manual WUME-FP7MCEC

PHLS System PHLS System User’s Manual WUME-PHLS

Programming Software
FPWIN GR7

FPWIN GR7 Introduction Guidance WUME-FPWINGR7
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Safety Precautions

● Observe the following precautions to ensure personal safety or to prevent accidents.
● Before performing installation, operation, maintenance, or inspection, read this manual carefully to

understand how to use the product correctly.
● Make sure that you fully understand the product, information on safety, and other precautions.
● This manual uses two safety symbols, different levels of safety precautions “Warning” and “Caution”, to

indicate .

Indicates a potentially hazardous situation which, if not handled correctly, could result in
death or serious injury of the user.

● Take safety measures outside the product to ensure the safety of the entire system even if this product fails
or an error occurs due to external factors.

● Do not use this product in atmospheres that contain flammable gases.
Doing so may result in explosion.

● Do not throw this product into the fire.
Doing so may cause the batteries or other electronic parts to explode.

Indicates a potentially hazardous situation which, if not handled correctly, could result in
injury to the user or property damage.

● To prevent abnormal heat generation or smoke generation, use this product with some leeway from the
guaranteed characteristics and performance values of the product.

● Do not disassemble or modify this product.
Doing so may result in abnormal heat generation or smoke generation.

● Do not touch any terminals while the power is on.
Doing so may result in electrical shock.

● Configure emergency stop and interlock circuits outside this product.
● Connect wires and connectors properly.

Failure to do so may result in abnormal heat generation or smoke generation.
● Do not perform work (such as connection or removal) with the power turned on.

Doing so may result in electrical shock.
● If this product is used in any way that is not specified by Panasonic, its protection function may be impaired.
● This product has been developed and manufactured for industrial use only.

Copyright / Trademarks

● The copyright of this manual is owned by Panasonic Industry Co., Ltd.
● Unauthorized reproduction of this manual is strictly prohibited.
● Windows is a registered trademark of Microsoft Corporation in the U.S. and other countries.
● Other company and product names are trademarks or registered trademarks of their respective companies.

Handling Precautions

■ In this manual, the following symbols are used to indicate safety information that
must be observed.

Indicates an action that is prohibited or a matter that requires caution.

Indicates an action that must be taken.

Indicates supplemental information.

Indicates details about the subject in question or information useful to remember.
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Indicates operation procedures.
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1.1 Unit Functions and Operation

1.1.1 Unit Functions

■ Inputs and outputs allocated flexibly
● As sixteen inputs and sixteen outputs can be allocated to various functions according to

purposes to be used, effective system configuration can be achieved.
● Voltage detection circuits are built in the inputs and they recognize input voltage

automatically. Any of the voltages of 24 VDC, 12 VDC and 5 VDC can be used.
● For outputs, the MOSFET of both Pch and Nch is adopted, and they can be used in any of

the modes, sink output, source output, push-pull output (negative logic) and push-pull output
(positive logic). When setting the push-pull output, a high-speed response can be obtained.

Input/Output Allocated function

Input

Interrupt input: Max. 8 points
High-speed counter: Max. 4 channels (Count input: 2 points, Reset input: 1 point, Mask input:
1 point)

Input for positioning: Max. 4 channels(Note 1)

Output
Comparison match output: Max. 8 points
Pulse output or PWM output: Max. 4 ch
Positioning pulse output: Max. 4 ch

 

(Note 1) The positioning function is available only for the FP7 Multi I/O Unit (H type).
 

■ Equipped with various functions
One unit is equipped with the following functions.

1.1 Unit Functions and Operation
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Function name Overview

Interrupt
Besides the interrupt control by external inputs, the interrupt control by the comparison
match with counter elapsed values is also available. High-speed response independent of
scan time can be obtained.

Counter

The count method can be selected from direction distinction, individual input, and phase
input. Frequencies can also be measured.
An elapsed value hold function for storing the count value when a trigger occurs is
provided. The count value independent of the scan time of PLC can be confirmed.

Comparison
The output can be obtained by comparing the counter elapsed value and an aribtrary
value. It can be used as the output of multistage counter by optionally combining with
counter channels.

Pulse output/PWM
output

The pulse output function is provided which achieves an easy positioning control with one
unit. The control by the PWM output is also be available. The counter for the pulse
output/PWM output is equipped with four channels, and it can also be applied to
operations such as switching the frequency at the time of constant pulse output or target
value matched.

Positioning(Note 1)
User programs can be simplified by adopting the table setting.
Positioning controls can be selected the follwoing four patterns; E-point control, P-point
control, C-point control and J-point control.

 

(Note 1) The positioning function is available only for the FP7 Multi I/O Unit (H type).
 

1.1.2 Unit Type and Product Number

■ Unit type and available functions

Product name FP7 Multi Input/Output Unit
FP7 Multi Input/Output Unit
H type

Product no. AFP7MXY32DWD AFP7MXY32DWDH

Interrupt Function Available Available

Counter Function Available Available

Comparison Output Function Available Available

Pulse Output/PWM Output
Function

Available Available

Positioning Function - Available

1.1 Unit Functions and Operation
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1.2 Restrictions on Units Combination

1.2.1 Restrictions by Power Consumption

The unit has the following internal current consumption. Make sure that the total current
consumption is within the capacity of the power supply with consideration of all other units used
in combination with this unit.

Name Product no. Current consumption

FP7 Multi Input/Output Unit AFP7MXY32DWD 100 mA or less

FP7 Multi Input/Output Unit (H type) AFP7MXY32DWDH 100 mA or less

1.2.2 Applicable Versions of FPWIN GR7 and Units

For using the multi input/output unit, the following versions of FPWIN GR7 and units are
required.

Item Applicable version

Programming tool software
FPWIN GR7

AFP7MXY32DWD Ver.2.10 or later
AFP7MXY32DWDH Ver.2.12 or later

FP7 CPU Unit CPS4* / CPS3*: Ver.1.2 or later, CPS2*: Ver.1.0 or later

FP7 Positioning Unit For using the interrupt function with the multi input/output unit, the positioning
unit ver.1.1 or later is required.

■ Procedure of confirming the unit version
Pressing the [[Unit information]] button in the ""Status display"" dialog box under "Online" of
FPWIN GR7 displays the unit version.

1.2 Restrictions on Units Combination
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(Note 1) When an ""*"" is displayed in the INT column, it indicates that the mode setting switch on the side of
the unit is set to ""Use the interrupt function"".

 

1.2.3 Restrictions on Interrupt Function

The multi input/output unit can start an interrupt program of the CPU unit using an interrupt
input or counter comparison match flag. The interrupt function can be used within the following
range.

■ Interrupt program specifications

Item Specifications

No. of
interrupt
programs

Per multi I/O unit Max. 8 programs

Per CPU unit Max. 64 programs (8 programs x 8 units)
 

(Note 1) If interrupts occur many times in one scan, the execution of interrupt program has priority, and the
scan time will be longer.

(Note 2) If more than one interrupt activation request is made from the unit, the process will be carried out from
the smallest slot number or the smallest interrupt program number.

 

1.2.4 Restrictions on I/O Allocation

● Any one of functions allocated to the same I/O number can be used. The inputs that are not
allocated to any functions can be used as general inputs.

● Functions to be allocated are specified on the configuration dialog box of tool software
FPWIN GR7. Allocate used input and output numbers not to be overlapped.

■ Input signal

Termin
al
numbe
r

I/O no.
Functions

Interrupt
input Counter Counter elapsed

value hold mode Positioning

A1 X0 - CH0 IN-A CH0 Z

1.2 Restrictions on Units Combination
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Termin
al
numbe
r

I/O no.
Functions

Interrupt
input Counter Counter elapsed

value hold mode Positioning

A2 X1 - CH0 IN-B
CH0 DOG

CH0 JPOS

A3 X2 - CH0 RST CH0 LMT+

A4 X3 - CH0 MASK CH0 LMT-

A5 X4 - CH1 IN-A CH1 Z

A6 X5 - CH1 IN-B
CH1 DOG

CH1 JPOS

A7 X6 - CH1 RST CH1 LMT+

A8 X7 - CH1 MASK CH1 LMT-

B1 X8 INT0 CH2 IN-A CH0 TRG CH2 Z

B2 X9 INT1 CH2 IN-B - CH2 DOG

B3 XA INT2 CH2 RST - CH2 LMT+

B4 XB INT3 CH2 MASK - CH2 LMT-

B5 XC INT4 CH3 IN-A CH1 TRG CH3 Z

B6 XD INT5 CH3 IN-B - CH3 DOG

B7 XE INT6 CH3 RST - CH3 LMT+

B8 XF INT7 CH3 MASK - CH3 LMT+
 

(Note 1) Either DOG or JPOS is selectable.
 

● Interrupt inputs can be set by one point. A maximum of eight points can be set.
● For the counter function, four inputs are occupied per channel. (Counter input: 2 points, Reset

input: 1 point, Mask input: 1 point)
● When using the counter elapsed value hold mode, one trigger input of the counter CH0 or CH1

is occupied.
● For the positioning function, four inputs are occupied per axis.
● The inputs that are not allocated to the interrupt input, counter or positioning function can be

used as general external inputs. Also, when the interrupt inputs INT0 to INT7 are allocated to
""comparison match"", the corresponding inputs (X8 to XF) can be used as general external
inputs.

■ Output signal

Termi
nal
numb
er

I/O no.
Functions

Comparison Pulse output PWM output Positioning

A11 Y0 CMP0 - - -

A12 Y1 CMP1 - - -

A13 Y2 CMP2 - - -

1.2 Restrictions on Units Combination
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Termi
nal
numb
er

I/O no.
Functions

Comparison Pulse output PWM output Positioning

A14 Y3 CMP3 - - -

A15 Y4 CMP4 - - CH0 CLR

A16 Y5 CMP5 - - CH1 CLR

A17 Y6 CMP6 - - CH2 CLR

A18 Y7 CMP7 - - CH3 CLR

B11 Y8 - PLS0 A PWM0 PLS0 A

B12 Y9 - PLS0 B - PLS0 B

B13 YA - PLS1 A PWM1 PLS1 A

B14 YB - PLS1 B - PLS1 B

B15 YC - PLS2 A PWM2 PLS2 A

B16 YD - PLS2 B - PLS2 B

B17 YE - PLS3 A PWM3 PLS3 A

B18 YF - PLS3 B - PLS3 B

● Comparison outputs can be set by one point.
● A maximum of eight points can be set. The pulse output/PWM output function can be set for a

maximum of four channels.
● The outputs that are not allocated to the comparison ouput, pulse ouput/PWM output or

positioning function can be used as general external outputs. Also, when selecting the PWM
ouput, the outputs (Y9, YB, YD, YF) can be used as general external outputs.

1.2 Restrictions on Units Combination

WUME-FP7MXY-06 1-7



(MEMO)

1-8 WUME-FP7MXY-06



2 Names and functions of parts
2.1  Names and functions of parts .............................................................2-2

2.1.1  Names and functions of parts .......................................................... 2-2
2.1.2  Operation monitor LEDs .................................................................. 2-2
2.1.3  Mode setting switches...................................................................... 2-3

WUME-FP7MXY-06 2-1



2.1 Names and functions of parts

2.1.1 Names and functions of parts

■ Names and functions of parts

No. Name Functions

(1) Operation monitor
LEDs

Indicates the operation mode, error occurrence state and input and output
states. For details, refer to ""2.1.2 Operation monitor LEDs"".

(2) I/O connector Connector for input and output. (40-pin) (Conforms to MIL standard.)

(3) DIN hook This hook is used to install the unit on a DIN rail.

(4) Unit connector Connects the internal circuits between units.

(5) Mode setting
switches

Change the switch to use the interrupt function. At the factory setting, all the
switches are off (the setting not to use the interrupt function). For details, refer
to ""2.1.3 Mode setting switches"".

(6) Fixing hook This hook is used to fix units.

2.1.2 Operation monitor LEDs

LED Content Col
or

LED ON LED OFF LED Flashing

1 - Power supply of the unit Blu
e ON OFF ―

2.1 Names and functions of parts
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LED Content Col
or

LED ON LED OFF LED Flashing

2 X0-XF Input signal monitor(Note 1)(Note 2) Gre
en Displays the status of the input signal.

3 Y0-YF Output signal monitor(Note 1) Gre
en Displays the status of the output signal.

4 YN Output polarity display(Note 3)(Note

4)
Gre
en

Turns on when there is an output that is set to ""Sink
output"" or ""Push-pull output (negative logic)"".

5 YP Output polarity display(Note 3)(Note

4)
Gre
en

Turns on when there is an output that is set to
""Source output"" or ""Push-pull output (positive
logic)"".

6 ERR Alarm/Error/Warning occurrence
display

Re
d

At the time of alarm/
error occurrence

In normal
operation

At the time of
warning
occurrence

 

(Note 1) The LEDs for the input and output both look as if they are continuously lit because the flashing speed
is fast when the frequencies of signals are high.

(Note 2) The LED for each input signal indicates the status after input time constant processing.
(Note 3) The output polarity display switches according to the output polarity setting using the tool software or a

program.
(Note 4) When the output polarity is not set by the software or program, both YN and YP will turn off. Also,

when the settings of sink, source, push-pull (negative logic) or push-pull (positive logic) are mixed, the
YN and YP turn on according to the polarity, and a warning occurs simultaneously.

 

2.1.3 Mode setting switches

No. Description

1 ON: Use the interrupt function, OFF: Not use the interrupt function

2
3
4

Not available. They should be always OFF.

 

(Note 1) At the factory setting, the mode setting switch number 1 is set to ""OFF"" (the setting not to use the
interrupt function).

 

2.1 Names and functions of parts
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3.1 Input/Output Specifications

3.1.1 Characteristics of Input/Output Circuits

The I/O circuits of the FP7 Multi I/O Unit incorporate the following mechanism. Make the setting
of the actual inputs/outputs and the settings on the software be the same.

■ Input circuit
The multi I/O unit has a circuit for detecting an input voltage and switching the input impedance.
This can be used at either 24 V, 12 V, or 5 V. The voltage mode is set by the software. The input
current varies according to the input voltage.

■ Output circuit
A MOSFET is built in, and it can be used in any of the sink output, source output, push-pull
(negative logic output) and push-pull (positive logic output) modes. The output mode is selected
by the software.

3.1.2 I/O Terminal Layout Diagram

■ Terminal layout diagram
The input is allocated to the upper 20 pins (A1 to A10/B1 to B10) of the connector, and the
output is allocated to the lower 20 pins (A11 to A20/B11 to B20).

3.1 Input/Output Specifications

3-2 WUME-FP7MXY-06



■ External connection diagram

In Sink output mode or Push-pull output (negative
logic) mode

In Source output mode or Push-pull output
(positive logic) mode

 

(Note 1) COM0 to COM3 are independent common terminals. They are not internally connected.
(Note 2) The two plus terminals (A19 and B19) on the output side are connected internally, and the two minus

terminals (A20 and B20) are connected internally.
(Note 3) The voltages of the external power supply of the output circuit and the power supply for the load circuit

should be within the range of 5 to 24 V.
 

Input Specifications

Item
Specifications

5 - 24 V mode 12 - 24 V mode

Insulation system Digital isolator

Rated input voltage 5 V/12 V/24 V DC(Note 1)

Rated input current Approx. 2 mA to approx. 10 mA (It automatically varies according to the input
voltage.)

Input impedance Approx. 0.5 kΩ to approx. 4.3 kΩ (It automatically varies according to the
input voltage.)

Operating voltage range ±10% of each voltage

Min. ON voltage/Min. ON current 4.2 V / 3 mA 7.5 V / 3 mA

Min. OFF voltage/Min. OFF
current 2.8 V / 1 mA 5.0 V / 1 mA

Response time OFF→ON
1.0 µs or less (at 5 V DC)
0.5 µs or less (at 12 V DC)
0.5 µs or less (at 24 V DC)

3.1 Input/Output Specifications
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Item
Specifications

5 - 24 V mode 12 - 24 V mode

ON→OFF
1.0 µs or less (at 5 V DC)
2.0 µs or less (at 12 V DC)
3.5 µs or less (at 24 V DC)

Min. input pulse width
1.0 µs (at 5 V/12 V DC)
2.0 µs (at 24 V DC)

Input time constant setting
0, 0.5 μs/1 μs/1.5 μs/2 μs/4 μs/8 μs/16 μs/32 μs/64 μs/96 μs/128 μs/256 μs/
2 ms/4 ms/8 ms(Note 2)

Output points per common 4 points/1 common (±common)
 

(Note 1) The mode of input voltage is selected by software. The default is the 5-24 V mode.
(Note 2) The default value of input time constant is 2 µs.
 

■ Limitations on number of simultaneous input on points

 

(Note 1) There is no limitation on the number of simultaneous on points in the ambient temperature range
between 0 to 55°C when using 12 V DC or 5 V DC.

 

● Use the input voltage within ±10% of 5 V, 12 V or 24 V. Heat or chattering may be
generated when using a voltage out of this range.

■ Internal circuit diagram and external connection diagram

R1 = 10 kΩ, R2a = 4.3 kΩ, R2b = 5.6 kΩ, R2c = 510 Ω

3.1 Input/Output Specifications
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(1) Voltage detection circuit (2) Internal circuit

■ Characteristics of input circuit
● The multi I/O unit has a circuit for detecting an input voltage and switching an input

impedance. See the following table as a guide for input impedances when using each
voltage.

Voltage Input impedance

5 V 1/ {(1/4.3 kΩ)+(1/5.6 kΩ)+(1/510 Ω) }≒ 420 Ω

12 V 1/ {(1/4.3 kΩ)+(1/5.6 kΩ) }≒ 2.43 kΩ

24 V 4.3 kΩ

● Input impedances are switched in three stages in the 5-24 V mode, and in two stages in the
12-24 V mode. Input currents vary like the following graphs. The respective minimum ON
voltages and maximum OFF voltages in the 5-24 V mode and 12-24 V mode are different.

3.1.3 Output Specifications

Item Specifications

Insulation system Digital isolator

Output device MOSFET

Output method(Note 1) Nch open drain / Pch open drain / Push-pull

Rated load voltage 5 V DC to 24 V DC

Allowable load voltage range 4.75 V DC to 26.4 V DC

Max. load current 0.1A

Off state leakage current 3.0 µA or less

ON Max. voltage drop 1.0 V DC or less

Response time
OFF→ON 0.5 µs or less(Note 2)

ON→OFF 0.5 µs or less(Note 2)

External power
supply

Voltage 4.75 V DC to 26.4 V DC

3.1 Input/Output Specifications
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Item Specifications

Current 100 mA or less

Output points per common 16 points/common (common to external power supply terminals)

Surge absorber Zener diode

Operating mode indicator LED display
 

(Note 1) The output method is selected by the software. The both polarities are off at the time of startup. The
output polarity must be set.

(Note 2) This shows the response time when the push-pull method is set and the output current is 0.1 A. It
varies according to the setting of the output method and load.

(Note 3) The voltages of the external power supply for the output circuit and the power supply for the load
circuit should be within the range of 5 to 24 V. When supplying power for the external power supply
and that for the load circuit from other power supplies, the load circuit voltage (V2) must be the same
as or smaller than the external supply voltage (V1). When the load circuit voltage (V2) is larger than
the external supply voltage (V1), the current flows back as below.

In the case of sink output In the case of source output

 

■ Internal circuit diagram and external connection diagram

Setting mode Internal circuit diagram and external connection diagram

Sink output

3.1 Input/Output Specifications
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Setting mode Internal circuit diagram and external connection diagram

Source output

Push-pull
Negative logic
output

When the operation result output Y is 1, the Pch turns off and Nch turns on, and
energization to the load is performed.

Push-pull
Positive logic
output

When the operation result output Y is 1, the Pch turns on and Nch turns off, and
energization to the load is performed.

3.1 Input/Output Specifications
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3.2 Wiring of Input and Output

3.2.1 Common Precautions to Input and Output

■ Wiring position
Arrange the wiring so that the input and output wiring are separated, and these wirings are
separated from the power wiring, as much as possible. Do not route them through the same
duct or tie them in a bundle. Separate the input/output wires from the power and high voltage
wires by at least 100 mm.

■ Selection of wires
Be sure to select the thickness (dia.) of the input and output wires while taking into
consideration the required current capacity.

■ Power supply
Wiring should be performed after the power supply to the PLC is turned off. Performing this
while the power supply is on may cause an accident, fault or malfunction.

3.2.2 Input Wiring

The following figures show the case when they are connected with the + common.

■ Connection of photoelectric sensor and proximity sensor

Relay output type

NPN open collector output type

Voltage Output Type

3.2 Wiring of Input and Output
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Two-wire output type

■ Precaution when Using LED-equipped Lead Switch
When an LED is connected in series to an input contact such as an LED-equipped lead switch,
make sure that the voltage applied to the PLC input terminal is greater than the ON voltage. In
particular, take care when connecting a number of switches in series.

■ Precaution when Using Two-wire Type Sensor
If input to the PLC does not turn off because of leakage current from a two-wire type
photoelectric sensor or a proximity sensor, connecting a bleeder resistor is recommended, as
shown below.

■ Precaution when Using LED-equipped Limit Switch
If the input of PLC does not turn off because of leakage current from the LED-equipped limit
switch, the use of a bleeder resistor is recommended, as shown below.

3.2.3 Output Wiring

The following figures show the case when they are connected with the sink output.

■ Protective circuit for inductive loads
With an inductive load, a protective circuit should be installed in parallel with the load.

3.2 Wiring of Input and Output
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■ Precautions when using capacitive loads
When connecting loads with large in-rush currents, to minimize their effect, connect a protection
circuit as follows.

3.2 Wiring of Input and Output
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3.3 Connection Using the Discrete-wire Connector

No discrete-wire connector is provided with the unit. Purchase it separately.

3.3.1 Specifications of Wire-pressed Terminal Cable

This is a connector allowing loose wires to be connected without removing the wire’s insulation.
A pressure connection tool is required to connect the loose wires.

Connector for wire-pressed terminal cable (40P)

■ Suitable wires (strand wire)

Size Nominal cross-sectional
area

Insulation thickness Rated current

AWG22 0.3 mm2 Φ1.5 to Φ1.1 3A

AWG24 0.2 mm2

■ Connector AFP2801 for wire-pressed terminal cable (provided with unit)

Composition of parts Required quantity

Housing (40P) 1 x 1 set

Semi-cover (40P) 2 x 1 set

5-pin contact (for AWG22 and 24) 8 x 1 set
 

(Note 1) One set is provided for the product. If you need more connectors, purchase AFP2801 (2 sets/pack).
 

■ Dedicated pressure welding tool

Product no. AXY52000FP

3.3 Connection Using the Discrete-wire Connector
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3.3.2 Wiring the Discrete-wire Connector

● When performing wiring work, refer to the instruction manual of the crimping tool in order
to prevent faulty wiring.

1. Bend and break the contact, and set it in the crimping tool.

2. Insert the wire without removing its insulation until it stops, and lightly grip the crimping tool.

3. The contact appears as shown below after it is crimped. Confirm the following two points.
1. The wire must be embraced inside the clamped part.
2. The wire must be inserted to the end.

4. Insert the wire with the contact into the housing.

3.3 Connection Using the Discrete-wire Connector
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5. When all the wires have been inserted, fit the semi-cover into place.

3.3 Connection Using the Discrete-wire Connector
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● If there is a wiring mistake or the wire is incorrectly press-fit, use the crimping tool to remove
the contact.
1. Set the pin of the crimping tool at the position indicated by an arrow.

2. Hold the housing with fingers and pull the wire.

3.3 Connection Using the Discrete-wire Connector
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3.4 Connection Using the Push-In Connector

3.4.1 About Push-In Connector

40-pole push-in type connector manufactured by Ningbo Degson Electronic Co. Ltd. that can be
used with the FP7 Series.

Product name Model number Remarks

Push-in connector set (40-pole) AFP2808 2 pcs.

3.4.2 Compatible Parts and Dedicated Tools

Pole terminal with insulating sleeve
Use the following pole terminals.

Manufacturer Model number Size Cross-sectional area

Phoenix Contact Co. Ltd AI0, 34-8TQ AWG#22 0.34 mm2

Dedicated pressure-welding tool for pole terminals

Manufacturer Model number

Phoenix Contact Co. Ltd CRIMPFOX 10S

3.4.3 Wiring to Connector

Installing onto the Unit

Follow the procedure below to install the product onto the unit.

1. Open out the clasps of the MIL connector.

3.4 Connection Using the Push-In Connector
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Clasps

MIL connector

2. Insert the product into the MIL connector. When inserting the product, make sure that the
triangular marking is at the top.

Triangular marking

3. Insert the product until the clasps of the MIL connector close.

3.4 Connection Using the Push-In Connector
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Wiring

Follow the procedure below when wiring.

Wiring precautions
● Do not damage the core when stripping off the covering material.
● Do not apply stress to the wires after wiring.
● Do not solder the core. Soldering the core may cause it to disconnect due to vibration.

1. Strip off the covering material from the wire

10 mm

2. Attach the pole terminal to the core part. Do not twist the core when attaching.

3. After attaching the pole terminal, pressure-weld using the dedicated pole terminal pressure-
welding tool.

4. After pressure-welding, insert the wire into the product.

3.4 Connection Using the Push-In Connector
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After inserting the wire, ensure that the wire does not protrude.

Replacing Wires

Follow the procedure below when replacing wires.

Use the following dedicated tool or an equivalent flat-head screwdriver to remove the wire.

Dedicated tool

Manufacturer Model number Remarks

Phoenix Contact Co. Ltd SZS 0, 4x2, 5 Blade width 0.4 × Blade thickness 2.5

1. Push the dedicated tool or flat-head screwdriver into the release button on the product.

3.4 Connection Using the Push-In Connector
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Release button

Dedicated tool or flat-head screwdriver

2. Remove the wire while pressing down the button.

3. Insert the new wire. For details on how to insert the wire, refer to "Wiring".

3.4 Connection Using the Push-In Connector
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● Pressing the release button unlocks the wires on both sides of the button. After replacing
the wires, ensure that the wires do not protrude.

3.4 Connection Using the Push-In Connector

3-20 WUME-FP7MXY-06



Removing from the Unit

Follow the procedure below to remove the product from the unit.

1. Open out the clasps of the MIL connector.

Clasps

MIL connector

2. Remove the product from the unit.

3.4 Connection Using the Push-In Connector
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3.4 Connection Using the Push-In Connector
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4.1 Unit Allocation

4.1.1 Number of Occupied I/O Points for the Unit

The input and output starts from the same I/O numbers in FP7 series. For the multi I/O unit, the
following number of words is occupied.

Product number Name Input Output

AFP7MXY32DWD FP7 Multi Input/Output Unit 4 words (64 points) 4 words (64 points)

AFP7MXY32DWDH FP7 Multi Input/Output Unit (H type) 6 words (96 points) 6 words (96 points)

4.1.2 Confirmation of I/O Allocation Information

The following I/O contacts are allocated for the multi I/O unit. The external inputs and external
outputs that are not allocated to any functions can be used as general inputs and outputs.

■ Input contact

Item I/O no. Functions

External
input

X0-X7 Counter (Input, reset mask) or positioning input

X8-XF Interrupt input or counter (Input, reset, mask) or positioning input

For control
Internal
input

X10-X17 Comparison contact monitor

X18-X1F Pulse output / PWM output monitor

X20-X27 Counter (Overflow flag, underflow flag)

X28-X2F (Reserved for system)

X30-X3B Positioning (Busy flag, operation done flag, home return done flag)

X30-X3F (Reserved for system)
 

(Note 1) The I/O numbers actually allocated are based on the first word number allocated to the unit.
Example) When the starting word number for the unit is ""10"", input contacts are numbered starting
from X100.

 

■ Output contact

Item I/O no. Functions

External
output

Y0-Y7 Comparison output or positioning (Deviation counter clear)

Y8-YF Pulse output / PWM output or positioning (Pulse output CW/CCW or pulse
output)

For control
Internal
output

Y10-Y17 Counter (Softwrae reset, mask), counter hold function (Enable, input logic)

Y18-Y1F Pulse output / PWM output (Enable, start)

Y20-Y27 Counter (Overflow clear, underflow clear)

Y28-Y2F Pulse output (Direction), pulse output counter (Reset)

Y30-Y34 Positioning (Positioning table start, positioning simultaneous start)

Y35-Y37 (Reserved for system)

4.1 Unit Allocation
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Item I/O no. Functions

Y38-Y3B Positioning (Home return start)

Y3C-Y43 Positioning (JOG operation start Forward/Reverse)

Y44 Positioning (System stop)

Y45-Y47 (Reserved for system)

Y48-Y4F Positioning (Emergency stop, deceleration stop)

Y50-Y55 Positioning (J-point control positioning start input, near home input, J-point
control speed change)

Y56 Positioning (Error clear)

Y57-Y5F (Reserved for system)
 

(Note 1) The I/O numbers actually allocated are based on the first word number allocated to the unit.
Example) When the starting word number for the unit is ""10"", output contacts are numbered starting
from Y100.

 

● For details of I/O allocation information, refer to ""13.2 Allocation of I/O Numbers"".

4.1.3 Registration in I/O Map

Before setting parameters, register the unit to be used in the I/O map. The following procedure
shows an example when FPWIN GR7 has been started and the CPU unit has been already
registered as the slot number 0 and the multi I/O unit is allocated to the slot number 1.

1. Select Options>FP7 Configuration>I/O map in the menu bar.
The "I/O Map Setting" dialog box is displayed.

2. Double-click a desired slot.
The "Unit Selection" dialog box is displayed.

3. Select the unit name to use in the "Select unit to use" field, and press the [[OK]] button.

4.1 Unit Allocation
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The selected unit is now registered in the I/O map.
The following figure shows the case that the input and output units have been registered
subsequently. The multi I/O unit occupies four words each for input and output.

4.1 Unit Allocation
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5.1 Basic Setup

The settings of the multi I/O unit are specified in the configuration menu of FPWIN GR7.
The input voltage mode, input time constant and output polarity can be switched by the setting
of the software. The default setting for the output is "Output OFF". Set this as appropriate.

1. Select Options>Multi I/O Unit Setting in the menu bar.

2. Select the type of Multi I/O Unit.

The basic setup screen of "Multi I/O Unit Setting" is displayed.

3. Set each item of the basic setup.

5.1 Basic Setup
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5.1.1 Basic setting item

Setting item Default Settings Related page

Double word
error
annunciation

Announce
Set whether or not to announce a double word access error
when it occurs.
Announce/Not announce

"P.12-4"

Warning
annunciation Announce

Set whether or not to announce a warning when it occurs.
Announce/Not announce

"P.12-7"

Input voltage
mode 5 V-24 V

Select either the 5V-24V mode or 12V-24V mode.
The switching operation of the impedance of the input circuit,
minimum ON voltage and maximum ON voltage vary
according to the selected mode.

"P.3-3"

Input time
constant 2 μs 0 / 0.5μs / 1μs / 1.5μs / 2μs / 4μs / 8μs / 16μs / 32μs / 64μs /

96μs / 128μs / 256μs / 2ms / 4ms / 8ms "P.3-3"

Output terminal
polarity Output Off

The output circuit is switched. Select to match the actual
wiring.
Output OFF: Output OFF
Sink output: N channel output
Source output: P channel output
N push-pull: Push-pull (negative logic)
P push-pull: Push-pull (positive logic)

"P.3-5"

 

(Note 1) The parameters of the basic setup are set for the external terminal regardless of the selection contents
of functions.

 

■ Precautions when using FPWIN GR7 for configuration
When using the GR7 ver.2.12 or later on the Multi I/O Unit ver.1.0x, there are the following
restrictions.
● On the Multi I/O Unit ver.1.0x, the setting of the double word error annunciation specified by

the FPWIN GR7 is not reflected . It can be set using a program.Refer to "13.4.1 Alarm/Error/
Warning".

● On the Multi I/O Unit Ver.1.0x, the following values specified for input time constants by the
FPWIN GR7 are set as 2 μs.
0.5 μs/1.5 μs/32 μs/64 μs/96 μs/128 μs/256 μs/8 ms
It can be set using a program.Refer to "13.4.2 Input setting".

5.1 Basic Setup
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5.2 Output Terminal Setting

5.2.1 Overview

On Multi Input/Output Unit, the allocation of output terminal polarities and output numbers can
be switched by the setting of the software.
● Output terminal polarities can be selected from sink, source, P-type push-pull (positive logic)

and N-type push-pull (negative logic).
● ""Allocate contacts of output terminals"" is used when to allocate a single I/O signal to two

output circuits. It is possible to apply them as line driver output by using this function.
● This setting can be made for four output circuits and four output points each.

■ Multi I/O Unit Setting dialog box

■ Example of Setting Output Terminal Polarity
● By default, ""Output OFF"" is selected.
● For using this like a general digital output unit, select ""Sink output"" for all points or ""Source

output"" for all points in "Output terminal polarity".
● The output formats can be mixed by four circuits.

5.2 Output Terminal Setting
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Example 1 of using sink and source outputs

Example 2 of using sink and source outputs

 

(Note 1) When the polarities are mixed, a warning occurs and the ERR LED on the unit flashes to remind
users to check the wiring.
To disable warning announcement, set "Warning annunciation" to ""Not announce"" in the ""Multi
I/O Unit Setting"" screen of tool software FPWIN GR7. (Available since Ver.1.1.) Or, set bit 9 of
UM00062 to 1.

 

5.2.2 Allocation of Contacts to Output Terminals

The contact allocation function to output terminals is a function to allocate Y contacts to output
terminals by four points. The arrangement can be changed from the initial state and the same Y
contact can be allocated to multiple terminals.

■ Example of contact allocation
In this example, "Output terminal polarity" is set to use sink and source outputs and the signals
of A15-A18 are replaced with the signals of B11-B14.

5.2 Output Terminal Setting
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In this example, "Output terminal polarity" is set to use two kinds of push-pull outputs and the
same Y contact is allocated to two output circuits.

 

(Note 1) When the polarities are mixed, a warning occurs and the ERR LED on the unit flashes to remind users
to check the wiring. To make warnings not to be announced, set "Warning annunciation" to "Not
announce" in the "Multi I/O Unit Setting" screen of FPWIN GR7 (Ver.1.1 or later), or set the bit 9 of
UM00062 to 1.

 

5.2.3 Application to Differential Output

It is possible to allocate one memory output for operation to two output circuits and obtain the
differential output by applying the contact allocation functions of output terminal polarities and
output terminals.
● Allocate the same I/O number to the terminals for two sets of four circuits by using ""Allocate

contacts of output terminals"" in the "Multi I/O Settings" dialog box.
● Allocate "Sink" or "P-type push-pull (positive logic)", "Source" or "N-type push-pull (negative

logic)" to ""Output terminal polarity"".
● Paired two terminals with the same I/O number are used as a pair of differential output.
In the following example, "Sink" and "Source" are allocated to the ""B11-B14"" and ""B15-B18""
terminals respectively, and used as differential outputs.

5.2 Output Terminal Setting
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■ Terminal layout diagram

■ External connection diagram

(a) External resistance (b) Differential input device (Line driver
input)

(c) Load current when turning
on

■ Configuration using FPWIN GR7

1. Select Options>Multi I/O Unit Setting in the menu bar.

2. Select a unit.
The basic setup screen of "Multi I/O Unit Setting" will be displayed.

3. Set ""Output terminal polarity"".
Set the terminal number B11-B14 to Sink, and B15-B18 to Source.

5.2 Output Terminal Setting
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4. Check the box for ""Allocate contacts of output terminals"" and set terminal numbers
allocated to each contact.
Set the both terminals B11-B14 and B15-B18 to Y108-Y10B.

(B11-14 is Sink and B15-18 is Source.)

The terminal layout displayed on the left side of the Multi I/O Unit Setting dialog box is updated
according to this setting.
Both terminals B11-B14 and B15-B18 are set to Y108-Y10B.
The terminals B11-B14 are minus outputs as they are set to Sink, and the terminals B15-B18 are
plus outputs as they are set to Source.

5.2 Output Terminal Setting
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5.3 Application Setting

5.3.1 Overview

Set applications according to functions to be used as necessary. The following figure shows the
case that high-speed counters are allocated to the inputs (X100 to X103) of the multi I/O unit of
the starting word number 10.

5.3.2 Setting Items by Use

■ Interrupt (INT0-INT7: Selectable by one point.)

Setting item Settings

Function setting
Unused / Comparison match output (when comparison values match) /
Comparison match output (OFF->ON) / (ON->OFF) / Comparison match output
(OFF->ON) / Comparison match output (ON->OFF) / Interrupt terminal input
(OFF->ON) / Interrupt terminal input (ON->OFF)

5.3 Application Setting
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■ High-speed counter (HSC0-HSC3 / PLSC0-PLSC3: Selectable by channel.)

Setting item Settings

Function setting Unused/Direction distinction/Individual input/Phase input (multiplied by 1)/Phase
input (multiplied by 2)/Phase input (multiplied by 4)

Elapsed value hold mode Switch on the checkbox for using this mode.

Count mode Ring / Linear

Counter elapsed value -2147483648 to +2147483647

Counter preset value -2147483648 to +2147483647

Counter upper/lower limit
values -2147483648 to +2147483647

■ Comparison match output (CMP0-CMP7: Selectable by one comparison output.)

Setting item Settings

Compare Switch on the checkbox for comparing.

Counter to be compared
High-speed Counter CH0/CH1/CH2/CH3
Pulse Output PLS0/PLS1/PLS2/PLS3
Positioning (H type only) CH0/CH1/CH2/CH3

Comparison Output
Function

ON when elapsed value is smaller than setting value / ON when elapsed value is
larger than or equal to setting value

Comparison value -2147483648 to +2147483647

Comparison output
destination

External terminal/Internal I/O
Internal I/O

 

(Note 1) To set comparison match output, one of the following must be set: high-speed counter, pulse output, or
positioning (H type only).

 

● For details of the interrupt function, refer to page "P.6-2".
● For details of the high-speed counter function, refer to page "P.7-2".
● For details of the comparison match output function, refer to page "P.8-2".

■ Pulse output / PWM output (PLS0-PLS3 / PWM0-PWM3: Selectable by channel.)

Setting item Settings

Function setting Unused/PLS output - Direction distinction/PLS output - Individual output/PLS
output - Phase output/PLS output - Comparison match stop/PWM output

Data update timing
When start signal rises
When start signal rises or upon comparison match output
When start signal rises or when data is updated

Frequency
For pulse output: 0 to 500,000 (Can be set in 1 Hz increments)
For PWM output: 0 to 100,000 (Can be set in 1 Hz increments)

Duty 0.0 to 100.0 (0.0% to 100.0%) (Only when using PWM output)

Counter elapsed value -2147483648 to +2147483647

5.3 Application Setting

5-10 WUME-FP7MXY-06



Setting item Settings

Counter upper/lower limit
values -2147483648 to +2147483647

Pulse start logic (Except
PWM output) OFF start / ON start

■ Positioning (CH0-CH3: Selectable by channel)

Setting item Settings

Function setting Unused/Use/Use (Use J point terminal)(Note 1)

Counter elapsed value -2147483648 to +2147483647

Counter upper/lower limit
values

-2147483648 to +2147483647

 

(Note 1) Use (Use J point terminal) is only for CH0 - CH1.
 

● For details of the pulse output/PWM output function, refer to page "P.9-2".
● For details of the positioning function, refer to page "P.10-3".

5.3 Application Setting
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6.1 Interrupt Function

6.1.1 Overview of Interrupt Function

● The multi input/output unit can start an interrupt program of the CPU unit using an interrupt
input signal or counter comparison match flag.

● If the activation condition is met, the interrupt program of a corresponding program number
will be activated. Once the execution of the interrupt program is complete, the process
returns to the execution of the main program.

■ Interrupt function specifications

Item Specifications

No. of interrupt
programs(Note 1)(Note

2)

Per multi I/O unit Max. 8 programs

Per CPU unit Max. 64 programs (8 programs x 8 units)

Interrupt condition

Any of the following conditions can be selected by one point.
External input (X8-XF) rising edge(OFF > ON)
External input (X8-XF) falling edge(ON > OFF)

Comparison match(Note 3)

 

(Note 1) If interrupts occur many times in one scan, the execution of interrupt program has priority, and the
scan time will be longer.

(Note 2) If more than one interrupt activation request is made from the unit, the process will be carried out from
the smallest slot number or the smallest interrupt program number.

(Note 3) The interrupt program will start when the counter elapsed value agrees with the comparison value
when using the comparison function. On the unit Ver.1.1 or later, the following conditions can be set as
interrupt conditions: Comparison match output (OFF > ON/ON > OFF), comparison match output (OFF
> ON), comparison match output (ON > OFF)

 

6.1.2 Setting of Unit Body

■ Setting method
For using the interrupt function, it is necessary to set the switch on the side of the unit.Refer to
"2.1 Names and functions of parts".

6.1.3 Configuration Using Tool Software

The settings of the interrupt function are specified in the configuration menu of FPWIN GR7.

■ Setting method
The following procedure shows allocating ""External interrupt input (OFF -> ON)"" to the input
(X108) of the multi I/O unit registered with the starting word number 10. It also describes the
procedure when the multi I/O unit has been already allocated in the I/O map.

6.1 Interrupt Function
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1. Select Options>Multi I/O Unit Setting in the menu bar.
The ""Multi I/O Unit Setting"" dialog box is displayed. Select a unit to be used.

2. From the function select tree, select ""Interrupt"", and double-click an interrupt number to
which the interrupt input is allocated.
The ""Interrupt Advanced"" dialog box is displayed.

3. Select an arbitrary interrupt condition.
A used terminal number will be automatically allocated.

4. Press the [[OK]] button.
The selected condition will be registered in the interrupt execution condition. The following
figure shows an example of allocating ""Interrupt terminal input (OFF > ON)"" to the
interrupt number INT0 of the Multi I/O Unit.

The set values will be effective when they are downloaded with programs or other
configuration information as a project.

6.1 Interrupt Function
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6.1.4 Overview of Interrupt Program

Use the following instructions to execute the activation of an interrupt program.

■ Instructions used for interrupt program activation

Described area Instruction Functions

Main program

EI Allows the interrupt process for the CPU.

DI Prohibits the interrupt process for the CPU.

IMASK Allows or prohibits the interrupt process of each unit.

ICLR
Clears the interrupt start request signal that has not been processed on
the unit side when interrupt program activation is prohibited by DI or
IMASK instructions.

Interrupt program
INTPG It is described at the beginning of the interrupt program.

IRET It is described at the end of the interrupt program.

■ Programming method (Main program)
The interrupt for the CPU and the interrupt activation of the multi I/O unit are allowed in the
main program. If the interrupt becomes disabled, clear the interrupt activation request signal
that is not processed in the unit as necessary.

■ Programming method (Interrupt program)
● Describe the program to be executed at the time of interrupt process in the interrupt

program.

6.1 Interrupt Function
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■ Corresponding interrupt program numbers

Interrupt
program No. Multi I/O unit interrupt No. Designation of the first operand of IMASK and ICLR

instructions

INTPG 10 INT0 (Input X8 or EQ0) IMASK instruction

ICLR instruction

INTPG 11 INT1 (Input X9 or EQ1)

INTPG 12 INT2 (Input XA or EQ2)

INTPG 13 INT3 (Input XB or EQ3)

INTPG 14 INT4 (Input XC or EQ4)

INTPG 15 INT5 (Input XD or EQ5)

INTPG 16 INT6 (Input XE or EQ6)

INTPG 17 INT7 (Input XF or EQ7)

 

(Note 1) Interrupt program numbers are specified with slot numbers + (0 to 7). The numbers in the above table
are for the slot 1.
Example) The program number corresponding to the interrupt INT3 of the multi I/O unit of the slot
number 10 is INTPG03.

 

● Either interrupt (X8-XF) by an external input or comparison match signal (EQ0-EQ7) when
using the comparison output function is allocated to the interrupt number of the multi I/O unit by
the tool software or the setting with a program. For details of the comparison match signals
(EQ0-EQ7), refer to ""8.1.2 Comparison Output and Comparison Match Signal"".

6.1.5 Precautions for Use

■ Process when more than one interrupt activation request is made
● If more than one interrupt activation request is made from the unit, the process will be carried

out from the smallest slot number or the smallest interrupt program number.
● If the interrupt activation is requested on the completion of the process of interrupt program,

a higher-priority program will be searched and the corresponding interrupt program will be
executed.

● Interrupt activation request signals on the unit side will be held until the corresponding
interrupt program is executed or ICLR instruction is executed.

● If interrupts occur many times in one scan, the execution of interrupt program has priority, and
the scan time will be longer.

6.1 Interrupt Function
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6.2 Execution Example of Interrupt Function

6.2.1 External Interrupt Input

■ Overview
● The following figure shows the example that the output (Y160) from the 32-point output unit

is output at a high speed by the processing of an interrupt program when inputting the
external input (INT0) of the multi I/O unit (X108) in the state that the interlock input (X140) is
input to the 32-point input unit.

● In the normal processing that does not use the interrupt processing, it is reflected by the
scan time from an input to the signal output. However, when performing the interrupt
processing, the input status is reflected to the output with a slight delay that is not influenced
by the scan time.

■ Configuration
● Allocate an interrupt input to the input (X108) in the ""Multi I/O Unit Setting"" dialog box.
● Allocate ""Interrupt terminal input (OFF -> ON)"" as an interrupt occurrence condition.

■ Time chart

For normal
processing

The output delays by the scan time.

6.2 Execution Example of Interrupt Function
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In the case of
interrupt
processing

The signal is output with a slight delay.

■ Program example
● Describe the interrupt enable instruction before the ED instruction, and describe a program

to be executed by the interrupt processing after the ED instruction.
● The interrupt program number corresponding to the input (X108) is INTPG10.

 

(Note 1) The input (X140) corresponds to (S2: IN0) in the program, and the output (X160) corresponds to (S3:
OT0).

(Note 2) For the unit which uses direct input (IN) and direct output (OT), set ""Exclude this unit from I/O
refresh"" in the I/O map.

 

6.2.2 Comparison Match Interrupt

■ Overview
● The high-speed counters are allocated to the inputs (X100-X103) of the multi I/O unit.
(For the interrupt occurred when comparison values match)
● The interrupt (INT0) occurs when the counted pulse number matches the ""Comparison

output setting value"" that has been specified. The interrupt program from INT0 of a

6.2 Execution Example of Interrupt Function

WUME-FP7MXY-06 6-7



sequence program until IRET is executed, and the output (Y160) of the 32-point output unit
is output at a high speed.

(For the interrupt occurred at the same time as comparison output)
● The interrupt (INT0) occurs at the same time as the comparison output. The interrupt

program from INT0 of a sequence program until IRET is executed, and the output (Y160) of
the 32-point output unit is output at a high speed.

■ Configuration
● From the function selection tree, select ""High-speed counter"", allocate high-speed counter

inputs to the inputs (X100-X103), and select ""Direction distinction"".
● From the function selection tree, select ""Comparison match output"", and select ""High-

speed counter CH0"" as a counter to compare the comparison match number CMP0
(external terminal number: Y100).

(For the interrupt occurred when comparison values match)
● From the function selection tree, select ""Interrupt"", and select ""Comparison match output

(When comparison values match)"" from the interrupt conditions in the Interrupt Advanced
settings.

(For the interrupt occurred at the same time as comparison output)
● From the function selection tree, select ""Interrupt"", and select ""Comparison match output

(OFF->ON/ON->OFF)"" from the interrupt conditions.

6.2 Execution Example of Interrupt Function
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■ Time chart (For the interrupt occurred when comparison values match)

(a) Comparison output
setting value (1) The count value is reset when the reset signal turns on.

(b) Counter elapsed value (2) The comparison output turns on when the elapsed value is smaller than
the setting value.

(c) Comparison (3) An interrupt occurs when the elapsed value agrees with the comparison
output setting value by the interrupt occurrence condition.

(d) Comparison match
Interrupt (4) Counting is disabled while the mask signal is on.

(e)
32-point input unit
Interlock input

(f)
32-Point output unit
External output

6.2 Execution Example of Interrupt Function
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■ Time chart (For the interrupt occurred when comparison values match)

(a) Comparison output
setting value (1) The count value is reset when the reset signal turns on.

(b) Counter elapsed value (2) The comparison output turns on when the elapsed value is smaller than
the setting value.

(c) Comparison (3) An interrupt occurs when the comparison output turns on or off by the
interrupt occurrence condition.

(d) Comparison match
Interrupt (4) Counting is disabled while the mask signal is on.

(e)
32-point input unit
Interlock input

(f)
32-Point output unit
External output

■ Program example
● Describe the interrupt enable instruction before the ED instruction, and describe a program

to be executed by the interrupt processing after the ED instruction.
● The interrupt program number corresponding to the match output CMP0 (EQ0) is INTPG10.

6.2 Execution Example of Interrupt Function
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(Note 1) The input (X140) corresponds to (S2: IN0) in the program, and the output (X160) corresponds to (S3:
OT0).

(Note 2) For the unit which uses direct input (IN) and direct output (OT), set ""Exclude this unit from I/O
refresh"" in the I/O map.

 

● For more information about how to use the counter function, refer to ""7 Counter Function"".
● For more information about how to use the comparison output function , refer to

""8 Comparison Output Function"".

6.2 Execution Example of Interrupt Function

6-12 WUME-FP7MXY-06



7 Counter Function
7.1  Counter Function ................................................................................7-2

7.1.1  Overview of Counter Function ......................................................... 7-2
7.1.2  Configuration Using Tool Software................................................... 7-3
7.1.3  Linear Counter and Ring Counter .................................................... 7-4
7.1.4  Selection of Count Methods............................................................. 7-6

7.2  Control Signals....................................................................................7-9
7.2.1  Reset and Mask ............................................................................... 7-9

7.3  Read/Write of Elapsed Value ..............................................................7-10
7.3.1  Elapsed Value When Power Turns On............................................. 7-10
7.3.2  Reading Elapsed Value.................................................................... 7-10
7.3.3  Changing Elapsed Value.................................................................. 7-10
7.3.4  Resetting/Presetting Elapsed Value................................................. 7-10

7.4  Elapsed Value Hold Function..............................................................7-12
7.4.1  Overview .......................................................................................... 7-12
7.4.2  Operation ......................................................................................... 7-13

7.5  Input Frequency Measurement Function ............................................7-14
7.5.1  Overview .......................................................................................... 7-14
7.5.2  Reading Measurement Value........................................................... 7-14

WUME-FP7MXY-06 7-1



7.1 Counter Function

7.1.1 Overview of Counter Function

● The count function is used to count the number of input pulses and reflect it to the elapsed
value. The freqeuncies of input pulses can also be measured.

● When an external output is necessary, use this function in combination with the comparison
function.

● There is also a function which holds the elapsed value at the time of the trigger input signal
from an external device. For details, refer to ""7.4 Elapsed Value Hold Function"".

■ Outline of specifications

Item Specifications

Counter type Linear counter/Ring counter

Number of channels Max. 4 channels

Counting range -2147483648 to +2147483647

Max. counting
speed(Note 1)(Note 2)

When input voltage is 5 V: 500 Hz (For phase input: 500 kHz)
When input voltage is 12V: 500 kHz (For phase input: 350kHz)
When input voltage is 24V: 250 kHz (For phase input: 180kHz)

Count method Direction distinction input, Individual input, Phase input (1 multiple, 2 multiple, 4 multiple)

Optional functions

Comparison output setting: Max. 8 points
Elapsed Value Offset/Preset Function
Elapsed Value Hold Function
Count upper and lower limit settings
Overflow/underflow detection (Linear counter only)
Input pulse frequency measurement

 

(Note 1) By default, the input time constant is set to 2 µs. Change the setting according to the frequencies
required. (The count upper limit at 2 µs is approx. 100 kHz.)

7.1 Counter Function
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(Note 2) This applies when the input pulse duty is 50%.
 

● Besides the purpose which counts input pulses from external devices, pulses generated by
them can be counted internally when using the pulse output/PWM output function. For details
of the counter for the pulse output/PWM output, also refer to ""9 Pulse Output/PWM Output
Function"".

7.1.2 Configuration Using Tool Software

The setting of the counter function is specified in the configuration menu of FPWIN GR7.

■ Setting method
The following procedure shows when ""High-speed counter (Phase input)"" is allocated to the
inputs (X100-X103) of the multi I/O unit registered in the starting word number 10. It also
describes the procedure when the multi I/O unit has been already allocated in the I/O map.

1. Select Options>Multi I/O Unit Setting in the menu bar.
The ""Multi I/O Unit Setting"" dialog box is displayed. Select a unit to be used.

2. From the function selection tree, select ""High-speed counter"", and double-click an input
number to which the high-speed counter is allocated.
The ""High-speed Counter Advanced"" dialog box is displayed.

3. Select ""Phase input (4 multiple)"" from the ""Function Setting"" drop-down list.

4. Input a preset value or upper and lower limit values as necessary.

7.1 Counter Function
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5. Press the [[OK]] button.
The selected condition will be registered in the ""Multi I/O Unit Setting"" dialog box.
The following figure shows an example when ""High-speed counter (Phase input)"" is
allocated to the inputs (X100-X103) of the multi I/O unit. The output for control is
automatically allocated to the outputs (Y110-Y111) of the unit's internal I/O.

The set values will be effective when they are downloaded with programs or other
configuration information as a project.

Settings of counter elapsed value and counter preset value
The values set in the ""Counter Advanced"" dialog box are applied as follows.

Item Operation Related unit memory

Counter elapsed
value

The value set for ""Counter elapsed value"" in the dialog box
is set in the elapsed value area after switching the mode to
RUN mode.

UM00110-UM00117

Counter preset value
The value set for ""Counter preset value"" in the dialog box is
set in the elapsed value area when the reset operation is
performed with a control signal.

UM00118-UM0011F

7.1.3 Linear Counter and Ring Counter

The operation changes depending on the types of counter as below.

7.1 Counter Function
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■ Operational difference between the counter types

Comparison
item

Linear counter Ring counter

Operation image

Operation when
reaching the
upper limit or
lower limit

If the count value exceeds the upper limit,
the upper limit will be held.
If the count value falls below the lower limit,
the lower limit will be held.(Note 1)

If the count value exceeds the upper limit,
the count value will be the lower limit
automatically and the count operation will
continue.
If the count value falls below the lower limit,
the count value will automatically become the
upper limit and the count operation will
continue.(Note 1)

Overflow
Underflow

When an overflow or underflow occurs, it will
be reflected to the input relays X20-X27) as
a flag. The count operation will be restart
until the overflow or underflow is cleared, and
the elapsed value will be held.

Even when the value exceeds the upper limit
or lower limit, it will not be considered as an
overflow or underflow, and the count will
continue.

 

(Note 1) When the upper limit or the lower limit has been changed in the configuration menu, the counter
operates based on its range.

 

■ Operation in case of overflow or underflow (Linear counter only)
● The overflow or underflow flags (X20-X27) can be cleared by the overflow clear or underflow

clear request signals (Y20-Y27).

● For the details of I/O signals related to overflow and underflow, refer to ""13.2 Allocation of I/O
Numbers"".

■ Linear counter operation
The overflow or underflow is detected when the count value exceeds the upper or lower limit.
(Example): The following figure shows when underflow occurs. When the underflow occurs, the
elapsed value will be held at the lower limit. Once the underflow clear signal turns on, the count
will restart from the lower limit.

7.1 Counter Function
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■ Ring counter operation
● If the lower limit is counted down, the count value will be rolled over, and counting down will

continue from the upper limit.
● If the upper limit is counted up, the count value will be rolled over, and counting up will

continue from the lower limit.

7.1.4 Selection of Count Methods

● Select from the following three types according to input devices to be connected.
● For phase input, the count operation varies depending on the settings of multiplication factor,

as shown below.

7.1 Counter Function
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■ Count method

Metho
d

Connection Count

Directi
on
distinct
ion

For the direction distinction input, the
count signal is connected to the input
A signal. The count direction is
controlled by the level of the direction
signal of the input B signal.
When the input B signal is off, the
counter is incremented when the input
A signal rises or falls. When the input
B signal is on, the counter is
decremented.

Individ
ual

In the individual input method, the
counter is incremented when the input
A signal rises or falls, and
decremented when the input B signal
rises or falls.

Phase

For the phase input, the input A signal
and input B signal of each counter are
connected to the phase A and phase
B of an encoder.
The count direction is determined by
the phase difference between phase
A and phase B. When phase A is
advanced by 90 degrees in electrical
angle compared to phase B, the count
value is incremented. When phase A
is delayed by 90 degrees in electrical
angle compared to phase B, the count
value is decremented.

■ Count operation of direction distinction input

Multi-
plica-
tion

factor

Time chart

Addition Subtraction

1
multiple

2
multiple

7.1 Counter Function
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■ Count operation of individual input

Multi-
plica-
tion

factor

Time chart

Addition Subtraction

1
multiple

2
multiple

■ Count operation of phase input

Multi-
plica-
tion

factor

Time chart

Addition Subtraction

1
multiple

2
multiple

4
multiple

7.1 Counter Function
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7.2 Control Signals

7.2.1 Reset and Mask

● The reset and mask operations can be performed with the counter for external inputs.
● The both operations can be performed by the inputs from external input terminals or user

programs.
● Once executing the reset operation, values will return to the preset values stored in the unit

memories (UM00118-UM0011F). The preset values can be set in the ""High-speed Counter
Advanced"" dialog box of the tool software or using user programs.

■ I/O allocation (Control by external input terminals)

Signal name Valid Condition CH0 CH1 CH2 CH3

Reset CHxRST Level X102 X106 X10A X10E

Mask CHxMASK Level X103 X107 X10B X10F

 

(Note 1) The I/O numbers in the table above are for slot number 1 and the starting word number 10. The I/O
numbers actually used vary according to the slot number where the unit is installed and the starting
word number.

 

■ I/O allocation (Control by programs)

Signal name Valid Condition CH0 CH1 CH2 CH3

Reset CHxRST Level Y110 Y112 Y114 Y116

Mask CHxMASK Level Y111 Y113 Y115 Y117

 

(Note 1) The I/O numbers in the table above are for slot number 1 and the starting word number 10. The I/O
numbers actually used vary according to the slot number where the unit is installed and the starting
word number.

 

■ Unit memory (UM) allocation

Signal name CH0 CH1 CH2 CH3

Counter preset
value

UM00118-UM00119 UM0011A-UM0011B UM0011C-UM0011D UM0011E-UM0011F

7.2 Control Signals
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7.3 Read/Write of Elapsed Value

7.3.1 Elapsed Value When Power Turns On

● The default for the elapsed value when the power turns on is ""0"".
● The count value when the power turns on can be set to any value as necessary. It can be set

to an arbitrary value in the configuration menu of the tool software or user programs.

7.3.2 Reading Elapsed Value

The elapsed value can be read from the unit memory area.

Example) Program to read the elapsed value of the counter CH0 for external inputs

7.3.3 Changing Elapsed Value

The elapsed value can be set to an arbitrary value using a user program as necessary.

Example) Program to change the elapsed value of the counter CH0 for external
inputs to 100000

■ Unit memory (UM) allocation

Signal name CH0 CH1 CH2 CH3

Counter elapsed
value area

UM00110-UM00111 UM00112-UM00113 UM00114-UM00115 UM00116-UM00117

7.3.4 Resetting/Presetting Elapsed Value

The counter elapsed value can be preset by the output ChxRST.

7.3 Read/Write of Elapsed Value
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Example) Program to change the elapsed value of the counter CH0 for external
inputs to a preset value.

■ Unit memory (UM) allocation

Signal name CH0 CH1 CH2 CH3

Counter preset
value

UM00118-UM00119 UM0011A-UM0011B UM0011C-UM0011D UM0011E-UM0011F

7.3 Read/Write of Elapsed Value
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7.4 Elapsed Value Hold Function

7.4.1 Overview

● The elapsed value hold function is a function which holds the elapsed value of the counter at
the time of the trigger input signal from an external device.

● The elapsed value hold function is available only for CH0 and CH1. Each elapsed value is
transferred to the hold value areas allocated to each channel.

● It will be valid by turning on the signal (CHx LATCH EN) with a user program.
● The input logics (ON -> OFF edge, and OFF -> ON edge) which enable trigger input signals

can be switched by the signal (CHx TRG LOG).

■ I/O allocation

Name CH0 CH1 Description

CHx IN-A X100 X104

They occupy the counter areas for external inputs (4 points for each
channel).

CHx IN-B X101 X105

CHx RST X102 X106

CHx MASK X103 X107

CHx TRG Y108 X10C Trigger input signal by an external input.

CHx LATCH EN Y114 Y116 Enables the elapsed value hold function.

CHx TRG LOG Y115 Y117

Switches the valid condition of trigger input signals.
When this is on, the ON -> OFF edge of the trigger signals (X8, XC) is
valid.
When this is off, the OFF -> ON edge of the trigger signals (X8, XC) is
valid.

 

(Note 1) The I/O numbers in the table above are for slot number 1 and the starting word number 10. The I/O
numbers actually used vary according to the slot number where the unit is installed and the starting
word number.

 

■ Unit memory (UM) allocation

Name CH0 CH1

Counter elapsed value area UM00110-UM00111 UM00112-UM00113

Counter hold value area UM00114-UM00115 UM00116-UM00117

■ Configuration
When allocating ""High-speed counter"" to the inputs (X100-X107) in the "Multi I/O Unit Setting"
dialog box, check the box for ""Elapsed value hold mode"".

7.4 Elapsed Value Hold Function
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7.4.2 Operation

The following time chart shows when the ""elapsed value hold function"" is set for the high-
speed counter CH0 and is enabled when the input logic of a trigger signal is (ON > OFF).

■ Time chart

Mark Procedure Description

(a) Enable trigger
input It shows the timing that the hold function becomes enabled within the unit.

(b) Elapsed value
area Elapsed value area of the counter.

(c) Hold value area Area in which the hold values are stored.

(1) Enable latch The trigger input (X108) becomes enabled when the latch enable signal
CHxLATCH EN (Y114) is turned on by the user program.

(2) Trigger input
When the trigger signal (X108) from an external device turns off, the counter
elapsed values (UM00110-UM00111) will be stored in the storage areas
(UM00114-UM00115).

(3) Wait
After accepting the trigger input and holding the counter elapsed values, the hold
operation will not be performed until the latch enable signal (Y114) turns on. To
hold the next data, change the state of the latch enable signal (Y114) as ON ->
OFF -> ON with the user program.

(4) Enable latch When the LATCH EN signal (Y114) turns on after turning off the CHxLATCH EN
signal on the user program, the trigger input will be enabled.

(5) 1 scan or more Ensure a time more than one scan time by the operation with the user program.

7.4 Elapsed Value Hold Function
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7.5 Input Frequency Measurement Function

7.5.1 Overview

● The measurement function is to measure the changes in the count values of the high-speed
counter for external outputs and to output them as frequencies.

● Measuring results are stored in unit memories (UM). They can be read by user programs if
necessary.

● As the measurement function is enabled automatically when the high-speed counter for
external inputs is allocated, the configuration for using the input frequency measurement
function is not required.

7.5.2 Reading Measurement Value

Measurement values can be read from the unit memory area.

Example) Program to read the input frequency measurement value of the counter
CH0 for external inputs

■ Unit memory (UM) allocation

Signal name CH0 CH1 CH2 CH3

Counter input
Frequency
measurement
value

UM00130-UM00131 UM00132-UM00133 UM00134-UM00135 UM00136-UM00137

7.5 Input Frequency Measurement Function
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8.1 Comparison Output Function

8.1.1 Overview of Comparison Output Function

● The comparison output function is used for comparing the ""Counter elapsed value by
external input"" or ""Pulse output counter elapsed value of pulse output/PWM output"" to an
arbitrary ""Comparison output setting value"" and outputting the comparison result.

● There are eight points for the comparison result output [CMPx], and the types and channels
of compared counters, and the comparison condition can be arbitrarily allocated by the
software. Also, all comparison output setting values are set to the same counter, and it can
be used as a counter with a maximum of eight steps.

● The conditions of the comparison output are selectable from ""ON when elapsed value is
larger than or equal to setting value"" and ""ON when elapsed value is smaller than setting
value"".

■ Outline of specifications

Item Specifications Remarks

No. of comparison
outputs

Max. 8 points (CMP0 to CMP7: I/O numbers Y0 to Y7)(Note

1)

Comparison object
""Counter elapsed value by external input"" or ""Pulse
output counter elapsed value of pulse output/PWM output""
is compared to an arbitrary setting value.

Settable for each point.

Comparison
condition

""ON when elapsed value is smaller than setting
value""/""ON when elapsed value is larger than or equal to
setting value""

Settable for each point.

Data range -2147483648 to +2147483647
 

(Note 1) I/O numbers vary according to the starting word number of the unit.
 

8.1 Comparison Output Function
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● When selecting ""Compare"" in the comparison output setting, ""Comparison output setting
value"" and ""Counter elapsed value"" are compared whether the counter function is used or
not. Note that the output turns on when the comparison output condition is met. Such as when
both ""Counter initial value"" and ""Comparison output setting value"" are ""0"".

8.1.2 Comparison Output and Comparison Match Signal

The comparison function provides the following two functions.

■ Types of measurement function

Item Comparison condition Description

Comparison
output (CMPx)

ON when elapsed value
is smaller than setting
value
ON when elapsed value
is larger than or equal to
setting value

Compares the elapsed value of the high-speed counter and
comparison value, and turns on the corresponding output (CMP0-
CMP7) when the specified condition is met.
The comparison result is output to the external outputs (Y0-Y7) and
can be monitored by the internal input signals (X10-X17).

Comparison
match signal
(Eqx)

ON when elapsed value
is equal to setting value

The comparison match signal (EQx) is a signal for the internal
processing which is not externally output.
Compares the elapsed value of the high-speed counter and a
specified comparison value, and turns on when they match.
The comparison match signal (EQx) functions as the startup
condition of an interrupt program when it is selected as the startup
condition of the interrupt function.

8.1.3 Configuration Using Tool Software

The setting of the comparison output function is specified in the configuration menu of FPWIN
GR7.

■ Setting method
The following procedure describes the process when the multi I/O unit has been already
allocated in the I/O map. Set the ""Counter (for external input)"" or ""PLS/PWM output counter""
to be compared in advance. The counter can be set for each comparison output.

1. Select Options>Multi I/O Unit Setting in the menu bar.
The ""Multi I/O Unit Setting"" dialog box is displayed. Select a unit to be used.

2. From the function selection tree, select ""Comparison match output"", and double-click a
comparison match number to which the comparison output is allocated.
The ""Comparison Match Output Advanced"" dialog box is displayed.

3. Check the box for ""Compare"".

8.1 Comparison Output Function
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4. Select a counter to be compared from the pull-down box.
Select High-speed counter (CH0-CH3) or PLS output (PLS0-PLS3).

5. Input the comparison condition and comparison value.
Select either ""ON when elapsed value is smaller than setting value"" or ""ON when
elapsed value is larger than or equal to setting value"" for the comparison condition.

6. Select a comparison output destination.
Select either ""External terminal/Internal I/O"" or ""Internal I/O"".

7. Press the [[OK]] button.
The selected condition will be registered in the ""Multi I/O Unit Setting"" dialog box.
The following figure shows an example of allocating the output compared to ""High-speed
counter (Direction distinction)"" to the output (Y100) of the multi I/O unit. The control input
for monitoring is automatically allocated to the input (X110) of the unit's internal I/O.

8.1 Comparison Output Function
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The set values will be effective when they are downloaded with programs or other
configuration information as a project.

● Precautions when using FPWIN GR7 for configuration
On the unit ver.1.0x, internal contacts cannot be set as the comparison output destination.
When selecting internal contacts as the comparison output destination on the tool software, the
registration of the comparison function is set not to be used.

● This function can also be set by writing to the comparison output setting area of unit memories
with user programs. For details on unit memories, refer to ""13.4.7 Comparison Output Setting
Area"".

8.1 Comparison Output Function
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8.2 Execution Example of Comparison Output Function

8.2.1 Comparison Output of Counter for External Input

■ Overview
This function is used for comparing the elapsed value of the high-speed counter CH0 for
external inputs to ""Comparison output setting value"" specified in advance, and turning on the
comparison output (CMP0: output number Y100) when the comparison condition is met.

■ Configuration
● Allocate high-speed counter inputs to the inputs (X100-X103), and select ""Direction

distinction"".
● Select ""Comparison match output"" in the function selection tree, and double-click the

comparison match number CMP0 to open the "Advanced" dialog box.
● Select ""High-speed counter CH0"" as a counter to be compared. Also, select ""ON when

elapsed value is larger than or equal to setting value"" for the comparison output function,
and input a comparison value.

8.2 Execution Example of Comparison Output Function
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■ Time chart
● The comparison output (CMP0: output number Y100) turns on when the elapsed value

reaches the comparison output setting value and meets the condition which satisfies the
comparison condition ""ON when elapsed value is larger than or equal to setting value"".

● The comparison is performed continuously even after turning on the comparison output. The
comparison output will turn off when ""Elapsed value is smaller than setting value"" is met.

(a) Comparison output setting
value (1) The count value is reset when the reset signal turns on.

(b) Counter elapsed value (2) Turns on when the elapsed value is larger than or equal to the setting
value. It is output to the output Y100.

(c) Comparison (3)
When using this function in combination with the interrupt function, an
interrupt occurs by the interrupt occurrence condition when the
elapsed value agrees with the comparison output setting value.

(d) Comparison match (Internal
signal) (4) Counting is disabled while the mask signal is on.

8.2 Execution Example of Comparison Output Function
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9.1 Pulse Output / PWM Output Function

9.1.1 Overview of Pulse Output / PWM Output Function

● The pulse output can be performed up to 500 kHz using the pulse output function, and it can
be applied to a simple position control. The output mode can be selected from direction
distinction, individual output, phase input, and comparison match stop.

● The PWM output up to 100 kHz can be obtained in the range of 0 to 100% with the PWM
output function.

● As the counter for the pulse output/PWM output is also provided, it can be applied to the
cases such as switching output frequencies according to the elapsed values.

■ Outline of specifications

Item Specifications

No. of output channels Max. 4 channels (The total of positioning, pulse output and PWM output)

Output I/O number Y8 to YF(Note 1)

Output frequency
During pulse output: 0 Hz to 500 kHz (Can be set in 1 Hz increments)
During PWM output: 0 Hz to 100 kHz (Can be set in 1 Hz increments)

Output duty ratio
During pulse output: 50% (fixed)
During PWM output: 0 to 100% (Can be set in 0.1% increments)

Control input Enable, Start, Counter reset

Pulse output/PWM
output counter

To be stored in unit memories (UM) by channel
Counting range: -2,147,483,648 to +2,147,483,647
Comparison output setting: Max. 8 points
Elapsed value offset function
Count upper and lower limit settings

 

(Note 1) Two outputs are used when using the pulse output function, and one output is used when using the
PWM output function.

 

9.1.2 Pulse Output Function Settings

The following five output modes are provided for the pulse output/PWM output. They can be
selected in the configuration menu of FPWIN GR7.

9.1 Pulse Output / PWM Output Function
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■ Types of pulse output function settings

Setting Description

PLS output - Direction
distinction

This mode is used to perform the pulse output for PLS A and the direction output for
PLS B using two outputs.
By turning the direction output signal (Y128-12B) on/off using the user program, the
output of the terminal allocated to PLS B (Y109/Y10B/Y10D/Y10F) turns on/off.

PLS output - Individual
output

This mode is used to use two outputs as the CW output/CCW output.
When the direction output signal (Y128-12B) is off, the pulse output is performed from
the terminal (Y108/Y10A/Y10C/Y10E) allocated to PLS A.
When the direction output signal (Y128-12B) is on, the pulse output is performed from
the terminal (Y109/Y10B/Y10D/Y10F) allocated to PLS B.

PLS output - Phase
output

This mode is used to perform the phase output by the combination of PLS A and PLS
B using two outputs.

PLS output -
Comparison match
stop

This mode is used in combination with the comparison output function.
When the elapsed value (UM00170-UM00177) of the counter for the pulse
output/PWM output matches the comparison output setting value (UM00144-
UM00153), the pulse output will stop.
The pulse output method when selecting the comparison match stop is the individual
output.
This mode is for using PLS A as CW output and PLS B as CCW output using two
outputs.

PWM output This mode is used to perform the PWM output.
 

(Note 1) The I/O numbers in the table above are for slot number 1 and the starting word number 10. The I/O
numbers actually used vary according to the slot number where the unit is installed and the starting
word number.

 

9.1.3 Pulse Start Logic

On the unit ver.1.10 or later, the pulse start logic can be selected from "OFF start" or "ON start".
(On the unit ver.1.0x, it is always "OFF start".)

■ Time chart
In the case of OFF start, the pulse output starts from the OFF period of one-half cycle when a
leading edge of the start signal is detected. In the case of ON start, the pulse output starts from
the ON period and turns off after the elapse of a half cycle.

9.1 Pulse Output / PWM Output Function
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9.1.4 Configuration Using Tool Software

The setting of the pulse output/PWM output function is specified in the configuration menu of
FPWIN GR7.

■ Setting method
The following procedure describes the process when the multi I/O unit has been already
allocated in the I/O map.

1. Select Options>Multi I/O Unit Setting in the menu bar.
The ""Multi I/O Unit Setting"" dialog box is displayed. Select a unit to be used.

2. From the function selection tree, select ""Pulse output"", and double-click an output number
to which the pulse output/PWM output is allocated.
The ""Pulse Output Advanced"" dialog box is displayed.

3. Select a function setting, data update timing, and input a frequency.
When selecting PWM output, set a duty ratio. Set the upper and lower limit values of the
counter for the pulse output/PWM output according to applications.

4. Select a pulse start logic.
Select either ""OFF start"" or ""ON start"".

5. Press the [[OK]] button.
The selected condition will be registered in the ""Multi I/O Unit Setting"" dialog box.

9.1 Pulse Output / PWM Output Function
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The following figure shows the example of allocating ""Pulse output (Direction distinction)""
to the outputs (Y108-Y109) of the multi I/O unit. The control inputs for monitoring are
allocated to the inputs of the unit internal I/O (X118-X119), and the control output is
allocated to the outputs (Y118/Y11C/Y128/Y12C) automatically.

The set values will be effective when they are downloaded with programs or other
configuration information as a project.

Setting of counter elapsed value
The values set in the ""Pulse Output Advanced"" dialog box are applied as follows.

Item Operation Related unit memory

PLS/PWM counter
elapsed value

The value set in the ""Counter elapsed value"" in the dialog
box is set in the PLS/PWM counter elapsed value area after
switching the mode to RUN mode.

UM00170-UM00177

 

(Note 1) The values in ""PLS/PWM counter elapsed value area"" of the channel to which the positioning
function has been set with the H type are the same as the values in ""Positioning elapsed value
(current value) area"".

 

● This function can also be set by writing to unit memories with user programs. For details on unit
memories, refer to ""13.4.8 Pulse Output / PWM Output Setting Area"".

9.1 Pulse Output / PWM Output Function
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9.1.5 Data Update Timing (Output Frequency)

The following three modes are provided for the both pulse output and PWM output as the timing
of changing the data of output frequencies.

■ Updating data when PLS start signal rises
In this mode, the data update is performed with the data when a PLS start signal turns on. The
frequency value changed at this timing will be reflected when the outputting pulse falls next
time.

 

(Note 1) In this time chart, "OFF start" is selected for the pulse start logic.
 

■ Updating data when comparison output is performed
In this mode, the data update is performed with the data when the counter elapsed value
matches the comparison value. The frequency value changed at this timing will be reflected
when the outputting pulse falls next time.

 

(Note 1) In this time chart, "OFF start" is selected for the pulse start logic.
 

9.1 Pulse Output / PWM Output Function
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■ Updating data when unit memory (UM) is rewritten
This mode updates using data as of when the unit memory (UM) was written. The frequency
value changed at this timing will be reflected when the outputting pulse falls next time.

Mark Procedure Description

(1) Data update
timing

It indicates the timing at which the data of the unit memory (UM) where PLS/PWM
output frequency is stored is reflected.

(2) Output update
timing

It indicates the timing at which the changed PLS/PWM output frequency is reflected
as an actual output.

■ I/O allocation

Signal name CH0 CH1 CH2 CH3

PLS output A Y109 Y10A Y10C Y10E

PLS output B X109 Y10B Y10D Y10F

PWM output Y109 Y10A Y10C Y10E
 

(Note 1) The I/O numbers in the table above are for slot number 1 and the starting word number 10. The I/O
numbers actually used vary according to the slot number where the unit is installed and the starting
word number.

 

■ Unit memory (UM) allocation

Signal name CH0 CH1 CH2 CH3

PLS/PWM frequency
area

UM00160-UM00161 UM00162-UM00163 UM00164-UM00165 UM00166-UM00167

PLS/PWM counter
elapsed value area

UM00170-UM00171 UM00172-UM00173 UM00174-UM00175 UM00176-UM00177

 

(Note 1) The values in ""PLS/PWM counter elapsed value area"" of the channel to which the positioning
function has been set with the H type are the same as the values in "Positioning elapsed value
(current value) area".

 

9.1.6 Data Update Timing (Duty Ratio)

The following three modes are provided as the timing of changing the data of duty ratio at the
time of PWM output.

9.1 Pulse Output / PWM Output Function
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■ Updating data when PLS start signal rises
In this mode, the data update is performed with the data when a PLS start signal turns on. The
frequency value changed at this timing will be reflected when the outputting pulse falls next
time.

■ Updating data when comparison output is performed
In this mode, the data update is performed with the data when the counter elapsed value
matches the comparison value. The frequency value changed at this timing will be reflected
when the outputting pulse falls next time.

■ Updating data when unit memory (UM) is rewritten
This mode updates using data as of when the unit memory (UM) was written. The frequency
value changed at this timing will be reflected when the outputting pulse falls next time.

9.1 Pulse Output / PWM Output Function
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Mark Procedure Description

(1) Data update
timing

It indicates the timing at which the data of the unit memory (UM) where PWM output
duty ratio is stored is reflected.

(2) Output update
timing

It indicates the timing at which the changed PWM output duty ratio is reflected as an
actual output.

■ I/O allocation

Signal name CH0 CH1 CH2 CH3

PWM output Y109 Y10A Y10C Y10E
 

(Note 1) The I/O numbers in the table above are for slot number 1 and the starting word number 10. The I/O
numbers actually used vary according to the slot number where the unit is installed and the starting
word number.

 

■ Unit memory (UM) allocation

Signal name CH0 CH1 CH2 CH3

PWM duty area UM00168-UM00169 UM0016A-UM0016B UM0016C-UM0016D UM0016E-UM0016F

PLS/PWM counter
elapsed value area

UM00170-UM00171 UM00172-UM00173 UM00174-UM00175 UM00176-UM00177

 

(Note 1) The values in the ""PLS/PWM counter elapsed value area"" of the channel to which the positioning
function has been set with the H type are the same as the values in the "Positioning elapsed value
(current value) area".

 

9.1 Pulse Output / PWM Output Function
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9.2 Control Signals

9.2.1 Enable and Start

The pulse output/PWM output function is controlled by user programs.

■ Functions of each signal

Signal name Description

Enable
PLSx EN
PWMx EN

● Enables or disables the pulse output/PWM output function.
● If this signal turns off during the output, the pulse output/PWM output will

stop.

Start
PLSx ST
PWMx ST

● Starts the pulse output/PWM output when the enable signal is valid.
● When this signal turns on during the execution of the pulse output/PWM

output, the frequency will be changed.
 

(Note 1) If the enable signal turns on when the start signal is on, this is interpreted as the start signal also
turning off > on, and the pulse output will start or the frequency will be changed.

 

■ I/O allocation (Control by programs)

Signal name Valid Condition
PLS0 PLS1 PLS2 PLS3

PWM0 PWM 1 PWM 2 PWM 3

Enable
PLSx EN
PWMx EN

Level Y118 Y119 Y11A Y11B

Start
PLSx ST
PWMx ST

ON edge Y11C Y11D Y11E Y11F

 

(Note 1) The I/O numbers in the table above are for slot number 1 and the starting word number 10. The I/O
numbers actually used vary according to the slot number where the unit is installed and the starting
word number.

 

9.2.2 Reset

● With the counter for the pulse output/PWM output, the reset operation by user programs can
be performed.

● The PLS/PWM counter elapsed value area (UM00170-UM00177) is reset to ""0"" by the
reset operation.

■ I/O allocation (Control by programs)

Signal name Valid Condition CH0 CH1 CH2 CH3

Reset PLSx CNT RST Level Y12C Y12D Y12E Y12F

 

(Note 1) The I/O numbers in the table above are for slot number 1 and the starting word number 10. The I/O
numbers actually used vary according to the slot number where the unit is installed and the starting
word number.

9.2 Control Signals
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(Note 2) The ""PLS/PWM counter elapsed value"" area of the channel to which the positioning function has
been set with the H type cannot be reset by the above operation.

 

9.2 Control Signals
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9.3 Read/Write of PLS/PWM Counter Elapsed Value

9.3.1 Elapsed Value When Power Turns On

● The default for the elapsed value when the power turns on is ""0"".
● The count value when the power turns on can be set to any value as necessary. It can be set

to an arbitrary value in the configuration menu of the tool software or user programs.

9.3.2 Reading PLS/PWM Counter Elapsed Value

The elapsed value can be read from the unit memory area.

Example) Program to read the elapsed value of the counter CH0 for pulse
output/PWM output

9.3.3 Changing PLS/PWM Counter Elapsed Value

The elapsed value can be set to an arbitrary value using a user program as necessary.

Example) Program to change the elapsed value of the counter CH0 for pulse
output/PWM output to 100000

■ Unit memory (UM) allocation

Signal name CH0 CH1 CH2 CH3

PLS/PWM counter
elapsed value area UM00170-UM00171 UM00172-UM00173 UM00174-UM00175 UM00176-UM00177

 

(Note 1) Values cannot be written into the "PLS/PWM counter elapsed value" area of the channel to which the
positioning function has been set for the H type.

 

9.3 Read/Write of PLS/PWM Counter Elapsed Value
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9.4 Execution Example of Pulse Output / PWM Output Function

9.4.1 Setting Example of Pulse Output

■ Overview
The pulse output is performed in the direction distinction mode. It is controlled by the switch
input (X140/X141/X142) connected to the 32-point input unit. If the start input (X141) turns on
when the enable input (X140) is on, the pulse output will start. The pulse output is switched to
that of the reverse direction by turning on X142.

■ Configuration
● Set the pulse output to the outputs (Y108-Y109).
● Select "PLS output - Direction distinction" in the "Pulse Output Advanced" dialog box, and

input a frequency.
● Select "When start signal rises" for the data update timing.

■ Time chart
If the rising of the start signal is detected when the enable input is on, pulses will be output.
When the enable input turns off, the pulse output will stop.

9.4 Execution Example of Pulse Output / PWM Output Function
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(1) If the rising edge of the start signal is detected when the enable signal is on, pulses will be output.

(2) The forward rotation pulse is output.

(3) One pulse is omitted when the direction is switched.

(4) The reverse rotation pulse is output.

(5) When the enable signal turns off, the pulse output will turn off.
 

(Note 1) In this time chart, "OFF start" is selected for the pulse start logic.
 

■ Sample program
The external inputs (X140, X141, X142) are allocated to the enable (Y118), start (Y11C) and
direction switching (Y128) signals of pulse output respectively.

9.4.2 Setting Example of Pulse Output (Frequency Change)

■ Overview
The pulse output is performed in the direction distinction mode. It is controlled by the switch
input (X140/X141/X142/X143) connected to the 32-point input unit. If the start input (X141)
turns on when the enable input (X140) is on, the pulse output will start. The pulse output is
switched to that of the reverse direction by turning on the direction switching input (X142). While
the speed change input (X143) is on, the frequency of output pulse is changed.

9.4 Execution Example of Pulse Output / PWM Output Function
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■ Configuration
● Set the pulse output to the outputs (Y108-Y109).
● Select "PLS output - Direction distinction" in the "Pulse Output Advanced" dialog box, and

input a frequency.
● Select "When start signal rises or when data is updated" for the data update timing.

■ Time chart
If the rising of the start signal is detected when the enable input is on, pulses will be output.
When the enable input turns off, the pulse output will stop. The speed changes according to the
speed change input.

9.4 Execution Example of Pulse Output / PWM Output Function
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(a) Speed change input

(1) If the rising edge of the start signal is detected when the enable signal is on, pulses will be output.

(2) The forward rotation pulse is output.

(3) The output frequency is changed while the speed change input is on.

(4) One pulse is omitted when the direction is switched.

(5) The reverse rotation pulse is output.

(6) When the enable signal turns off, the pulse output will turn off.

■ Sample program
The external inputs (X140, X141, X142) are allocated to the enable (Y118), start (Y11C),
direction switching (Y128) and speed change signals of pulse output respectively.

9.4.3 Setting Example of Pulse Output (Comparison Match Stop)

■ Overview
The pulse output is performed in the individual output mode. It is controlled by the switch input
(X140/X141) connected to the 32-point input unit. If the start input (X141) turns on when the

9.4 Execution Example of Pulse Output / PWM Output Function
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enable input (X140) is on, the pulse output will start. When the value of the pulse output counter
reaches the comparison output setting value, the pulse will stop.

■ Configuration
● Set the pulse output to the outputs (Y108-Y109).
● Select ""PLS output - Comparison match stop"" in the ""Pulse Output Advanced" " dialog

box, and input a frequency.
● Select ""When start signal rises"" for the data update timing.
● Select ""Comparison match output"" in the function selection tree, and double-click the

comparison match number CMP0 to open the "Advanced" dialog box.
● In the "Advanced Setting" dialog box, select ""Pulse output PLS0"" and ""ON when elapsed

value is larger than or equal to setting value"", and input a comparison value.

■ Time chart
If the rising of the start signal is detected when the enable input is on, pulses will be output. The
pulse output counter reaches the comparison value, the pulse output will stop.

9.4 Execution Example of Pulse Output / PWM Output Function
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(1) If the rising edge of the start signal is detected when the enable signal is on, pulses will be output.

(2) The pulse is output.

(3) When the comparison output turns on, the pulse output will stop. Also, when the enable signal turns off,
the pulse output will turn off.

■ Sample program
The external inputs (X140, X141) are allocated to the enable (Y118) and start (Y11C) signals of
pulse output respectively.

9.4.4 Setting Example of PWM Output

■ Overview
The PWM output is performed. It is controlled by the switch input (X140/X141) connected to the
32-point input unit. If the start input (X141) turns on when the enable input (X140) is on, the
PWM output will start.

9.4 Execution Example of Pulse Output / PWM Output Function
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■ Configuration
● Set the PWM output to the output (Y108).
● Select "PWM output" in the "Pulse Output Advanced" dialog box, and input the frequency

and duty.
● To change the frequency or duty ratio during the output, from data update timing, select

"When start signal rises or when data is updated" or "When start signal rises or when
comparison output is performed".

■ Time chart
If the rising of the start signal is detected when the enable input is on, pulses will be output.
When the enable input turns off, the pulse output will stop.

(1) If the rising edge of the start signal is detected when the enable signal is on, pulses will be output.

(2) Pulse output with a duty ratio of 50%.

(3) When the enable signal turns off, the pulse output will turn off.
 

(Note 1) The pulse output starts in the OFF period.
 

9.4 Execution Example of Pulse Output / PWM Output Function
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■ Sample program
The external inputs (X140, X141) are allocated to the enable (Y118) and start (Y11C) signals of
PWM output respectively.

9.4 Execution Example of Pulse Output / PWM Output Function
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10.1 Positioning Function

10.1.1 Overview of Positioning Function

The positioning control can be performed when the unit is used in combination with a stepping
motor or servo motor equipped with a driver of pulse string input type.
● Up to twenty positioning data tables for each channel are provided in configuration software

""Configurator PMX"", and can be allocated to arbitrary positioning controls (E-point
control/P-point control/C-point control/J-point control).

● Positioning controls can be executed by specifying positioning data table numbers with user
programs.

● JOG operation, five kinds of home return operations and four kinds of stop controls are also
supported.

● Positioning parameters and data of positioning data tables can be set using configuration
software ""Configurator PMX"". ""Configurator PMX"" is started from the "Options" menu of
FPWIN GR7.

■ Operation image

10.1 Positioning Function
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■ Outline of specifications

Item Specifications Remarks

No. of output
channels

Max. 4 channels (The total of positioning, pulse output and
PWM output)

Occupied I/O
numbers X0 to XF, Y4 to YF(Note 1) Per unit

Control input Home input, Near home input, Limit + input, Limit - input, J-
point control positioning start input Per channel

Control output
Pulse output: 2 points (CW/CCW or Pulse/Sign)
Deviation counter clear output: 1 point

Per channel

Position command -2147483648 to +2147483647

Speed command
(Pulse output
frequency)

1 to 500000 (1 Hz to 500 kHz)

Control Mode
Positioning control (E-point control/P-point control/C-point
control/J-point control)
JOG operation, home return, stop

 

(Note 1) The I/O numbers actually used vary according to the slot number where the unit is installed and the
starting word number. As for the near home input and J-point control positioning start input, either of
them can be selected and allocated.

 

10.1.2 Control Mode

There are mainly four control modes.

■ Control mode type

Item Description Related page

Positioning
Control

There are four modes, E-point control, P-point control, C-point control and
J-point control. Each control is executed by turning on an allocated output
(Y30-Y34) using user programs.

E-point control:
Executes a trapezoidal control. Performs a single-speed acceleration/
deceleration control.

P-point control:
Executes a trapezoidal control. Performs a multispeed acceleration/
deceleration control.

C-point control:
Executes multiple trapezoidal controls continuously.

J-point control:
Executes a position control by a timing input (position control start input)
after the start of speed control.

"P.10-47"

JOG operation
JOG operation is executed while an allocated output (Y3C-Y43) is on using
user programs. The speed can be changed after starting the JOG
operation.

"P.10-34"

Home Return There are five modes which correspond to various system configurations,
such as home return, near home input and limit input. Each control is "P.10-40"

10.1 Positioning Function
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Item Description Related page
executed by turning on an allocated output (Y38-Y3B) using user
programs.

Stop

There are four modes, system stop, emergency stop, limit stop and
deceleration stop. Each control is executed by turning on an allocated
output (Y44-Y4F) using user programs. (Except limit stop)

System stop:
Stops all channels without deceleration time.

Emergency stop:
Stops each channel using a set ""emergency stop time"".

Limit stop:
Stops at the time of limit input using a set ""limit stop time"".

Deceleration stop:
Stops each channel using a set ""deceleration time"".

"P.10-31"

10.1 Positioning Function
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10.2 Wiring

10.2.1 Connection Diagram with Servo Motor Amplifier

■ Connection example using sink output

 

(Note 1) The allocation of I/O numbers on the controller side depends on the unit settings.
 

10.2 Wiring
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■ Connection example using push-pull negative logic output

 

(Note 1) The allocation of I/O numbers on the controller side depends on the unit settings.
 

10.2 Wiring
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■ Connection example using differential output

 

(Note 1) The allocation of I/O numbers on the controller side depends on the unit settings.
 

● For details on the differential output setting method, refer to "5.2.3 Application to Differential
Output".

10.2 Wiring
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10.2.2 Connections with Servo Motor Amplifier

■ Connections of each signal and precautions

Signal type Point

Pulse command output

● Connect the output allocated to each channel and the command pulse input of
servo amplifier.

● Connect a resistor (2 kΩ) for limiting currents.
● Use twisted-pair cables for the connection.

Home input
● Connect the input allocated to each channel and the Z phase input of servo

amplifier.
● Use twisted-pair cables for the connection.

Near home input ● Connect the near home sensor.

CCW over limit input
● Connect the over limit switches.

CW over limit input

Deviation counter clear
output

● Connect the output allocated to each channel and the counter clear input of servo
amplifier.

● The length of a deviation counter clear signal is specified in the range of 1 to
100 ms in the ""Parameter Setting"" dialog box of Configurator PMX.

Servo on output ● Connect an arbitrary output of PLC to the servo on input of servo amplifier.

● Use twisted-pair cables for the connection between the unit and servo amplifiers.
● Connect each signal to the terminal numbers allocated in the "Positioning" I/O terminal

allocation screen in "Multi I/O Unit Setting" for FPWIN GR7.
● Terminal numbers and I/O numbers allocated to each signal vary according to the settings.

Each setting is configured in the "Multi I/O Unit Setting" dialog box of FPWIN GR7.Refer to
"10.4 Setting of Positioning Function".

10.2.3 Connection with Stepping Motor Driver

■ Connections of each signal and precautions

Signal type Point

Pulse command output

● Connect the output allocated to each channel and the command pulse input of
motor driver.

● Use twisted-pair cables for the connection.
● Use a 24 VDC input for the input on the driver side. When the input interface of

the driver is 5 VDC input, insert a resistor for limiting currents externally.

Home input
● Connect the input allocated to each channel and the home sensor.
● Use twisted-pair cables for the connection.

Near home input ● Connect the near home sensor.

CCW over limit input
● Connect the over limit switches.

CW over limit input

10.2 Wiring
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● Use twisted-pair cables for the connection between the unit and motor driver.
● Connect each signal to the terminal numbers allocated in the "Positioning" I/O terminal

allocation screen in "Multi I/O Unit Setting" for FPWIN GR7.
● Terminal numbers and I/O numbers allocated to each signal vary according to the settings.

Each setting is configured in the "Multi I/O Unit Setting" dialog box of FPWIN GR7.Refer to
"10.4 Setting of Positioning Function".

10.2 Wiring
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10.3 Initial Operation Check

10.3.1 Safety Circuit Design

■ System configuration example

Installation of the over limit switch

■ Items to check the safety circuit

No. Item Description

(1) Safety circuit based on
external circuit

Install the safety circuit recommended by the manufacturer of the motor
being used.

(2) Safety circuit based on the
unit

Install over limit switches as shown above.
Connect the over limit switches on the (+) and (-) sides to the input
circuit of PLC.

10.3 Initial Operation Check
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10.3.2 Before Turning On the Power

■ System configuration example

■ Items to check before turning on the power

No. Item Description

(1) Checking connections to the
various devices

Check to make sure the various devices have been connected as
indicated by the design.

(2) Checking the installation of
the external safety circuit

Check to make sure the safety circuit (wiring and installation of over
limit switch) based on an external circuit has been installed securely.

(3)
Checking the installation of
the safety circuit based on
the unit

Check the connection between the unit and over limit switches. Check
the installation condition of the over limit switches.

(4)
Checking the procedure
settings for turning on the
power supplies

Make sure settings have been entered so that power supplies will be
turned on in the sequence given in “"Sequence for Turning On the
Power"”.

(5) Checking the CPU mode
selection switch

Set the CPU unit to PROG. mode. The CPU unit in RUN mode may
operate unexpectedly.

10.3 Initial Operation Check
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10.3.3 Power-on and Power-off Sequences

■ Power-on sequence
When turning on the power to the system incorporating the unit, consider the nature and states
of any external devices connected to the system, and take sufficient care so that turning on the
power will not initiate unexpected movements.
1. Turn on the power supplies for the input and output devices connected to the PLC.
2. Turn on the power supply for the PLC.
3. Turn on the power supply for the motor driver.

■ Power-off sequence
1. Check to make sure the rotation of the motor has stopped, and then turn off the power

supply for the motor driver.
2. Turn off the power supply for the PLC.
3. Turn off the power supplies for the input and output devices connected to the PLC.

10.3.4 After Turning On the Power

■ System configuration example
Check each item in the following four major steps.

10.3 Initial Operation Check
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■ Items to check after turning on the power

No. Item Description

(1) Checking the installation of
the external safety circuit

Check to make sure the safety circuit (wiring and installation of over
limit switch) based on an external circuit has been installed securely.

(2) Checking the safety circuit
by the PLC unit

Check the connection between the unit and over limit switches. Check
the installation condition of the over limit switches.

(3) Checking the near home
input and home input

Check if the near home input and home are loaded as the inputs of the
PLC and activated properly by performing JOG operation or home
return operation.

(4)
Checking the rotation,
moving direction, and
moving distance.

Check the rotation, moving direction and moving distance by
performing JOG operation or positioning operation.

10.3 Initial Operation Check
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10.4 Setting of Positioning Function

10.4.1 I/O Allocation of Positioning Function

■ Input (External terminals)

Signal name Application

I/O number

Axis 1 Axis 2 Axis 3 Axis 4

CH0 CH1 CH2 CH3

Termi
nal
numb
er

I/O no. Termi
nal
numb
er

I/O no. Termi
nal
numb
er

I/O no. Termi
nal
numb
er

I/O no.

Z Home input A1 X0 A5 X4 B1 X8 B5 XC

DOG(Note 1) Near home input
A2 X1 A6 X5

B2 X9 B6 XD

JPOS(Note 1) J point control
positioning start input - - - -

LMT+ Limit + input A3 X2 A7 X6 B3 XA B7 XE

LMT- Limit - input A4 X3 A8 X7 B4 XB B8 XF
 

(Note 1) For channel 0 (CH0) and channel 1 (CH1), select either ""DOG"" or ""JPOS"". They can be allocated
in the ""Multi I/O Unit Setting"" dialog box of FPWIN GR7. Also, for using the both inputs, connect
either input to another external input terminal. They can be allocated to the unit internal I/O (JPOS/
DOG) in the table below using a user program.

 

■ Input (Internal I/O)

Signal name Application

I/O number

Axis 1 Axis 2 Axis 3 Axis 4

CH0 CH1 CH2 CH3

BUSY Control flag (X30) (X31) (X32) (X33)

FIN Operation done (X34) (X35) (X36) (X37)

HFIN Home return done (X38) (X39) (X3A) (X3B)

■ Output (External terminals)

Signal
name Application

I/O number

Axis 1 Axis 2 Axis 3 Axis 4

CH0 CH1 CH2 CH3

Termin
al
numbe
r

I/O no. Termin
al
numbe
r

I/O no. Termin
al
numbe
r

I/O no. Termin
al
numbe
r

I/O no.

CLR Deviation counter
clear A15 Y4 A16 Y5 A17 Y6 A18 Y7

PLS A Pulse output CW or
Pulse output A19 Y8 A21 YA A23 YC A14 YE

10.4 Setting of Positioning Function
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Signal
name Application

I/O number

Axis 1 Axis 2 Axis 3 Axis 4

CH0 CH1 CH2 CH3

Termin
al
numbe
r

I/O no. Termin
al
numbe
r

I/O no. Termin
al
numbe
r

I/O no. Termin
al
numbe
r

I/O no.

PLS B Pulse output CCW
or Sign output A20 Y9 A22 YB A24 YD A14 YF

■ Output (Internal I/O)

Signal name Application

I/O number

Axis 1 Axis 2 Axis 3 Axis 4

CH0 CH1 CH2 CH3

POS Positioning table
start (Y30) (Y31) (Y32) (Y33)

MPOS Positioning
simultaneous start (Y34)

HOME Home return start (Y38) (Y39) (Y3A) (Y3B)

JOG+ JOG operation
start (Forward) (Y3C) (Y3D) (Y3E) (Y3F)

JOG- JOG operation
start (Reverse) (Y40) (Y41) (Y42) (Y43)

SYS STP System stop (Y44)

EMG STP Emergency stop (Y48) (Y49) (Y4A) (Y4B)

DEC STP Deceleration stop (Y4C) (Y4D) (Y4E) (Y4F)

JPOS(Note 1) J point positioning
start input (Y50) (Y51) - -

DOG(Note 2) Near home input (Y52) (Y53) - -

JPOS SP J point control
speed change (Y54) (Y55) - -

ECLR Error clear (Y56)
 

(Note 1) Even when ""JPOS"" is selected for the external input X1 (or X5), Y50 (or Y51) can be used.
(Note 2) When ""DOG"" is selected for the external input X1 (or X5), Y52 (or Y53) cannot be used.
 

10.4.2 Configuration Using Tool Software

The setting of the positioning function is specified in the configuration menu of FPWIN GR7.

■ Setting method
The following procedure describes the process when the Multi I/O Unit (H type) has been
already allocated in the I/O map.

10.4 Setting of Positioning Function
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1. Select Options>Multi I/O Unit Setting in the menu bar.
The ""Select Multi I/O Unit"" dialog box is displayed.
Go to "Step 2"

2. Select ""H-type Multi I/O Unit"", and press the [[OK]] button.
The ""Multi I/O Unit Setting"" dialog box is displayed.

3. From the function selection tree, click ""Positioning"", and double-click an input number (or
output number) to which the positioning function is allocated.
The ""Positioning Advanced"" dialog box is displayed.
Go to "Step 4"

10.4 Setting of Positioning Function
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4. Select a function setting and press the [[OK]] button.
The input and output of the positioning function will be allocated. A maximum of four
channels can be allocated. Allocated channel numbers are fixed.

Function setting Content

Not used The positioning function is not allocated.

Used The input and output of the positioning function including near home input are
allocated.

Used
(Use J-point terminal)
(Only CH0/CH1)

The input and output of the positioning function including J point control positioning
start input are allocated.

10.4 Setting of Positioning Function
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5. Set "Counter elapsed value" and "Counter upper and lower limit values" as necessary.

6. Press the [[OK]] button.
In the following example, the positioning function for two channels (CH0 and CH1) are
allocated to the Multi I/O Unit (H type). The control inputs of CH0 are allocated to the inputs
(X100-X103) of the internal I/O and the control inputs of CH1 are allocated to the inputs
(X104-X107) automatically. Also, the control outputs of CH0 are allocated to the outputs
(Y104, Y108, Y109) and the control outputs of CH1 are allocated to the outputs (Y105,
Y10A, Y10B) automatically.

The set values will be effective when they are downloaded to the PLC with programs or
other configuration information as a project.

10.4 Setting of Positioning Function
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10.5 Positioning Table Settings (Configurator PMX)

10.5.1 Used Channel Setting

The following procedure describes the process when the Multi I/O Unit (H type) has been
already allocated in the I/O map and the positioning function has been allocated in the ""Multi
I/O Unit Setting"" dialog box.

1. Press the [[Positioning Table Settings]] button in the ""Multi I/O Unit Setting"" dialog box.

""Configurator PMX"" will be activated.

10.5 Positioning Table Settings (Configurator PMX)
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2. Select Channel setting>Used channel setting from the menu bar.
The ""Used channel setting"" dialog box is displayed.

3. Select the control method for the used axes, and press the [[OK]] button.
In the initial condition, the allocated channel numbers are selected for single control.
To select interpolation control, check the box of "Interpolation".
When the setting is changed, a confirmation message box will be displayed.
Press the [[Yes]] button. The changed setting will be reflected on the setting screen.

10.5 Positioning Table Settings (Configurator PMX)
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● When interpolation control is selected, the data table is changed to the channel numbers for the
X and Y axes, and ["Interpolation"] is displayed on the tab.

10.5.2 Parameter Settings

Use the Configurator PMX to allocate the most fundamental parameters for positioning control,
such as the motor rotation direction, pulse output method (CW/CCW and Pulse/Sign), home
input, limit input logic, and positioning control. The following procedure is explained on the
condition that the Configurator PMX has already started.
For the procedure of activating Configurator PMX, refer to ""10.5.1 Used Channel Setting"".

■ Parameters

Parameter name Default (Unit) Settings

Ba
si

c 
Se

tu
p

Pulse output method Pulse/Sign Pulse/Sign, CW/CCW

Pulse output rotation
direction CW direction +

When selecting Pulse/Sign mode:
CW direction +: Select this setting for the case that the elapsed
value is plused when Sign output turns off.
CCW direction +: Select this setting for the case that the
elapsed value is plused when Sign output turns on.

When selecting CW/CCW mode:
CW direction +: Select this setting for the case that the elapsed
value is plused at the time of CW output.
CCW direction +: Select this setting for the case that the
elapsed value is plused at the time of CCW output.

Startup Speed 100 (pps）

Set the startup speed common to each operation. This setting
is common to JOG operation, home return, E-point control, P-
point control, C-point control and J-point control.
Setting range: 1 to 500,000

Positioning repeat count 0

Specify this setting for performing repetitive controls when
using E-point/P-point/C-point control.
0, 1: Not repeat
2 to 254: Repeat for the specified number of times.
255: Repeat infinitely until the execution of stop control.

In
pu

t s
et

tin
g Home position logic Normal Open

Select the input logic for each switch.
Normal Open、Normal Close

Near home input logic Normal Open

Limit + switch logic Normal Open

Limit - switch logic Normal Open
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Parameter name Default (Unit) Settings
Po

si
tio

ni
ng

 s
et

tin
g Starting table number 1

Specify the table number to be started when a positioning start
signal is input.
Setting value: 1 to 20

Simultaneous starting
table number 0

Specify the table number to be started when a positioning
simultaneous start signal is input.
Setting value: 0
Specified channels do not start simultaneously.
Setting value: 1 to 20
Specified channels start with the set table number.

H
om

e 
re

tu
rn

Home return method Not use DOG method 1, DOG method 2, DOG method 3, Home
position method, Data set method, Not use

Home return direction Limit (-)
direction Limit (-) direction, Limit (+) direction

Home return acceleration
time 100 (ms） Setting range: 1 to 10,000

Home return deceleration
time 100 (ms） Setting range: 1 to 10,000

Home return target
speed 1000 (pps） Setting range: 1 to 500,000

Home return creep
speed 100 (pps） Setting range: 1 to 500,000

Deviation counter clear
time 1 (ms）

Setting range: 0 to 100
For 0, no deviation counter clear signal is output.

Coordinate origin 0 (Pulse)
When the home return method is Data set method, specify a
coordinate origin.
Setting range: -1,073,741,824 to +1,073,741,823

JO
G

 o
pe

ra
tio

n 
se

tti
ng

JOG acceleration
time(Note 1) 0 (ms） Setting range: 0 to 10,000

JOG deceleration
time(Note 1) 0 (ms） Setting range: 0 to 10,000

JOG target speed 1000 (pps） Setting range: 1 to 500,000

J point change target
speed 1000 (pps）

Set this setting for changing the speed during J-point control.
Setting range: 1 to 500,000

St
op

 s
et

tin
g Emergency stop

deceleration time 100 (ms） Setting range: 1 to 10,000(Note 2)

Limit stop deceleration
time 100 (ms） Setting range: 1 to 10,000(Note 2)

 

(Note 1) When either of them is set to 0 ms, the target speed is output without acceleration/deceleration.
(Note 2) Set a value by converting to a deceleration time from 500 kHz to 0 kHz.
 

1. Select Channel setting>Parameter settings from the menu bar.
The "Parameter Settings" dialog box is displayed.

10.5 Positioning Table Settings (Configurator PMX)

WUME-FP7MXY-06 10-23



2. Make necessary parameter settings according to the application and press the [[OK]]
button.
The settings will be stored as part of positioning parameter data.

10.5.3 Creating Positioning Data Table

● The positioning data tables are divided into sheets for each axis, and 20 tables ranging no. 1
to no. 20 can be set.

■ For independent axis control

Parameter
name

Default (Unit) Content

Operation
pattern E: End point

Select one from the following operation patterns.
E: End point, C: Continuance point, P: Pass point, J: Speed point

Control
method I: Increment Select either I: Increment or A: Absolute.
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Parameter
name

Default (Unit) Content

I: Increment The position moves relatively from the current position
by a specified amount.

A: Absolute The position moves to an absolue coordinate
determined by home return operation.

X-axis
movement
amount

0 (pulse) Input a movement amount. Setting range: -1,073,741,824 to
+1,073,741,823

Acceleration/
deceleration
type

L: Linear L: Linear (FIxed)

Acceleration
time 100 (ms) Set an acceleration time. Setting range: 1 to 10,000

Deceleration
time 100 (ms) Set a deceleration time. Setting range: 1 to 10,000

Target speed 1000 (pps) Set a target speed. Setting range: 1 to 500,000

Dwell time 0 (ms)

Set a dwell time from the end of each positioning control of positioning
operation table to the next operation.
Note that operations vary depending on operation patterns.

When operation pattern is E (end
point)

Turns on the positioning end
contact after the elapse of the dwell
time.

When operation pattern is C
(continuance point)

Stops the motor operation for the
dwell time and start the next
operation.

When operation pattern is P (pass
point)

This setting is ignored.
When operation pattern is J (speed
point)

Setting range: 0 to 32,767

■ For interpolation control

Parameter
name

Default (Unit) Content

Operation
pattern E: End point

Select one from the following operation patterns.
E: End point, C: Continuance point, P: Pass point

Interpolation
operation

Linear
(Composite
speed)

Select a specification method of speed.
Linear (Composite speed): Specify the speed combining the speed of X
and Y axes.
Linear (Long axis speed): Specify the speed on the long axis side whose
movement amount is large.

Control
method I: Increment

Select either I: Increment or A: Absolute.

I: Increment The position moves relatively from the current position
by a specified amount.

A: Absolute The position moves to an absolue coordinate
determined by home return operation.
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Parameter
name

Default (Unit) Content

X-axis
movement
amount

0 (pulse)
Input a movement amount of the channel specified for X axis.
Setting range: -8,388,608 to +8,388,607

Y-axis
movement
amount

0 (pulse)
Input a movement amount of the channel specified for Y axis.
Setting range: -8,388,608 to +8,388,607

Acceleration/
deceleration
type

L: Linear L: Linear (FIxed)

Acceleration
time 100 (ms) Set an acceleration time. Setting range: 1 to 10,000

Deceleration
time 100 (ms) Set a deceleration time. Setting range: 1 to 10,000

Interpolation
speed 1000 (pps)

Set either composite speed or major axis speed in accordance with the
selection of interpolation operation.
Setting range: 1 to 500,000

Dwell time 0 (ms)

Set a dwell time from the end of each positioning control of positioning
operation table to the next operation.
Note that operations vary depending on operation patterns.

When operation pattern is E (end
point)

Turns on the positioning end
contact after the elapse of the dwell
time.

When operation pattern is C
(continuance point)

Stops the motor operation for the
dwell time and start the next
operation.

When operation pattern is P (pass
point)

This setting is ignored.

Setting range: 0 to 32,767

■ Selection of positioning operation patterns
● For the E-point control, input settings in one row.
● For P-point control (speed change control), C-point control (continuance point control) and J-

point control (JOG positioning control), they should be combined with E-point control of the
next step as a pair and the settings should be input in two rows.

■ Table numbers and activation of positioning
● Table numbers on the Configurator PMX are specified in user programs.
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● The unit executes the control under the conditions set in the table by turning on the
positioning start contact corrensponding to a desired channel number (axis number) and
table number. Specify the first data table number for each control in the program.

● For details of each control, refer to ""10.10 Positioning Control"".

10.5.4 Saving Positioning Parameters

Information on positioning parameters and positioning data tables set on Configurator PMX is
saved as part of program files.

1. Select File>Save changes and exit from the menu bar.
A confirmation message box appears.

2. Press [Yes].
● The set information will be saved as part of project files.
● When selecting [No], the changes made immediately before will be discarded. When

selecting [Cancel], it will return to the setting screen of Configurator PMX with the
changes made immediately before still in place.
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10.5.5 Export and Import

● Basic parameters and positioning parameters set can be exported to and imported from the
Configurator PMX.

● Information on positioning parameters and positioning tables saved by using the export
function can be reused between projects.

1. Select File>Export from the menu bar.
The saving destination and file names appear.

2. Enter a saving destination and file name, and press [Save] button.
Information on the parameters and positioning data tables will be saved in a file with a
“.pmx” extension.

● When export is executed, information on the positioning data tables will be saved along
with parameters set in the parameter setting menu.

10.5.6 Check on Parameter Data

● The following procedure is explained on the condition that the Configurator PMX has already
started.

1. Select Debug>Check Parameter and Data Values from the menu bar.
A message box appears to show the check result. If there is an error in the settings for the
positioning data tables, an error message will appear and the cursor will move to the
corresponding error position.
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10.5.7 Writing Parameters to Unit

● Set parameter information is transferred to the CPU unit.
● The following procedure is explained on the condition that the Configurator PMX has already

started.

1. Select File>Save changes and exit from the menu bar of Configurator PMX.

2. When ""Do you want to save the setting?"" appears, press [[Yes (Y)]].

3. Select Online>Download To PLC from the FPWIN GR7 menu bar.
Positioning data will also be downloaded to the CPU unit together with programs comment
and system register information.
File>Download positioning table in the menu bar of "Configurator PMX" is not available
for the Multi I/O Unit (H type).
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10.6 Read/Write of Elapsed Value

10.6.1 Elapsed Value (Current Value) Area

● They are stored as 2-word 32-bit data in the axis information area of unit memories.
● The elapsed value area will be reset when the power supply turns off. It will be held when

switching the mode from RUN to PROG.

■ Counting range of elasped value (current value) area

Item Range

During single
axis control

-1073741824 to +1073741823

During
interpolation axis
control

-8388608 to +8388607

10.6.2 Reading Elapsed Value (Current Value) Area

The elapsed value can be read from the unit memory (elapsed value: current value
coordinate)area.

■ Sample program
In this example, the elapsed value of the Multi I/O Unit installed in the slot 0 is read.

■ Allocation of unit memories (UM)

Signal name CH0 CH1 CH2 CH3

Elapsed value
(Current value
coordinates)

UM00220-UM00221 UM0022A-UM0022B UM00234-UM00235 UM0023E-UM0023F

PLS/PWM
counter UM00170-UM00171 UM00172-UM00173 UM00174-UM00175 UM00176-UM00177

 

(Note 1) The elapsed values of the channels which use positioning control are also applied in the ""PLS/PWM
counter elapsed value area"". They can be used for the comparison match function, etc.

 

● Programs for reading and writing values from unit memories can be easily created by using the
""Template Function"" of FPWIN GR7.Refer to "11.1 Creating of Ladder Programs Using
Templates".
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10.7 Stop Control

10.7.1 Type of stop operations

■ Type of stop operations

Name Time chart Occurrence condition and operation

System
stop

● Once the system stop contact (Y44) turns
on, an active operation will stop and the
pulse outputs of all channels will
immediately stop.

● The similar operation is performed when the
operation mode of the control unit is
switched from RUN to PROG.

Emergenc
y stop

Emergency stop deceleration time
● Once an emergency stop contact (Y48-Y4B)

turns on, an active operation will stop and
the pulse outputs of corresponding channels
will stop.

● Performs a deceleration stop in the
emergency stop deceleration time specified
in the positioning parameter setting menu of
Configurator PMX.
The specified time is a deceleration time
from 500 kHz.

Limit stop

Limit stop deceleration time
● Once the limit + input or limit - input (X2, X3,

X6, X7, XA, XB, XE, XF) turns on, an active
operation will stop and the pulse outputs of
corresponding channels will stop.

● Performs a deceleration stop in the limit
stop deceleration time specified in the
positioning parameter setting menu of
Configurator PMX.
The specified time is a deceleration time
from 500 kHz.

Decelerati
on stop

Deceleration time
● Once a deceleration stop contact (Y4C-Y4F)

turns on, an active operation will stop and
the pulse outputs of corresponding channels
will stop.

● Performs a deceleration stop in the
deceleration time specified for the active
positioning operation.

■ Execution of stop operations
Stop controls are executed when the following I/O signals turn on.
1. System stop > 2. Emergency stop > 3. Limit stop > 4. Deceleration stop
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■ Allocation of I/O numbers (External inputs)

Signal name Application

I/O number

Axis 1 Axis 2 Axis 3 Axis 4

CH0 CH1 CH2 CH3

Extern
al
conne
ction
termin
al no.

Interna
l input
no.

Extern
al
conne
ction
termin
al no.

Interna
l input
no.

Extern
al
conne
ction
termin
al no.

Interna
l input
no.

Extern
al
conne
ction
termin
al no.

Interna
l input
no.

LMT+ Limit + input A3 X2 A7 X6 B3 XA B7 XE

LMT- Limit - input A4 X3 A8 X7 B4 XB B8 XF
 

(Note 1) The limit inputs are processed once in one scan.
 

■ Allocation of I/O numbers (Internal inputs)

Signal name Application

I/O number

Axis 1 Axis 2 Axis 3 Axis 4

CH0 CH1 CH2 CH3

SYS STP System stop Y44

EMG STP Emergency stop Y48 Y49 Y4A Y4B

DEC STP Deceleration stop Y4C Y4D Y4E Y4F

■ Sample program
The execution condition is set to be always executed. A program is shown below for when the
inputs of ""SYS STP"", ""EMG STP"" and ""DEC STP"" are allocated to the external connection
terminal numbers X108, X109, and X10A.

10.7.2 Characteristics of Stop Operations

■ Priority of stop operations
When stop control requests are made simultaneously, the stop operations are executed
according to the following priority.
1. System stop > 2. Emergency stop > 3. Limit stop > 4. Deceleration stop
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■ Dwell time setting
The dwell time setting is invalid in the stop operations regardless of patterns.

■ Flag processing
● In the case of system stop, the busy signal turns off and the operation done signal turns on.
● In the cases of emergency stop, limit stop and deceleration stop, the busy signal turns off

and the operation done signal turns on after the completion of the pulse output during
deceleration.

■ Elapsed value area (Current value coordinate)
● Even in a stop operation, the elapsed value area is always updated.
● After the emergency stop, limit stop or deceleration stop, deceleration is performed with each

specified deceleration time, and the value when the pulse output stops is stored.
● In the case of system stop, the value when the pulse output stops is stored.

● For details of the deceleration stop operations when repetitive control is executed, refer to
"10.11.3 Stop Operation During Repeat Operation".
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10.8 JOG operation

10.8.1 Setting and Operation of JOG Operation

An operation in which the motor is rotated only while operation commands are being input is
called JOG operation. This is used to forcibly rotate the motor using input from an external
switch, for instance when to make adjustments.
Pulses are output while the JOG operation start contact is on.

Table
Forward JOGReverse JOG

Ball screw

(-) side (+) side

■ Operation diagram

t [ms]

f [Hz]

100ms

20,000Hz

1,000Hz

Instruction start condition

Busy signal

Operation done signal

200ms

JOG operation target speed 20,000

■ Operations of each contact
● The BUSY flags (X30-X33), which indicate that the motor is running, will turn on when the

JOG operation starts, and they will turn off when the operation completes.
● The operation done flags (X34-X37), which indicate the completion of operation, will turn on

when the current operation is completed, and they will be held until the next positioning
control, JOG operation or home return operation starts.
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■ Cautions on Programming
● The startup contact and flag numbers vary depending on channel numbers (axis numbers).
The parameters for JOG operations are specified in the "Positioning Parameter Setting" menu
of Configurator PMX.

■ Settings

Item Value

Axis Setting Area

Startup Speed 1,000 Hz

JOG acceleration time 100 ms

JOG deceleration time 200 ms

JOG target speed 20,000 Hz

■ Configurator PMX settings

■ Allocation of I/O signals

Signal name Application

I/O number

Axis 1 Axis 2 Axis 3 Axis 4

CH0 CH1 CH2 CH3

JOG+ JOG operation start
(Forward)

Y3C Y3D Y3E Y3F

JOG- JOG operation start
(Reverse)

Y40 Y41 Y42 Y43

■ Sample program
The execution condition is set to be always executed.
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■ Operation at limit input

Condition Direction Limit status Operation

At startup

Forward
Over limit input (+): ON Not executable, Error occurs.

Over limit input (-): ON Executable

Reverse
Over limit input (+): ON Executable

Over limit input (-): ON Not executable, Error occurs.

During
operation

Forward
Over limit input (+): ON Limit stops, error occurs(Note 1)

Over limit input (-): ON Limit stops, error occurs(Note 1)

Reverse
Over limit input (+): ON Limit stops, error occurs(Note 1)

Over limit input (-): ON Limit stops, error occurs(Note 1)

 

(Note 1) Create a program as below if you do not want to restart the instruction when the limit error occurs
during an operation when the execution condition has been set to be always executed.

 

10.8.2 Setting and Operation of JOG Operation (Speed Changes)

It is possible to change a target speed during the JOG operation. The target speed is changed
by rewriting unit memories using a user program.

10.8 JOG operation

10-36 WUME-FP7MXY-06



■ Operation diagram

t [ms]

f [Hz]

20,000Hz

1,000Hz

100ms

10,000Hz

20,000 10,000

Rewriting the target speed

Approx.100ms Approx.100ms

Instruction start condition

Busy signal

Operation done signal

JOG operation target speed

■ Operations of each contact
● The BUSY flags (X30-X33), which indicate that the motor is running, will turn on when the

JOG operation starts, and they will turn off when the operation completes.
● The operation done flags (X34-X37), which indicate the completion of operation, will turn on

when the current operation is completed, and they will be held until the next positioning
control, JOG operation or home return operation starts.

■ Characteristics of acceleration/deceleration zone when changing speeds
● The speeds of acceleration zone and deceleration zone changes by approx. 100 us when

changing the speeds in the JOG operation. The speed variation is obtained by the following
formula.
Speed variation = (JOG operation target speed - Startup speed) / (JOG acceleration time or
JOG deceleration time)

● When the JOG acceleration time or JOG deceleration time is set to 0 ms, the speed will be
changed immediately.

■ Settings

Item Setting example

Axis Setting Area

Startup Speed 1,000 Hz

JOG acceleration
time

100 ms

JOG deceleration
time

200 ms
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Item Setting example

JOG operation
target speed

20,000 Hz -> 10,000 Hz

■ Configurator PMX settings

■ Allocation of I/O signals

Signal name Application

I/O number

Axis 1 Axis 2 Axis 3 Axis 4

CH0 CH1 CH2 CH3

JOG+ JOG operation start
(Forward)

Y3C Y3D Y3E Y3F

JOG- JOG operation start
(Reverse)

Y40 Y41 Y42 Y43

■ Sample program
The execution condition is set to be always executed.

■ Cautions on Programming
● To change a speed during the JOG operation, rewrite the value of the unit memory (axis

setting area) using a user program.
● The startup contact and flag numbers vary depending on channel numbers (axis numbers).

10.8 JOG operation
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10.8.3 Speed Changes in JOG Operation

● The value of ""JOG operation target speed"" in the axis setting area is constantly monitored
while the operation is being executed. When the target speed is changed, it will be changed
with the same acceleration.

● The speed change is executed after the completion of acceleration/deceleration.
● The speed range in which the JOG operation can be set is 1 Hz to 500 kHz. If a value out of

the range is set, the speed cannot be changed. The speed remains that before making this
setting.

● When the JOG acceleration time or JOG deceleration time is set to 0 ms, the speed will be
changed immediately.
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10.9 Home Return

10.9.1 Types of Home Return

The home return is specified in the positioning parameter setting dialog box for each axis.

Name Operation diagram Operation and application

DOG
method
1

Limit (-)

Home switch

Home return creep speed
Target speed

Home return
deceleration time

Limit (+)Near home

Home return direction

● The leading edge of the first home input
is set as a home position after the
detection of the leading edge of the near
home input.

● Even when the limit input turns on, the
motor rotation will be automatically
reversed and the home return operation
will continue.

● This method is used when the home
switch exists in the range that the near
home switch is enabled, such as a
system using a servo motor. This
method can also be used when no
home switch exists in the range that the
near home switch is enabled.

DOG
method
2

Limit (-)

Target speedHome return
deceleration time

Limit (+)Near home

Home return direction

● The leading edge of a near home input
is detected and it is set as a home
position.

● Even when the limit input turns on, the
motor rotation will be automatically
reversed and the home return operation
will continue.

● This method is used for performing the
home return with the near home switch
only.

DOG
method
3

Limit (-) Home switch

Home return creep speed
Target speed

Home return
deceleration time

Limit (+)Near home

Home return direction

● The leading edge of the first home input
in the home return direction set as a
home position after the detection of a
trailing edge (back end) of the near
home input.

● Even when the limit input turns on, the
motor rotation will be automatically
reversed and the home return operation
will continue.

● This method is used when no home
switch exists in the range that the near
home switch is enabled.

Home
position
method

Limit (-)
Home switch

Home return creep speed

Limit (+)

Home return direction

● Moves the current position to the home
return direction, and stops at the
position where the leading edge of the
home input is detected. This coordinate
is set as the starting point.

● When no home input exists in the home
return direction, the limit input turns on
and the operation stops.

● This method is used for performing the
home return with the home switch only.
This method is compatible with the F171
instruction of the existing model
FPsigma.
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Name Operation diagram Operation and application

Data set
method

Home position (= Current value)

● Performs the home return based on the
home coordinate values in the axis
setting area of positioning memory.

● Performs the home return toward the
home coordinate on the software.

● When the starting point is within the limit
switch, it cannot be started.

10.9.2 Operation Patterns of Home Return Operation

The operations vary according to selected home return methods and the difference in current
positions.

■ DOG method 1 (Edge detection of near home switch + Home switch, based on
front end)

The leading edge of the first home switch is set as a home position after the detection of the
leading edge of the near home switch.

The starting point is
between the near home
switch and limit (+) switch.

①

The starting point is
between the near home
switch and limit (-) switch.

③

The starting point is on the
near home switch.

Limit (-) switch

Home switch

Target speed

Home return creep speed

Home return creep speed

Home return creep speed

Target speed

Target speed

Target speed

Target speed Home return
deceleration time

Home return
deceleration time

Home return
deceleration time

Home return
deceleration time

Limit stop
deceleration time

Limit (+) switchNear home switch

Home return direction

②

The starting point is on the
limit (-) switch.

④

■ DOG method 2 (Edge detection of near home switch)
The leading edge of the near home switch is detected and it is set as a home position.
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Target speed

Target speed

Target speed

Target speed

Target speed

Limit stop
deceleration time

Home return
deceleration time

Home return
deceleration time

Home return
deceleration time

Home return
deceleration time

Home return creep speed

Home return creep speed

Home return creep speed

Home return creep speed

Limit (-) switch Limit (+) switchNear home switch

Home return direction

The starting point is
between the near home
switch and limit (+) switch.

The starting point is
between the near home
switch and limit (-) switch.

The starting point is on the
near home switch.

The starting point is on the
limit (-) switch.

①

③

②

④

■ DOG method 3 (Edge detection of near home switch + Home switch, based on
back end)

The leading edge of the first home switch in the home return direction is set as a home position
after the detection of the trailing edge (back end) of the near home switch.

Limit (-) switch Limit (+) switchNear home switch

Home return direction

The starting point is
between the near home
switch and limit (+) switch.

The starting point is
between the near home
switch and limit (-) switch.

The starting point is on the
near home switch.

The starting point is on the
limit (-) switch.

Home switch

Home return creep speedHome return creep speed

Home return creep speedHome return creep speed

Home return creep speedHome return creep speed

Home return creep speedHome return creep speed

Target speed

Target speed

Target speed

Limit stop
deceleration time

Home return
deceleration time

Home return
deceleration time

Home return
deceleration time
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■ Home position method (Edge detection of home switch)
Moves the current position to the home return direction, and stops at the position where the
leading edge of the first home switch is detected. This coordinate is set as a home position.

Home return directionHome switch

Home return creep speed

■ Data set method
Performs the home return based on the home coordinate values in the axis setting area of unit
memories.

Home position (= Current value)

● For details of addresses and settings of unit memories, refer to ""13.3 List of Unit Memories"".

10.9.3 Settings and Operations of Home Return

● The parameters for home return operations are specified in the "Positioning Parameter
Setting" menu of Configurator PMX.

● When the home return start contact turns on, the pulse output starts and the home return
operation is performed.

● In the following example, the DOG1 method is selected. After the start, it moves at a target
speed and reverses at the time of near home detection. After the redetection of near home
input, it moves at a creep speed until the home position is detected.
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■ Operation diagram
Home return target speed

Home return creep speed

Home return start contact

Near home switch (DOG)

Home switch

Home return done flag

Deviation counter clear signal

BUSY flag

■ Operations of each contact
● The BUSY flags (X30-X33), which indicate that the motor is running, will turn on when the

home return operation starts, and they will turn off when the operation completes.
● The deviation counter clear signal will turn on after the completion of the home return

operation. The ON time is set in the axis setting area of the unit memories.
● The home return done flags (X38 to X3B), which indicate the completion of home return

operation, will turn on when the current operation is completed, and they will be held until
any operation of the positioning control, JOG operation and home return operation starts.
The timing of turning on the flags is on the completion of the home return.

■ Settings

Item Setting example

Axis Setting Area

Home return method DOG method 1

Home return direction Limit (-) direction

Home return acceleration time
(ms)

100 ms

Home return deceleration time
(ms)

100 ms

Home return target speed 10000 pps

Home return creep speed 1000 pps

Deviation counter clear time 1 ms
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■ Configurator PMX settings

■ Allocation of I/O signals

Signal name Application

I/O number

Axis 1 Axis 2 Axis 3 Axis 4

CH0 CH1 CH2 CH3

BUSY Control flag X30 X31 X32 X33

HOME Home return start Y38 Y39 Y3A Y3B

■ Sample program
The execution condition is differential execution.

■ Operation at limit input

Condition Direction Limit status Operation

At startup

Forward
Over limit input (+): ON Executable(Note 2)(Note 3)

Over limit input (-): ON Executable(Note 3)

Reverse
Over limit input (+): ON Executable(Note 3)

Over limit input (-): ON Executable(Note 2)(Note 3)

During operation
Forward

Over limit input (+): ON Automatic reverse
operation(Note 4)

Over limit input (-): ON edge(Note 1) Limit stops, Error occurs.

Reverse Over limit input (+): ON edge(Note 1) Limit stops, Error occurs.
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Condition Direction Limit status Operation

Over limit input (-): ON Automatic reverse
operation(Note 4)

 

(Note 1) Only when an edge signal is detected, the limit stop is performed.
(Note 2) In the case of home position method, it cannot be executed.
(Note 3) In the case of data set method, it cannot be executed.
(Note 4) Under some circumstances, ""Limit Stop or Error"" (Example) After detecting home position proximity,

if the limit input is enabled during deceleration, a limit stop is performed without reverse operation.
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10.10 Positioning Control

10.10.1 Types of Positioning Controls

■ Operation pattern

Name Time chart Operation and application
Repea
t

Inter-
pola-
tion

E-
point
contro
l

● This is a method of control which is
initiated up to an end point, and is
referred to as “E-point control".

● This method is used for a first
speed acceleration/deceleration.

A A

P-
point
contro
l

● This refers to control which passes
through a “Pass Point”, and is
called “P-point control”.

● This method is used for a second
speed acceleration/deceleration.

● After the pulse output is performed
for a specified movement amount,
it shifts to the E-point control.

A A

C-
point
contro
l

● This refers to control which passes
through a “Continuance Point”, and
is called "C-point control”.

● This method is used for performing
two successive first speed
positioning control with different
target speeds or acceleration/
deceleration times.

● The time taken for transmitting
from the C-point control to E-point
control is specified as a dwell time.

A A

J-
point
contro
l

No speed change

● This refers to control which passes
through a speed point “JOG
Operation Point”, and is called "J-
point control”.

● After the start, it is controlled at
specified speeds.

● Once the J-point positioning
contact turns on, the positioning
control starts.

● When the J-point control speed
change flag is set, the speed
changes.

- -
Speed changes

■ Selection of positioning operation modes
Positioning operation modes are selected on Configurator PMX.
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● For the E-point control, input settings in one row.
● For P-point, C-point and J-point controls, they should be combined with E-point control of the

next step as a pair and the setting should be input in two rows.

● When E: End point is not selected in the next row after P: Pass point, C: Continuance point or
J: Speed point, the self-diagnostic error (error code 44: positioning error) is set to UM00066.
For details of positioning error codes, refer to ""12.2.2 What to Do When Positioning Error
Occurs"".

■ Settings of J-point control
● For J-point control, select ""Increment"" as a control method.
● For changing speed during J-point control, set the target speed after the change in the

"Positioning Parameter" dialog box.

10.10.2 E-point Control (Single Speed Positioning)

● When the positioning table start contact or positioning simultaneous start contact turns on,
the pulse output starts and the positioning control operation is performed.
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■ Operation diagram

t [ms]

f [Hz]

100ms 200ms

50ms

100,000 pulses

20,000Hz

1,000Hz

Instruction
start condition

Busy signal

Operation
done signal

Table 1

■ Operations of each contact
● The BUSY flags (X30-X33), which indicate that the motor is running, will turn on when the

position control starts, and they will turn off when the operation completes.
● The operation done flags (X34-X37), which indicate the completion of operation, will turn on

when the current operation is completed, and they will be held until the next positioning
control, JOG operation or home return operation starts.

■ Settings
The parameters for position control operations are specified in the "Positioning Parameter
Setting" menu and data table of Configurator PMX.

Item Setting example

Axis Setting Area Startup Speed 1,000 Hz

Table area

Table No. Table 1

Operation pattern E-point control (End point control)

Control method Increment mode

X-axis (CH0)
movement amount

100,000 pulses

Positioning
acceleration time

100 ms

Positioning
deceleration time

200 ms

Positioning target
speed

20,000 Hz

Dwell time 50 ms
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■ Configurator PMX settings

■ Allocation of I/O signals

Signal name Application

I/O number

Axis 1 Axis 2 Axis 3 Axis 4

CH0 CH1 CH2 CH3

BUSY Control flag X30 X31 X32 X33

POS Positioning table start Y30 Y31 Y32 Y33

MPOS Positioning
simultaneous start

Y34

■ Sample program
The execution condition is differential execution.

10.10.3 P-point Control (Double Speed Positioning)

● When the positioning table start contact or positioning simultaneous start contact turns on,
the pulse output starts and the positioning control operation is performed.
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■ Operation diagram

t [ms]

f [Hz]

100ms

50ms

50,000 pulses

20,000Hz

1,000Hz

10,000Hz

250ms 250ms

100,000 pulses

Instruction
start condition

Busy signal

Operation
done signal

Table 1 Table 2

■ Operations of each contact
● The BUSY flags (X30-X33), which indicate that the motor is running, will turn on when the

position control starts, and they will turn off when the operation completes.
● The operation done flags (X34-X37), which indicate the completion of operation, will turn on

when the current operation is completed, and they will be held until the next positioning
control, JOG operation or home return operation starts.

■ Settings
The parameters for position control operations are specified in the "Positioning Parameter
Setting" menu and data table of Configurator PMX.

Item Setting example

Axis Setting Area Startup Speed 1,000 Hz

Table area

Table No. Table 1 Table 2

Operation pattern P-point control (Pass point
control)

E-point control (End point
control)

Control method Increment mode Increment mode

X-axis (CH0)
movement amount

50,000 pulses 100,000 pulses

Positioning
acceleration time

100 ms 150 ms

Positioning
deceleration time

200 ms 250 ms

Positioning target
speed

20,000 Hz 10,000 Hz

Dwell time - 50 ms
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■ Configurator PMX settings

■ Allocation of I/O signals

Signal name Application

I/O number

Axis 1 Axis 2 Axis 3 Axis 4

CH0 CH1 CH2 CH3

BUSY Control flag X30 X31 X32 X33

POS Positioning table start Y30 Y31 Y32 Y33

MPOS Positioning
simultaneous start

Y34

■ Sample program
The execution condition is differential execution.

10.10.4 C-point control

● When the positioning table start contact or positioning simultaneous start contact turns on,
the pulse output starts and the positioning control operation is performed.
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■ Operation diagram

t [ms]

f [Hz]

100ms

50ms

100,000
pulses

20,000Hz

1,000Hz

10,000Hz

200ms 250ms

50,000
pulses

150ms

30ms
Instruction

start condition

Busy signal

Operation
done signal

Table 1 Table 2

■ Operations of each contact
● The BUSY flags (X30-X33), which indicate that the motor is running, will turn on when the

position control starts, and they will turn off when the operation completes.
● The operation done flags (X34-X37), which indicate the completion of operation, will turn on

when the current operation is completed, and they will be held until the next positioning
control, JOG operation or home return operation starts.

■ Settings
The parameters for position control operations are specified in the "Positioning Parameter
Setting" menu and data table of Configurator PMX.

Item Setting example

Axis Setting Area Startup Speed 1,000 Hz

Table area

Table No. Table 1 Table 2

Operation pattern C-point control (Continuance
point control)

E-point control (End point
control)

Control method Increment mode Increment mode

X-axis (CH0)
movement amount

100,000 pulses 50,000 pulses

Positioning
acceleration time

100 ms 150 ms

Positioning
deceleration time

200 ms 250 ms

Positioning target
speed

20,000 Hz 10,000 Hz

Dwell time 30 ms 50 ms
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■ Configurator PMX settings

■ Allocation of I/O signals

Signal name Application

I/O number

Axis 1 Axis 2 Axis 3 Axis 4

CH0 CH1 CH2 CH3

BUSY Control flag X30 X31 X32 X33

POS Positioning table start Y30 Y31 Y32 Y33

MPOS Positioning
simultaneous start

Y34

■ Sample program
The execution condition is differential execution.

10.10.5 J-point Control (JOG Positioning)

● When the positioning table start contact or positioning simultaneous start contact turns on,
the pulse output starts. In the J-point control, the unit operates at a taret speed after the
startup, and starts the position control when the J-point control positioning start input (X1, X5
or Y50, Y51) turns on.

● For J-point control, only "Increment" can be used as a control method.
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■ Operation diagram

T [ms]

f [Hz]

100ms
5ms

20,000Hz

1,000Hz

250ms

100000
pulses

15,000Hz

J-point positioning
start contact

Approx. 250ms

Instruction
start condition

Busy signal

Operation
done signal

Table 1 Table 2

■ Operations of each contact
● The BUSY flags (X30, X31) will turn on when the operation starts and turn off when the

operation is completed.
● The operation done flags (X34, X35) will turn on when the JOG operation is completed, and

it will be held until the next positiotning control, JOG operation, or home return operation
starts.

● Positioning control will start when J-point control positioning start inputs (X1, X5 or Y50, Y51)
turn on. However, when the inputs (X1, X5) are used as near home inputs, J-point control will
not be performed.

■ Settings
The parameters for position control operations are specified in the "Positioning Parameter
Setting" menu and data table of Configurator PMX.

Item Setting example

Axis Setting Area
Startup Speed 1,000 Hz

J-point change speed 10,000 Hz

Table area

Table No. Table 1 Table 2

Operation pattern J-point control (Speed
control)

E-point control (End point
control)

Control method Increment mode Increment mode

X-axis (CH0)
movement amount

- 100,000 pulses

Positioning
acceleration time

100 ms 150 ms
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Item Setting example

Positioning
deceleration time

200 ms 250 ms

Positioning target
speed

20,000 Hz 15,000 Hz

Dwell time 30 ms 5 ms

■ Configurator PMX settings

■ Allocation of I/O signals

Signal name Application

I/O number

Axis 1 Axis 2 Axis 3 Axis 4

CH0 CH1 CH2 CH3

BUSY Control flag X30 X31 X32 X33

POS Positioning table start Y30 Y31 Y32 Y33

MPOS Positioning
simultaneous start

Y34

■ Sample program
The execution condition is differential execution.
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10.10.6 J-point Control (JOG Positioning: Speed Changes)

● In the J-point control, the speed can be changed while controlling the speed after the start.
● After starting the J-point control, the unit operates at the speed specified in the positioning

parameters of Configurator PMX.
● The speed changes when the J-point control speed change flag (Y54, Y55) turns on.
● For J-point control, only "Increment" can be used as a control method.

■ Operation diagram

t [ms]

f [Hz]

100ms

50ms

20,000Hz

1,000Hz

10,000Hz

Approx. 50 ms 250ms

100000
pulses

150 ms

15,000Hz

J-point speed
change

J-point speed
change contact

J-point positioning
start contact

Instruction
start condition

Busy signal

Operation
done signal

Table 1 Table 2

■ Operations of each contact
● The BUSY flags (X30, X31) will turn on when the operation starts and turn off when the

operation is completed.
● The operation done flags (X34, X35) will turn on when the JOG operation is completed, and

it will be held until the next positiotning control, JOG operation, or home return operation
starts.

● The target speed will be changed when the J-point control speed change flags (Y54, Y55)
turn on. The change will be enabled at the edge where the contact turns on.

● Positioning control will start when J-point control positioning start inputs (X1, X5 or Y50, Y51)
turn on. However, when the inputs (X1, X5) are used as near home inputs, J-point control will
not be performed.

■ Characteristics of acceleration/deceleration zone when changing speeds
● The speed of speed change zone changes by approx. 100 us when changing the speed in

the J-point control. The speed variation is obtained by the following formula.

10.10 Positioning Control

WUME-FP7MXY-06 10-57



(J-point table target speed - Startup speed) / (J-point table acceleration time or J-point table
deceleration time)

■ Settings
The parameters for position control operations are specified in the "Positioning Parameter
Setting" menu and data table of Configurator PMX.

Item Setting example

Axis Setting Area
Startup Speed 1,000 Hz

J-point change speed 10,000 Hz

Table area

Table No. Table 1 Table 2

Operation pattern J-point control (Speed
control)

E-point control (End point
control)

Control method Increment mode Increment mode

X-axis (CH0)
movement amount

- 100,000 pulses

Positioning
acceleration time

100 ms 150 ms

Positioning
deceleration time

200 ms 250 ms

Positioning target
speed

20,000 Hz 15,000 Hz

Dwell time 30 ms 50 ms

■ Configurator PMX settings
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■ Allocation of I/O signals

Signal name Application

I/O number

Axis 1 Axis 2 Axis 3 Axis 4

CH0 CH1 CH2 CH3

BUSY Control flag X30 X31 X32 X33

POS Positioning table start Y30 Y31 Y32 Y33

MPOS Positioning
simultaneous start

Y34

JPOS SP J point control speed
change

Y54 Y55 ― ―

■ Sample program
The execution condition is differential execution.

■ Behaviors when the speed change contact turns on while the positioning unit is
accelerating or decelerating the speed

● A speed change is possible during J-point control, but impossible during acceleration or
deceleration.

● A speed change will be made after the positioning unit goes to a constant speed when the
speed change signal turns on during acceleration or deceleration.
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● Specify parameters for the start of operation in the positioning data table. The parameters for
changing speeds are specified in the Channel setting>Parameter settings menu. For details
about parameter settings, refer to ""10.5.2 Parameter Settings"".

● J-point control can be used for single-axis control only. It is not available for interpolation
control. For details about how to use axes, refer to ""10.5.1 Used Channel Setting"".

● Set the unit to increment mode to implement E-point control with positions specified after J-
point control is implemented.

● Speed control is performed while the positioning unit is in J-point control, in which case, be
sure to input the amount of movement for positioning with a value that can secure a target
constant-speed area.

10.10.7 Programming Cautions

■ Programming cautions
● The last table should be set to E: End point.
● If any value such as a movement amount, acceleration time, deceleration time or target

speed is out of the specified range, a positioning error will occur when the position control
starts.

● The startup contact and flag numbers vary depending on channel numbers (axis numbers).

■ Operation at limit input

Conditions Direction Limit status Operation

When each control starts

Forward
Over limit input (+): ON Not executable, Error occurs.

Over limit input (-): ON Not executable, Error occurs.

Reverse
Over limit input (+): ON Not executable, Error occurs.

Over limit input (-): ON Not executable, Error occurs.

When each control is
performed

Forward
Over limit input (+): ON Limit stops, Error occurs.

Over limit input (-): ON Limit stops, Error occurs.

Reverse
Over limit input (+): ON Limit stops, Error occurs.

Over limit input (-): ON Limit stops, Error occurs.
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10.11 Repeat Operation

10.11.1 Overview of Repeat Operation

● When the positioning table start contact is on, the unit repeats the operation set in the
positioning table.

■ Conditions of repeat control

Item Repeat control is available Repeat control is unavailable

Operation pattern E-point control, P-point control + E-point
control, C-point control + E-point control

JOG operation, J-point control, Interpolation
control

Control method Increment mode Absolute mode

Dwell time setting Set the table of E-point control to 1 ms or
more. When setting 0 ms.

■ Operation diagram (Setting operation on the table)

■ Operation diagram (Repeat operation)

■ Configurator PMX setting items
The repeat count is specified for executing the repeat control in Configurator PMX.

Parameter name Unit Default Settings

Positioning repeat count times 0 0 or 1 Not repeat an operation.
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Parameter name Unit Default Settings

2 to 254 Repeat an operation for a specified
number of times.

255 Repeat an operation infinitely.

■ Configurator PMX settings

● When selecting ""255: Repeat infinitely"" in the positioning repeat count parameter, program
this to stop the operation using the deceleration stop function.

10.11.2 Settings and Operations of Repeat Operation

● When the positioning table start contact or positioning simultaneous start contact turns on,
the pulse output starts.

● After starting the instruction, the unit executes the pulse output for a specified repeat count
and then stops the operation. For setting to execute the operation infinitely, use this function
in combination with the deceleration stop function.
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■ Operation diagram

■ Operations of each contact
● The BUSY flags (X30-X33), which indicate that the motor is running, will turn on when the

position control starts, and they will turn off when the set repeat operation completes.
● The operation done flags (X34-X37), which indicate the completion of operation, will turn on

when the current operation is completed, and they will be held until the next positioning
control, JOG operation or home return operation starts. Those flags do not turn off in the
middle of the repeat operation.

■ Settings
The parameter for the repeat count is specified in the "positioning parameter setting" menu in
Configurator PMX.

Item Setting example

Common Area
Axis setting Turn on the single axis setting for an appropriate axis.

Positioning repeat
count

3

Axis Setting Area
Pulse output control
code

Set in accordance with system configuration.

Startup Speed 1,000 Hz

Table area

Table No. Table 1 Table 2

Operation pattern P-point control (Pass point
control)

E-point control (End point
control)

Control method Increment mode Increment mode

X-axis (CH0)
movement amount

5,000 pulses 10,000 pulses

Positioning
acceleration time

100 ms 150 ms

Positioning
deceleration time

200 ms 250 ms

Positioning target
speed

20,000 Hz 10,000 Hz

Dwell time - 50 ms
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■ Configurator PMX settings

■ Allocation of I/O signals

Signal name Application

I/O number

Axis 1 Axis 2 Axis 3 Axis 4

CH0 CH1 CH2 CH3

BUSY Control flag X30 X31 X32 X33

POS Positioning table start Y30 Y31 Y32 Y33

MPOS Positioning
simultaneous start

Y34

■ Sample program
The execution condition is differential execution.

10.11.3 Stop Operation During Repeat Operation

● When setting the repeat function, the operation at the time of deceleration stop varies as
follows.
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■ Operation at the time of deceleration stop (Repeating E-point control)
When the unit detects a deceleration stop, the unit will come to a stop after repeating
positioning control N+2 times. However, the unit will stop the control when reaching the set
repeat count.

■ Operation at the time of deceleration stop (Repeating P-point control, C-point
control)

When the unit detects a deceleration stop, it stops the operation after repeating the positioning
control N+1 times. However, the unit will stop the control when reaching the set repeat count.

● When a system stop is executed, the unit will stop the pulse output immediately without
repetitive operations.

● When an emergency stop is executed, the unit will stop the pulse output after a specified
emergency stop setting time without repetitive operations.
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10.12 Linear Interpolation Control

10.12.1 Overview

The interpolation control is available under the following conditions.

■ Combinations of interpolation control

Interpolation axis 1 Interpolation axis 2

X-axis Y-axis X-axis Y-axis

CH0 CH1 CH2 CH3

■ Conditions of interpolation control

Item
Condition under which interpolation control is executable

Executable Not executable

Operation pattern
E-point control
P-point control + E-point control
C-point control + E-point control

JOG operation

Home Return(Note 1)

J-point control

Control method Increment mode, Absolute mode -
 

(Note 1) In the home return operation, home return start contacts turn on for each channel corresponding to X
and Y axes. The trajectory is not linear interpolation.

 

■ Setting method of speed

Item Composite speed Long axis speed

Operation

Setting method Specify the speed combining the speed
of X and Y axes.

Specify the speed for the axis whose
movement amount is large.

 

(Note 1) When specifying the same value, the major axis speed is faster than the composite speed.
 

10.12.2 Setting and Operation of Linear Interpolation

The example below is a case of E-point control with the unit installed in slot 1. The X axis is set
to the 1st axis and the Y axis is set to the 2nd axis. The movement amount setting is the
increment method, and the unit is set to pulse.
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Y axis

X axis

10000 pulses

5000 pulses

■ Operation diagram

100 100

f [pps]

10000

t [ms]

Composite speed

Operation done flag of axis 1

Operation done flag of axis 2

BUSY flag of axis 1

BUSY flag of axis 2

Start Condition

■ Operations of each contact
● The BUSY flags (X30, X31), which indicates that the motor is running, will turn on when the

positioning control starts, and it will turn off when the operation completes.
● The operation done flags of axes 1 and 2 (X34, X35), which indicates the completion of

operation, will turn on when the current operation is completed, and it will be held until the
next positioning control, JOG operation or home return operation starts.

■ Settings

Item Setting example

Common Area
Axis setting Turn on the single axis setting for an appropriate axis.

Positioning repeat
count

0

Axis Setting Area
Pulse output control
code

Set in accordance with system configuration.

Startup Speed 1,000 Hz

Table area Operation pattern E: End point
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Item Setting example

Interpolation operation 0: Linear (Composite speed)

Control method I: Increment

X-axis movement
amount

10000 pulses

Y-axis movement
amount

5000 pulses

Acceleration/
deceleration type

L: Linear

Acceleration time (ms) 100 ms

Deceleration time (ms) 100 ms

Interpolation speed 10000 pps

Dwell time 0 ms

■ Allocation of I/O signals

Signal name Application

I/O number

Axis 1 Axis 2 Axis 3 Axis 4

CH0 CH1 CH2 CH3

BUSY Control flag X30 X31 X32 X33

POS Positioning table start Y30 Y31 Y32 Y33

■ Sample program
The execution condition is differential execution.

■ Cautions on Programming
● Specify a smaller channel number in the same group for starting the interpolation control.
● If any value such as a movement amount, acceleration time, deceleration time or target

speed is out of the specified range, a positioning error will occur when the position control
starts.

● The startup contact and flag numbers vary depending on channel numbers (axis numbers).
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10.13 Operational Difference Between Speed Parameters

10.13.1 Startup speed

● The startup speed is the parameter for setting the initial speed when starting each operation
and the speed when finishing each operation.

● The startup speed is common to each control of the JOG operation, home return, E-point
control, P-point control, C-point control and J-point control operations. It is set for each
channel number (axis number).

■ Setting method of startup speed
It is set in the “Parameter settings” dialog box of Configurator PMX.

■ Precautions when setting the startup speed
● The home return creep speed setting is not influenced by the startup speed in the home

return operation.
● The target speed of each operation is not influenced by the startup speed. Each operation is

performed at each specified target speed regardless of the setting of startup speed.

10.13.2 Operation Patterns and Start Speed Settings

Operation
pattern

Startup speed setting

JOG
operation

(1) Startup speed

(2) Target speed
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Operation
pattern

Startup speed setting

Home
return

(1) Startup speed

(2) Target speed

(3) Creep speed

E-point
control

(1) Startup speed

(2) Target speed

P-point
control

(1) Startup speed

(2) P-point target speed

(3) E-point target speed

C-point
control

(1) Startup speed

(2) C-point target speed

(3) E-point target speed

J-point
control

(1) Startup speed

(2) J-point target speed

(3) J-point change speed

(4) E-point target speed
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10.14 Other Characteristics

10.14.1 Memory Backup

● Data in unit memories are cleared when the power is turned off.
● When the power is turned on again, data is preset in the parameters saved in the non-

volatile memory within FP7 CPU Unit.
● The contents of unit memories will be held when changing the RUN mode to PROG. mode.

10.14.2 Activation of Each Operation

● When any of the JOG operation, home return and position control is activated, it does not
transit to other operation even if an instruction to activate the other instruction turns on.
Create a program to confirm the busy signals (X30 to X33) allocated to each axis and to start
instructions.

● Stop operations (system stop, emergency stop, limit stop, deceleration stop) have priority
even during other operations. Each operation is executed by turning on the stop signal
allocated to each axis.

10.14.3 Operation When CPU Mode Changes From RUN To PROG.

● When the mode of CPU Unit changes from RUN to PROG. after starting the JOG operation,
home return or position control (E-point control, P-piont cotnrol, C-point control, J-point
control), each operation stops.

● As well as the execution of the system stop, the unit stops the pulse output immediately.

10.14 Other Characteristics
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11.1 Creating of Ladder Programs Using Templates

11.1.1 Overview of Template Input Function

In FPWIN GR7, it is possible to select unit memory numbers using templates and easily create
ladder programs.

■ Appearance of Template input screen

1 Select Unit Select an arbitrary unit from connected units.

2 Select Function Select items in accordance with used functions. Items vary according to a selected
unit.

3 Select Unit Memory Select applications and unit memory numbers you want to insert a program. ""R"" is
used only for reading programs. ""RW"" is used for both reading and writing
programs.

4 Description Displays the detailed descriptions of each unit memory.

5 Operation button Operand: Click for changing specified values of operands.

Read: Click for creating a program to read a selected unit memory.
An access unit is also automatically creaetd according to a selected
unit memory.

Write: Click for creating a program to write data to a selected unit memory.
An access unit is also automatically creaetd according to a selected
unit memory.

11.1 Creating of Ladder Programs Using Templates
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11.1.2 Creating Reading/Writing Program

The following procedure describes the process when the multi I/O unit has been already
allocated in the I/O map.

1. In the menu bar, select Edit>Template input
The "template input" screen will open.

2. Move the cursor to a desired insertion position and select a desired unit memory.

11.1 Creating of Ladder Programs Using Templates
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3. Click the "[Read]" button.
Once a program is created, specify an arbitrary operand.

11.1 Creating of Ladder Programs Using Templates
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● Using the template input for changing operands
The template input can also be used for changing the operands of created programs or for
inputting commands manually.
Move the cursor to a position you want to change and select the unit memory, and then click
the "[Operand]" button.

The operand is changed.

11.1 Creating of Ladder Programs Using Templates
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12.1 Confirming Errors Using Self-diagnostic Function

12.1.1 Checking the LED Display of Unit

FP7 Multi I/O Unit has a self-diagnostic function which identifies errors and stops operation if
necessary. The types of the self-diagnostic function are alarms, errors and warnings. When an
error occurs, check the ERR.LED state and error type, and monitor the unit memory in which
the code is stored.

ERR
LED
state

Item State Operation of CPU
unit

Solution

LED ON
Alarm
(H type
only)

Alarm occurs. Stops the operation. Refer to “"12.2.1 ERR LED Turns
ON on the Unit"“.

LED ON

Error 1

Unit error occurs. Stops the operation.

Monitor UM00064 and check the
error code. For details of error
codes, refer to ""12.2.1 ERR LED
Turns ON on the Unit"".

Error 2
Monitor UM00066 and check the
error code. For details of error
codes, refer to ""12.2.1 ERR LED
Turns ON on the Unit"".

LED
Flashing Warning Warning occurs. Continues the

operation.

Monitor UM00065 and check the
warning code. For details of warning
codes, refer to ""12.2.3 ERR LED is
Flashing on the Unit"".

12.1.2 Operation Mode When an Error Occurs

● When an alarm or error occurs, the unti stops the operation in the usual case. When a
warning occurs, the unit continues the operation. The operation mode of the CPU unit when
a unit error occurs can be changed in ""CPU Configuration"" in the tool software.

● When a warning occurs, the unit continues the operation.

■ Operation of CPU Unit when an alarm occurs (H type only)
● If an alarm occurs in the unit, it will give the information to the CPU as ""Unit alarm"".

12.1 Confirming Errors Using Self-diagnostic Function
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● If a ""Unit alarm"" occurs, the default setting is for the CPU to stop operation.
● ""Error code (80): Unit alarm occurrence"" is displayed as a self-diagnostic error in the status

display of the tool software.

■ Operation of the CPU unit when an error occurs (Common)
● If an error occurs in the unit, it will give the information to the CPU as ""Unit error"".
● If a ""Unit error"" occurs, the default setting is for the CPU to stop operation.
● ""Error code (81): Unit error"" is displayed as a self-diagnostic error in the status display of

the tool software.

■ CPU configuration screen of FPWIN GR7

12.1 Confirming Errors Using Self-diagnostic Function
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12.2 Troubleshooting

12.2.1 ERR LED Turns ON on the Unit

■ Situation
An alarm or error occurred.

■ Solution
Check the condition according to the following procedure.

1. Select Online>Device Monitor in FPWIN GR7.

2. Monitor the unit memory (UM00064 or UM00066) in which an error code is stored, and
check the alarm/error code.

3. For code 44, monitor the unit memory (UM00207) in which a positioning error code is
stored and check the detailed information. For detailed information on positioning errors,
refer to the list of positioning error codes on page "P.12-5".

4. Check the appropriate way to handle for each error code, switch the mode to PROG. mode
and review the settings or program. (When code 20 or 26 occurs, the unit must be
rebooted.)

5. Execute the UCLR command to clear the error. In the case of alarm (code: U20) or error
(code: 26), turn on the power supply again.

6. Switch the mode to RUN mode. Once the ERR.LED turns off, the error state will be cleared.
If the LED does not turn off, repeat the above operation.

■ Alarm code

Code Name Situation Code storage
destination

Solution

U20
Unit alarm
(H type only)

There is a possibility
that an error
occurred in the main
unit.

UM00064 Reboot the unit. If the alarm still occurs,
consult your Panasonic representative.

■ Error code

Code Name Situation Code storage
destination

Solution

U1 Double word
access error

The access by one
word (read, write)
was executed to an
area to which only
the access by two
words is allowed.

UM00064

Check the unit memory (UM00063) to
confirm the address where the error
occurred.(Note 1)

Correct the operation unit of the
instruction in the user program, so that it
accesses the address where the error
occurred using a two-word unit.

U26 System error
There is a possibility
that an error
occurred in the main
unit.

UM00066
Reboot the unit. If the alarm still occurs,
consult your Panasonic representative.

12.2 Troubleshooting
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Code Name Situation Code storage
destination

Solution

U44 Positioning
Error

The setting error for
positioning occurs. UM00066 Refer to "12.2.2 What to Do When

Positioning Error Occurs".

U45 Unit processing
error

A table number is
out of the range at
the time of
positioning table
start/positioning
simultaneous start.
(The table number is
larger than 20.)

UM00066 Check and correct the program.

 

(Note 1) On the unit Ver.1.1 or later, the address where the double word access error occurs can be confirmed
in UM00063. When no error has occurred or when the error is cleared, ""FFFF"" is stored.

 

● For details of the access units of unit memories, refer to ""13.3.1 Role of Unit Memories"" and
""13.3.2 List of Unit Memories (AFP7MXY32DWD/ AFP7MXY32DWDH)"".

● For details of the solution when the positioning error (warning code 44) occurs, refer to
""12.2.2 What to Do When Positioning Error Occurs"".

■ Clearing errors using user programs

● Errors can be cleared by user programs.
● Executing the dedicated instruction UCLR (error) clears errors occurred in the multi I/O unit.

Example) Program to clear errors in the multi I/O unit installed in the slot No.1

12.2.2 What to Do When Positioning Error Occurs

■ Checking the description of positioning errors
The following are detailed error codes among self-diagnostic errors when the error code 44
(positioning error) occurs. Monitor the unit memory (UM00207) where the code is stored, and
confirm the solution appropriate to the code.

■ Positioning error code

Error
code

Error name Content Operation when an error
occurs and solution

H10 Limit + signal detection The input on the plus side of the limit
turned ON.(Note 1)

The operation stops in the limit
stop time specified in the axis
setting area.
After the stop, execute the
home return or JOG operation
in the reverse direction.

H11 Limit - signal detection The input on the minus side of the limit
turned ON.(Note 1)

12.2 Troubleshooting

WUME-FP7MXY-06 12-5



Error
code

Error name Content Operation when an error
occurs and solution

H12 Correct the setting of the
parameter.

Limit signal error Both inputs on the plus and minus sides of
the limit turned on.

H20 Axis setting error The axis setting is incorrect.

Each control operation does
not start. Correct the setting of
the parameter.

H21 Limit stop deceleration
time error

The set value of the limit stop deceleration
time is out of the range.

H22 Emergency stop
deceleration time error

The set value of the emergency stop
deceleration time is out of the range.

H23 Startup speed error The set value of the startup speed is out
of the range.

H24 Home return setting code
error

The set value of the home return setting
code is out of the range.

H25 Home return target
speed error

The set value of the home return target
speed is out of the range.

H26 Home return acceleration
time error

The set value of the home return
acceleration time is out of the range.

H27 Home return deceleration
time error

The set value of the home return
deceleration time is out of the range.

H28 Home return creep
speed error

The set value of the home return creep
speed is out of the range.

H29 Home return direction
error

The set value of the home return direction
is out of the range.

H30 JOG operation target
speed error

The set value of the JOG operation target
speed is out of the range.

H31 JOG acceleration time
error

The set value of the JOG acceleration
time is out of the range.

H32 JOG deceleration time
error

The set value of the JOG deceleration
time is out of the range.

H41 Table setting error The combination of tables is incorrect.

H42 Operation pattern error The set value of the operation pattern is
incorrect.

H43 Positioning acceleration
time error

The set value of the positioning start time
is out of the range.

H44 Positioning deceleration
time error

The set value of the positioning
deceleration time is out of the range.

H45 Positioning target speed
error

The set value of the positioning target
speed is out of the range.

H46 Positioning movement
amount error

The set value of the positioning movement
amount is out of the range.

H47 Dwell time error The set value of the dwell time is out of
the range.

H48 J point control setting
error

● The setting of the J-point table is made
for channels other than CH0/1.

● The J-point control is set on the
interpolation axis table.

H60 Repeat operation dwell
time setting error

The dwell time of the E table which
performs repetitive operations is 0 ms.

12.2 Troubleshooting
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(Note 1) The error occurs only when the condition of the limit stop is satisfied.
 

■ Error code 41: Occurrence condition of table setting error
● The last table of the positioning setting tables is not the E point. (e.g. The P point, C point

and J point are set continuously.)
● The control method of the J-point control table is absolute.
● The tables whose control method is absolute are set repeatedly.
● The opposite pulse output directions (forward/reverse) are set on the consecutive tables of P

+E points.
● Axes to which the interpolation operation setting is made are selected for the positioning

simultaneous start (MPOS).

12.2.3 ERR LED is Flashing on the Unit

■ Situation
A warning occurred. The setting content is wrong. A warning also occurs in the initial state at
the time of factory shipment as the output setting is not configured.

■ Solution
Check the condition according to the following procedure.

1. Select Online>Device Monitor in FPWIN GR7.

2. Monitor the unit memory (UM00065) and confirm the warning code.

3. Check the appropriate way to handle for each warning code, switch the mode to PROG.
mode and review the settings or program.

4. Switch the mode to RUN mode. Once the ERR.LED turns off, the warning state will be
cleared. If the LED does not turn off, repeat the above operation.

■ Warning code

Code Name Situation Solution

U1 Interrupt
setting error

As the interrupt switch is not set, the
interrupt function is not activated.

Turn on the mode setting switch no. 1 of
the unit to enable the interrupt function.

U2 Output
setting error

Output polarities are mixed.
This error occurs when the sink output,
source output, push-pull output (negative
logic), or push-pull (positive logic) are
mixed.

This is a warning to check if the wiring is
correct.
If you want to clear warnings, set
"Warning annunciation" to ""Not
announce"" using the tool software or
program.

U3 Input voltage
setting error The input voltage is set by two points. Set the input voltage on a program by four

points.

U4 Pulse output
setting error

A value exceeding the operation
guarantee range (over 500,001) is set.

Monitor the unit memory (UM0015E/
UM0015F) in which the pulse output flag
is stored, and review the settings after
confirming the detailed information.

12.2 Troubleshooting
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Code Name Situation Solution

U5
PWM
frequency
setting error

A value exceeding the settable range
(over 100,001) is set. Review the set value.

■ Cancel of warning annunciation setting

To disable warning announcement, set "Warning annunciation" to ""Not announce"" in the
""Multi I/O Unit Setting"" screen of tool software FPWIN GR7. (Available since Ver.1.1.) Or, set
the bit 9 of UM00062 to 1.

● For details of the pulse output/PWM output flag (UM0015E/UM0015F), refer to ""13.4.9 Pulse
Output/PWM Output Monitor Setting Area"".

● For details of the unit memory (UM00062), refer to ""13.4.1 Alarm/Error/Warning"".

12.2 Troubleshooting
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13.1 Specifications

13.1.1 General Specifications

Item Specifications

Operating ambient
temperature

0°C to +55°C

Storage ambient
temperature

-40°C to +70°C

Operating ambient
humidity

10 to 95% RH (at 25°C with no condensing)

Storage ambient
humidity

10 to 95% RH (at 25°C with no condensing)

Breakdown
voltage(Note 1)

Between input terminal and output terminals 500V AC for 1 minute

Between input terminals and CPU power supply terminal/
function earth

500V AC for 1 minute

Between output terminals and CPU power supply terminal/
function earth

500V AC for 1 minute

Insulation
resistance(Note 2)

Between input terminal and output terminals 100 MΩ or more

Between input terminals and CPU power supply terminal/
function earth

100 MΩ or more

Between output terminals and CPU power supply terminal/
function earth

100 MΩ or more

Vibration
resistance

Conforming to JISB3502 and IEC61131-2.
5 to 8.4 Hz, 3.5-mm single amplitude

8.4 to 150 Hz, acceleration of 9.8 m/s2

10 sweeps each in X, Y, and Z directions (1 octave/min)

Shock resistance Conforming to JISB3502 and IEC61131-2.

147 m/s2 or more in X, Y, and Z directions three times each

Noise resistance 1,000 V [P-P] with pulse widths of 50 ns and 1 µs (using noise simulator)

Environment Free from corrosive gases and excessive dust. EU Directive applicable standard

Overvoltage
category

Category II

Pollution degree Pollution level 2

Internal current
consumption

100 mA or less

Weight Approx. 100g
 

(Note 1) Cutoff current: 10 mA (Default)
(Note 2) With 500 V DC megohmmeter
 

13.1 Specifications
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13.1.2 Function Specifications (AFP7MXY32DWD/AFP7MXY32DWDH)

Item Specifications

In
pu

t/O
ut

pu
t

No. of external
inputs/outputs

Input: 16 points, Output: 16 points

No. of occupied
inputs/outputs

AFP7MXY32DWD: 64 points respectively for I/O (4 words)
AFP7MXY32DWDH: 96 points respectively for I/O (6 words)

Input time constant
setting

0/0.5 μs/1 μs/1.5 μs/2 μs/4 μs/8 μs/16 μs/32 μs/64 μs/96 μs/128 μs/256 μs/2 ms/
4 ms/8 ms(Note 1)

Output polarity
setting

No output, Sink output, Source output, Push-pull (negative logic), Push-pull (positive
logic), Differential output(Note 1)

In
te

rru
pt

No. of points Per multi I/O unit: Max. 8 points can be set in one point increments.(Note 2)

Per CPU unit: Max. 64 programs (8 programs x 8 units)

Mode Non-interrupt unit, Interrupt unit (Set with the dip switches on the side of the unit.)

Occurrence
condition

Terminal input, comparison match

C
ou

nt
er

Number of channels Max. 4 channels (Max. 2 channels when using the elapsed value hold function)(Note

2)

Counter type Linear counter, Ring counter

Counting range Signed 32-bit integer (-2,147,483,648 to +2,147,483,647)

Input mode ● Direction distinction input
● Individual input
● Phase input

Max. counting
speed(Note 3)(Note 5)

When input voltage is 5 V: 500 Hz (For phase input: 500 kHz)
When input voltage is 12 V: 500 kHz (For phase input: 350 kHz)
When input voltage is 24 V: 250 kHz (For phase input: 180 kHz)

Min. input pulse
width

0.5 µs

Others Multiplication function (multiplied by 1, 2, or 4)/Elapsed value offset/preset function,
Elapsed value hold function, Counter upper and lower limits setting, Overflow/
underflow detection (only when setting the linear counter)
Input pulse frequency measurement

Comparison output
setting

Max. 8 points(Note 2)

(4-point external input counters and 4-point pulse output counters can be arbitrarily
compared using 1 point.)

Pu
ls

e 
ou

tp
ut

Number of channels Max. 4 channels including PWM output(Note 2)

Output mode Direction distinction, Individual output, Phase output, Comparison match stop

Output frequency 0 to 500 kHz (Settable in 1 Hz units)(Note 4)

Duty Approx. 50% (Fixed)

PW
M

 o
ut

pu
t Number of channels Max. 4 channels including pulse output(Note 2)

Output frequency 0 to 100 kHz (Settable in 1 Hz units)(Note 4)

Duty 0 to 100% (Settable by 0.1%.)
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(Note 1) The input mode, input time constant, and output polarity can be set by the tool software or user
programs. The settable units and ranges may be different.

(Note 2) For details of the usable combinations for each of the functions such as interrupt, counter, comparison
output, pulse output, and PWM output, refer to ""Unit type and available functions"" in
""1.2 Restrictions on Units Combination"".

(Note 3) This shows when the input pulse duty ratio is 50%.
(Note 4) This shows when the push-pull setting is specified and the output current is 0.1 A. It varies according

to the load.
(Note 5) By default, the input time constant is set to 2 µs. Change the setting according to the frequencies

required. (The count upper limit at 2 µs is approx. 100 kHz.)
 

13.1.3 Positioning Function Specifications (AFP7MXY32DWDH)

Item Specifications

C
om

m
on

 s
pe

ci
fic

at
io

ns

Number of axes
controlled

Max. 4 axes

Position setting mode Increment, Absolute

Output interface Transistor open collector output, Push-pull, Line driver(Note 1)

Pulse output method Pulse/Sign, CW/CCW

Max. output frequency 500 kHz

Output pulse duty ratio When using table setting mode: 50% (Fixed)

Control unit Pulse

Po
si

tio
n 

co
nt

ro
l

Position setting range During single axis control: -1,073,741,824 to +1,073,741,823 pulses
During interpolation axis control: -8,388,608 to +8,388,607 pulses

Speed reference range Pulse: 1 to 500,000 Hz

Max. operation speed 500 kHz

Acceleration/
deceleration type

Linear acceleration/deceleration

Acceleration time 1 to 10,000 ms (Settable by 1 ms)

Deceleration time 1 to 10,000 ms (Settable by 1 ms)

No. of positioning tables 20 tables for each axis (Up to 2 tables can be executed consecutively.)

Control method (Single
axis)

PTP control (E-point control, C-point control), CP control (P-point control),
Speed control (J-point control)(Note 2)(Note 3)

Control method
(2-axis linear
interpolation)

E-point, P-point, C-point controls, Composite speed or Long axis speed setting

Dwell time 0 to 32,767 ms (Settable by 1 ms)

JO
G

 o
pe

ra
tio

n Speed reference range Pulse: 1 to 500,000 Hz(Note 3)

Acceleration/
deceleration type

Linear acceleration/deceleration

Acceleration time 0 to 10,000 ms (Settable by 1 ms)

Deceleration time 0 to 10,000 ms (Settable by 1 ms)

13.1 Specifications
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Item Specifications
H

om
e 

R
et

ur
n

Speed reference range Pulse: 1 to 500,000 Hz

Acceleration/
deceleration type

Linear acceleration/deceleration

Acceleration time 1 to 10,000 ms (Settable by 1 ms)

Deceleration time 1 to 10,000 ms (Settable by 1 ms)

Return method DOG methods (3 types), Home position method, Data set method

St
op

 fu
nc

tio
n

Deceleration stop Performs deceleration stop in the deceleration time of a running operation for
each axis.

Emergency stop Stops in a deceleration time specified for the emergency stop for each axis.(Note

4)

Limit stop Stops in a deceleration time specified for the limit input for each axis.(Note 4)

System stop Stops all axes immediately.
 

(Note 1) The number of axes is reduced when setting Line driver.
(Note 2) J-point control is executable only for the two axes of CH0 and CH1.
(Note 3) When performing J-point control or JOG operation, the speed can be changed after startup.
(Note 4) This is a deceleration time from 500 kHz.
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13.2 Allocation of I/O Numbers

13.2.1 Input

■ External terminals

Termin
al
number

I/O no.

Functions

Interrupt
input Counter

Counter
elapsed
value hold

Com-
parison

Pulse
output

PWM
output

Positioning
(H type)

A1 X0 - CH0 IN-A - - - CH0 Z

A2 X1 - CH0 IN-B - - -
CH0 DOG

CH0 JPOS

A3 X2 - CH0 RST - - - CH0 LMT+

A4 X3 - CH0 MASK - - - CH0 LMT-

A5 X4 - CH1 IN-A - - - CH1 Z

A6 X5 - CH1 IN-B - - -
CH1 DOG

CH1 JPOS

A7 X6 - CH1 RST - - - CH1 LMT+

A8 X7 - CH1 MASK - - - CH1 LMT-

B1 X8 INT0 CH2 IN-A CH0 TRG - - - CH2 Z

B2 X9 INT1 CH2 IN-B - - - - CH2 DOG

B3 XA INT2 CH2 RST - - - - CH2 LMT+

B4 XB INT3 CH2 MASK - - - - CH2 LMT-

B5 XC INT4 CH3 IN-A CH1 TRG - - - CH3 Z

B6 XD INT5 CH3 IN-B - - - - CH3 DOG

B7 XE INT6 CH3 RST - - - - CH3 LMT+

B8 XF INT7 CH3 MASK - - - - CH3 LMT-
 

(Note 1) The I/O numbers actually allocated are the numbers based on the starting word number allocated to
the unit.
Example) When the starting word number of the unit is ""10"", the interrupt input corresponding to
INT0 is X108.

(Note 2) Any one of functions allocated to the same I/O number in the table above can be used. Functions to
be allocated are specified in the "Configuration" dialog box of the tool software. The inputs that are not
allocated to any functions can be used as general inputs.

(Note 3) The functions of each signal are as follows.

Signal name Description

INTx This is the interrupt signal of external inputs.

CHx IN-A This is the A phase (or CW/pulse) input signal for the counter.

CHx IN-B This is the B phase (or CW/pulse) input signal for the counter.

CHx RST This is the reset signal for the counter.

13.2 Allocation of I/O Numbers
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Signal name Description

CHx MASK This is the mask signal for the counter. Counting is disabled when this signal is on.

CHx TRG This is the trigger signal that is used when using the elapsed value hold function for
count values. The rising and trailing edges can be switched by the output signal
CHx TRG LOG.

CHx Z This is the home signal for positioning.

CHx DOG This is the near home signal for positioning.

CHx JPOS This is the J-point control positioning start signal for positioning.

CHx LMT ＋ This is the limit + signal for positioning.

CHx LMT－ This is the limit - signal for positioning.
 

■ Internal I/O

Termin
al
number

I/O no.

Functions

Interru
pt input Counter

Counter
elapsed value
hold

Com-
parison

Pulse
output

PWM
output

Positioning
(H type)

- X10 - - - CMP0 - - -

- X11 - - - CMP1 - - -

- X12 - - - CMP2 - - -

- X13 - - - CMP3 - - -

- X14 - - - CMP4 - - -

- X15 - - - CMP5 - - -

- X16 - - - CMP6 - - -

- X17 - - - CMP7 - - -

- X18 - - - - PLS0 A PWM0 -

- X19 - - - - PLS0 B - -

- X1A - - - - PLS1 A PWM1 -

- X1B - - - - PLS1 B - -

- X1C - - - - PLS2 A PWM2 -

- X1D - - - - PLS2 B - -

- X1E - - - - PLS3 A PWM3 -

- X1F - - - - PLS3 B - -

- X20 - CH0
UDF

- - - - -

- X21 - CH1
UDF

- - - - -

- X22 - CH2
UDF

- - - - -

- X23 - CH3
UDF

- - - - -

- X24 - CH0
OVF

- - - - -
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Termin
al
number

I/O no.

Functions

Interru
pt input Counter

Counter
elapsed value
hold

Com-
parison

Pulse
output

PWM
output

Positioning
(H type)

- X25 - CH1
OVF

- - - - -

- X26 - CH2
OVF

- - - - -

- X27 - CH3
OVF

- - - - -

- X28-X2F - - - - - - -

- X30 - - - - - - CH0 BUSY

- X31 - - - - - - CH1 BUSY

- X32 - - - - - - CH2 BUSY

- X33 - - - - - - CH3 BUSY

- X34 - - - - - - CH0 FIN

- X35 - - - - - - CH1 FIN

- X36 - - - - - - CH2 FIN

- X37 - - - - - - CH3 FIN

- X38 - - - - - - CH0 HFIN

- X39 - - - - - - CH1 HFIN

- X3A - - - - - - CH2 HFIN

- X3B - - - - - - CH3 HFIN

- X3C-X3F - - - - - - -

-
X40-X5F
(H type
only)

- - - - - - -

 

(Note 1) The I/O numbers actually allocated are the numbers based on the starting word number allocated to
the unit.
Example) When the starting word number of the unit is "10", the interrupt input corresponding to INT0
is X108.

(Note 2) Any one of functions allocated to the same I/O number in the table above can be used. Functions to
be allocated are specified in the "Configuration" dialog box of the tool software. The inputs that are not
allocated to any functions can be used as general inputs.

(Note 3) The I/O numbers X10 to X27F are contacts for monitoring on user programs.
(Note 4) The functions of each signal are as follows.

Signal name Description

CHx UDF The is the contact for monitoring the underflow flag for the counter.

CMPx This is the contact for monitoring the comparison output. This is switched between
the on and off states by the setting.

PLSx A This is the contact for monitoring the A-phase output of pulse output.

PLSx B This is the contact for monitoring the B-phase output of pulse output.

PWMx This is the contact for monitoring the PWM output.
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Signal name Description

CHx BUSY This is the contact for monitoring the busy flag for positioning.

CHx FIN This is the contact for monitoring the operation done flag for positioning.

CHx HFIN This is the contact for monitoring the home return done flag for positioning.
 

13.2.2 Output

■ External terminals

Termin
al
number

I/O no.

Functions

Interru
pt input Counter

Counter
elapsed
value hold
mode

Com-
parison

Pulse
output

PWM
output

Positionin
g (H type)

A11 Y0 - - - CMP0 - - -

A12 Y1 - - - CMP1 - - -

A13 Y2 - - - CMP2 - - -

A14 Y3 - - - CMP3 - - -

A15 Y4 - - - CMP4 - - CH0 CLR

A16 Y5 - - - CMP5 - - CH1 CLR

A17 Y6 - - - CMP6 - - CH2 CLR

A18 Y7 - - - CMP7 - - CH3 CLR

B11 Y8 - - - - PLS0 A PWM0 PLS0 A

B12 Y9 - - - - PLS0 B - PLS0 B

B13 YA - - - - PLS1 A PWM1 PLS1 A

B14 YB - - - - PLS1 B - PLS1 B

B15 YC - - - - PLS2 A PWM2 PLS2 A

B16 YD - - - - PLS2 B - PLS2 B

B17 YE - - - - PLS3 A PWM3 PLS3 A

B18 YF - - - - PLS3 B - PLS3 B
 

(Note 1) The I/O numbers in the table indicates offset addresses. The I/O numbers actually allocated are based
on the starting word number allocated to the unit.
Example) When the starting word number for the unit is ""10"", the reset input for the counter CH0 is
Y110.

(Note 2) Any one of functions allocated to the same I/O number in the table above can be used. Functions to
be allocated are specified in the "Configuration" dialog box of the tool software. The outputs that are
not allocated to any functions can be used as general outputs.

(Note 3) The comparison contacts CMP0 to CMP7, pulse outputs PLS0 to PLS3, and PWM outputs PWM0 to
PWM3 are signals which are directly output to I/O connectors. They are not related to the I/O numbers
Y0 to YF. The states of these signals can be monitored by the inputs X10 to X1F. (Unlike general
outputs, they are not reflected in the outputs Y0 to YF.)

(Note 4) The functions of each signal are as follows.
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Signal name Description

CMPx This is the comparison match signal.

PLSx A This is the A phase (or CW/pulse) output signal for pulse output

PLSx B This is the B phase (or CCW/direction) output signal for pulse output

PWMx This is the PWM output signal for pulse output.

CHx CLR This is the deviation counter clear signal for positioning.

PLSx A This is the CW (or pulse) output signal for positioning.

PLSx B This is the CCW (or sign) output signal for positioning.
 

■ Internal I/O

Termin
al
number

I/O no.

Functions

Interru
pt input Counter

Counter
elapsed value
hold mode

Com-
parison

Pulse
output

PWM
output

Positioning (H
type)

- Y10 - CH0 SOFT RST - - - -

- Y11 - CH0 MASK - - - -

- Y12 - CH1 RST - - - -

- Y13 - CH1 MASK - - - -

- Y14 - CH2 SOFT
RST

CH0 LATCH
EN

- - - -

- Y15 - CH2 SOFT
MASK

CH0
TRG LOG

- - - -

- Y16 - CH3 SOFT
RST

CH1 LATCH
EN

- - - -

- Y17 - CH3 SOFT
MASK

CH1
TRG LOG

- - - -

- Y18 - - - - PLS0 EN PWM0
EN

-

- Y19 - - - - PLS1 EN PWM1
EN

-

- Y1A - - - - PLS2 EN PWM2
EN

-

- Y1B - - - - PLS3 EN PWM3
EN

-

- Y1C - - - - PLS0 ST PWM0
ST

-

- Y1D - - - - PLS1 ST PWM1
ST

-

- Y1E - - - - PLS2 ST PWM2
ST

-

- Y1F - - - - PLS3 ST PWM3
ST

-

- Y20 - CH0 UDF CLR - - - -
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Termin
al
number

I/O no.

Functions

Interru
pt input Counter

Counter
elapsed value
hold mode

Com-
parison

Pulse
output

PWM
output

Positioning (H
type)

- Y21 - CH1 UDF CLR - - - -

- Y22 - CH2 UDF
CLR

- - - - -

- Y23 - CH3 UDF
CLR

- - - - -

- Y24 - CH0 OVF CLR - - - -

- Y25 - CH1 OVF CLR - - - -

- Y26 - CH2 OVF
CLR

- - - - -

- Y27 - CH3 OVF
CLR

- - - - -

- Y28 - - - - PLS0 DIR - -

- Y29 - - - - PLS1 DIR - -

- Y2A - - - - PLS2 DIR - -

- Y2B - - - - PLS3 DIR - -

- Y2C - - - - PLS0 CNT RST -

- Y2D - - - - PLS1 CNT RST -

- Y2E - - - - PLS2 CNT RST -

- Y2F - - - - PLS3 CNT RST -

- Y30 - - - - - - CH0 POS

- Y31 - - - - - - CH1 POS

- Y32 - - - - - - CH2 POS

- Y33 - - - - - - CH3 POS

- Y34 - - - - - - MPOS

- Y35 - - - - - - -

- Y36 - - - - - - -

- Y37 - - - - - - -

- Y38 - - - - - - CH0 HOME

- Y39 - - - - - - CH1 HOME

- Y3A - - - - - - CH2 HOME

- Y3B - - - - - - CH3 HOME

- Y3C - - - - - - CH0 JOG+

- Y3D - - - - - - CH1 JOG+

- Y3E - - - - - - CH2 JOG+

- Y3F - - - - - - CH3 JOG+

- Y40 - - - - - - CH0 JOG

- Y41 - - - - - - CH1 JOG
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Termin
al
number

I/O no.

Functions

Interru
pt input Counter

Counter
elapsed value
hold mode

Com-
parison

Pulse
output

PWM
output

Positioning (H
type)

- Y42 - - - - - - CH2 JOG

- Y43 - - - - - - CH3 JOG

- Y44 - - - - - - SYS STP

- Y45-
Y47 - - - - - - -

- Y48 - - - - - - CH0 EMG STP

- Y49 - - - - - - CH1 EMG STP

- Y4A - - - - - - CH2 EMG STP

- Y4B - - - - - - CH3 EMG STP

- Y4C - - - - - - CH0 DEC STP

- Y4D - - - - - - CH1 DEC STP

- Y4E - - - - - - CH2 DEC STP

- Y4F - - - - - - CH3 DEC STP

- Y50 - - - - - - CH0 JPOS

- Y51 - - - - - - CH1 JPOS

- Y52 - - - - - - CH0 DOG

- Y53 - - - - - - CH1 DOG

- Y54 - - - - - - CH0 JPOS SP

- Y55 - - - - - - CH1 JPOS SP

- Y56 - - - - - - ECLR

- Y57 - - - - - - -

- Y58-
Y5F - - - - - - -

 

(Note 1) The I/O numbers in the table indicates offset addresses. The I/O numbers actually allocated are based
on the starting word number allocated to the unit.
Example) When the starting word number for the unit is ""10"", the reset input for the counter CH0 is
Y110.

(Note 2) Any one of functions allocated to the same I/O number in the table above can be used. Functions to
be allocated are specified in the "Configuration" dialog box of the tool software. The outputs that are
not allocated to any functions can be used as general outputs.

(Note 3) The I/O numbers Y10 to Y2F are contacts for controlling each function in user programs.
(Note 4) The comparison contacts CMP0 to CMP7, pulse outputs PLS0 to PLS3, and PWM outputs PWM0 to

PWM3 are signals which are directly output to I/O connectors. They are not related to the I/O numbers
Y0 to YF. The states of these signals can be monitored by the inputs X10 to X1F. (Unlike general
outputs, they are not reflected in the outputs Y0 to YF.)

(Note 5) The functions of each signal are as follows.

Signal name Description

CHx SOFT RST This is the reset signal for the counter. The counter is reset to its preset value.
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Signal name Description

CHx SOFT MASK This is the mask signal for the counter. Counting is disabled when this signal is
on.

CHx LATCH EN This is the enable signal for the elpased value hold function.

CHx TRG LOG This switches the trigger input logic when using the elapsed value hold
function.

CHx UDF CLR This is the underflow clear signal for the counter. It clears the underflow flag.

CHx OVF CLR This is the overflow clear signal for the counter. It clears the overflow flag.

PLSx EN This is the enable signal for the pulse output. The pulse output can be
performed when this signal is on.

PLSx ST This is the start signal for the pulse output.. This is also used for changing
frequencies.

PLSx DIR This is the sign signal for the pulse output.

PLSx CNT RST This is the signal for resetting the elapsed value of pulse output counter.

PWMx EN This is the enable signal for the PWM output. The PWM output can be
performed when this signal is on.

PWMx ST This is the start signal for the PWM output. This is also used for changing the
frequency and duty.

CHx POS This is the table start signal for positioning.

MPOS This is the simultaneous start signal for positioning.

CHx HOME This is the home return start signal for positioning.

CHx JOG ＋ This is the JOG operation (forward) start signal for positioning.

CHx JOG－ This is the JOG operation (reverse) start signal for positioning.

SYS STP This is the system stop signal for positioning.

CHx EMG STP This is the emergency stop signal for positioning.

CHx DEC STP This is the deceleration stop signal for positioning.

CHx J POS This is the J-point control positioning start signal for positioning.

CHx DOG This is the near home signal for positioning.

CHx J POS SP This is the J-point control speed change signal for positioning.

ECLR This is the error clear request signal for positioning.
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13.3 List of Unit Memories

13.3.1 Role of Unit Memories

Unit memories are arithmetic memories to access the monitor area and configuration
information area of the unit.

■ Accessing unit memories
The symbols described in the unit memory list below indicate the following content.

Unit It indicates the unit in the case of the access (read, write) using user programs.
1W: 1 word, 2W: 2 words

R It indicates the area that can be read using user programs.

W It indicates the area that can be written using user programs.

■ Reading from unit memories (UM)
The areas which are shown as enabled in the ""R"" column in the following table can be read
with user programs using transfer instructions or arithmetic instructions. The operand of an
instruction is specified by the combination of the slot number where the slot is installed and a
unit memory number (UM).

Example) Program to read the elapsed value area (UM00110) of the counter CH0 of
the multi I/O unit installed in the slot number 1 (S1) to an arbitrary data register
(DT100)

■ Writing to unit memories (UM)
● When the mode changes from PROG. to RUN, the configuration information set by the tool

software will be stored.
● The areas which are shown as enabled in the ""W"" column in the following table can be read

with user programs using transfer instructions or arithmetic instructions. The operand of an
instruction is specified by the combination of the slot number where the slot is installed and a
unit memory number (UM).

● Be sure not to execute writing in the reserved areas for the system.

Example) Program to change the elapsed value area (UM00110) of the counter CH0
for external input to 100000

13.3 List of Unit Memories
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● Be sure not to execute reading or writing in the reserved areas for the system.
● An error will occur if the access by one word (read, write) is executed to an area to which

only the access by two words is allowed.

● Programs for reading and writing values from unit memories can be easily created by using the
""Template Function"" of FPWIN GR7.Refer to "11.1 Creating of Ladder Programs Using
Templates".

13.3.2 List of Unit Memories (AFP7MXY32DWD/ AFP7MXY32DWDH)

A: Available, -: Not available

Item Unit memory number
(Hex.) Content Access

unit R W

- UM 00000-UM 00061 (Reserved for system) - - -

Alarm/Error/
Warning

UM 00062 Error alarm setting 1 W A A

UM 00063 Double word access error occurrence
address 1 W A -

UM 00064 Unit error code 1 1 W A -

UM 00065 Unit warning code 1 W A -

UM 00066 Unit error code 2 1 W A -

- UM 00067-UM 0006F (Reserved for system) ― - -

Input/Output UM 00070-UM 00071 Input time constant voltage setting (High
resolution) 1 W A A

- UM 00072 (Reserved for system) - - -

- UM 00073-UM 000FF (Reserved for system) - - -

Input/Output

UM 00100-UM 00101 Input voltage / Input time constant voltage
setting 1 W A A

UM 00102-UM 00103 (Reserved for system) - - -

UM 00104 Output polarity setting 1 W A A

UM 00105 Output contact terminal interrupt setting 1 W A A

UM 00106-UM 00107 (Reserved for system) - - -

Interrupt
UM 00108-UM 00109 Interrupt setting 1 W A A

UM 0010A-UM 0010B (Reserved for system) - - -

High-speed
counter

UM 0010C-UM 0010D Counter mode setting 1 W A A

UM 0010E-UM 0010F (Reserved for system) - - -

UM 00110-UM 00111 Counter elapsed value CH0 2 W A A

UM 00112-UM 00113 Counter elapsed value CH1 2 W A A

UM 00114-UM 00115
Counter elapsed value CH2

2 W A A
Counter hold value(Note 1) CH0
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Item Unit memory number
(Hex.) Content Access

unit R W

UM 00116-UM 00117
Counter elapsed value CH3

2 W A A
Counter hold value(Note 1) CH1

UM 00118-UM 00119

Counter preset value

CH0 2 W A A

UM 0011A-UM 0011B CH1 2 W A A

UM 0011C-UM 0011D CH2 2 W A A

UM 0011E-UM 0011F CH3 2 W A A

UM 00120-UM 00121

Counter lower limit value

CH0 2 W A A

UM 00122-UM 00123 CH1 2 W A A

UM 00124-UM 00125 CH2 2 W A A

UM 00126-UM 00127 CH3 2 W A A

UM 00128-UM 00129

Counter upper limit value

CH0 2 W A A

UM 0012A-UM 0012B CH1 2 W A A

UM 0012C-UM 0012D CH2 2 W A A

UM 0012E-UM 0012F CH3 2 W A A

UM 00130-UM 00131

Counter input frequency
measurement value

CH0 2 W A A

UM 00132-UM 00133 CH1 2 W A A

UM 00134-UM 00135 CH2 2 W A A

UM 00136-UM 00137 CH3 2 W A A

UM 00138-UM 0013F (Reserved for system) - - -

Comparison

UM 00140 Corresponding counter setting (CMP0-CMP3) 1 W A A

UM 00141 Corresponding counter setting (CMP4-CMP7) 1 W A A

UM 00142 Comparison function validation setting
(CMP0-CMP3) 1 W A A

UM 00143 Comparison function validation setting
(CMP4-CMP7) 1 W A A

UM 00144-UM 00145

Comparison output setting value

CMP0 2 W A A

UM 00146-UM 00147 CMP1 2 W A A

UM 00148-UM 00149 CMP2 2 W A A

UM 0014A-UM 0014B CMP3 2 W A A

UM 0014C-UM 0014D CMP4 2 W A A

UM 0014E-UM 0014F CMP5 2 W A A

UM 00150-UM 00151 CMP6 2 W A A

UM 00152-UM 00153 CMP7 2 W A A

UM 00154-UM 0015B (Reserved for system) - - -

Pulse output
PWM output

UM 0015C PLS/PWM function setting 1 W A A

UM 0015D PLS/PWM counter function setting 1 W A A

UM 0015E PLS/PWM flag (CH0/CH1) 1 W A -
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Item Unit memory number
(Hex.) Content Access

unit R W

UM 0015F PLS/PWM flag (CH2/CH3) 1 W A -

UM 00160-UM 00161

PLS/PWM frequency

CH0 2 W A A

UM 00162-UM 00163 CH1 2 W A A

UM 00164-UM 00165 CH2 2 W A A

UM 00166-UM 00167 CH3 2 W A A

UM 00168-UM 00169

PWM duty

CH0 2 W A A

UM 0016A-UM 0016B CH1 2 W A A

UM 0016C-UM 0016D CH2 2 W A A

UM 0016E-UM 0016F CH3 2 W A A

UM 00170-UM 00171

PLS/PWM counter elapsed value

CH0 2 W A A

UM 00172-UM 00173 CH1 2 W A A

UM 00174-UM 00175 CH2 2 W A A

UM 00176-UM 00177 CH3 2 W A A

UM 00178-UM 00179

PLS/PWM counter lower limit value

CH0 2 W A A

UM 0017A-UM 0017B CH1 2 W A A

UM 0017C-UM 0017D CH2 2 W A A

UM 0017E-UM 0017F CH3 2 W A A

UM 00180-UM 00181

PLS/PWM counter upper limit value

CH0 2 W A A

UM 00182-UM 00183 CH1 2 W A A

UM 00184-UM 00185 CH2 2 W A A

UM 00186-UM 00187 CH3 2 W A A

UM 00188-UM 0019F (Reserved for system) - - -
 

(Note 1) In counter elapsed value hold mode
 

13.3.3 List of Unit Memories (AFP7MXY32DWDH)

The following is the list of unit memories for the positioning function.
A: Available, -: Not available

Unit memory number
(Hex.) Content Access

unit R W

UM 00200 Axis setting 1 W A A

UM 00201

Positioning repeat count

CH0 1 W A A

UM 00202 CH1 1 W A A

UM 00203 CH2 1 W A A

UM 00204 CH3 1 W A A

UM 00205-UM 00206 (Reserved for system) - - -
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Unit memory number
(Hex.) Content Access

unit R W

UM 00207 Positioning error code 1 W A -

UM 00208 (Reserved for system) - - -

UM 00209

Starting table number

CH0 1 W A A

UM 0020A CH1 1 W A A

UM 0020B CH2 1 W A A

UM 0020C CH3 1 W A A

UM 0020D-UM 0020F (Reserved for system) - - -

UM 00210

Simultaneous starting table number

CH0 1 W A A

UM 00211 CH1 1 W A A

UM 00212 CH2 1 W A A

UM 00213 CH3 1 W A A

UM 00214-UM 0021D (Reserved for system) - - -

UM 0021E Active or execution done table

CH0

1 W A -

UM 0021F Repeat count current value 1 W A -

UM 00220-UM 00221 Elapsed value (Current value coordinate) 2 W A A

UM 00222-UM 00227 (Reserved for system) - - -

UM 00228 Active or execution done table

CH1

1 W A -

UM 00229 Repeat count current value 1 W A -

UM 0022A-UM 0022B Elapsed value (Current value coordinate) 2 W A A

UM 0022C-UM 00231 (Reserved for system) - - -

UM 00232 Active or execution done table

CH2

1 W A -

UM 00233 Repeat count current value 1 W A -

UM 00234-UM 00235 Elapsed value (Current value coordinate) 2 W A A

UM 00236-UM 0023B (Reserved for system) - - -

UM 0023C Active or execution done table

CH3

1 W A -

UM 0023D Repeat count current value 1 W A -

UM 0023E-UM 0023F Elapsed value (Current value coordinate) 2 W A A

UM 00240-UM 00245 (Reserved for system) - - -

UM 00246-UM 00263 (Reserved for system) - - -

UM 00264 Pulse output control code

CH0

1 W A A

UM 00265-UM 00266 Startup Speed 2 W A A

UM 00267 Home return method 1 W A A

UM 00268 Home return direction 1 W A A

UM 00269 Home return acceleration time 1 W A A

UM 0026A Home return deceleration time 1 W A A

UM 0026B-UM 0026C Home return target speed 2 W A A

UM 0026D-UM 0026E Home return creep speed 2 W A A
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Unit memory number
(Hex.) Content Access

unit R W

UM 0026F Deviation counter clear time 1 W A A

UM 00270-UM 00271 Coordinate origin 2 W A A

UM 00272 JOG acceleration time 1 W A A

UM 00273 JOG deceleration time 1 W A A

UM 00274-UM 00275 JOG operation target speed 2 W A A

UM 00276-UM 00277 J point change target speed 2 W A A

UM 00278 Emergency stop deceleration time 1 W A A

UM 00279 Limit stop deceleration time 1 W A A

UM 0027A-UM 00281 (Reserved for system) - - -

UM 00282 Pulse output control code

CH1

1 W A A

UM 00283-UM 00284 Startup Speed 2 W A A

UM 00285 Home return method 1 W A A

UM 00286 Home return direction 1 W A A

UM 00287 Home return acceleration time 1 W A A

UM 00288 Home return deceleration time 1 W A A

UM 00289-UM 0028A Home return target speed 2 W A A

UM 0028B-UM 0028C Home return creep speed 2 W A A

UM 0028D Deviation counter clear time 1 W A A

UM 0028E-UM 0028F Coordinate origin 2 W A A

UM 00290 JOG acceleration time 1 W A A

UM 00291 JOG deceleration time 1 W A A

UM 00292-UM 00293 JOG operation target speed 2 W A A

UM 00294-UM 00295 J point change target speed 2 W A A

UM 00296 Emergency stop deceleration time 1 W A A

UM 00297 Limit stop deceleration time 1 W A A

UM 00298-UM 0029F (Reserved for system) - - -

UM 002A0 Pulse output control code

CH2

1 W A A

UM 002A1-UM 002A2 Startup Speed 2 W A A

UM 002A3 Home return method 1 W A A

UM 002A4 Home return direction 1 W A A

UM 002A5 Home return acceleration time 1 W A A

UM 002A6 Home return deceleration time 1 W A A

UM 002A7-UM 002A8 Home return target speed 2 W A A

UM 002A9-UM 002AA Home return creep speed 2 W A A

UM 002AB Deviation counter clear time 1 W A A

UM 002AC-UM 002AD Coordinate origin 2 W A A

UM 002AE JOG acceleration time 1 W A A
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Unit memory number
(Hex.) Content Access

unit R W

UM 002AF JOG deceleration time 1 W A A

UM 002B0-UM 002B1 JOG operation target speed 2 W A A

UM 002B2-UM 002B3 J point change target speed 2 W A A

UM 002B4 Emergency stop deceleration time 1 W A A

UM 002B5 Limit stop deceleration time 1 W A A

UM 002B6-UM 002BD (Reserved for system) - - -

UM 002BE Pulse output control code

CH3

1 W A A

UM 002BF-UM 002C0 Startup Speed 2 W A A

UM 002C1 Home return method 1 W A A

UM 002C2 Home return direction 1 W A A

UM 002C3 Home return acceleration time 1 W A A

UM 002C4 Home return deceleration time 1 W A A

UM 002C5-UM 002C6 Home return target speed 2 W A A

UM 002C7-UM 002C8 Home return creep speed 2 W A A

UM 002C9 Deviation counter clear time 1 W A A

UM 002CA-UM 002CB Coordinate origin 2 W A A

UM 002CC JOG acceleration time 1 W A A

UM 002CD JOG deceleration time 1 W A A

UM 002CE-UM 002CF JOG operation target speed 2 W A A

UM 002D0-UM 002D1 J point change target speed 2 W A A

UM 002D2 Emergency stop deceleration time 1 W A A

UM 002D3 Limit stop deceleration time 1 W A A

UM 002D4-UM 002DB (Reserved for system) - - -

UM 002DC-UM 0032B (Reserved for system) - - -

UM 0032C Control code

Table no. 1

CH0

1 W A A

UM 0032D Control pattern 1 W A A

UM 0032E Positioning acceleration time 1 W A A

UM 0032F Positioning deceleration time 1 W A A

UM 00330-UM 00331 Positioning target speed 2 W A A

UM 00332-UM 00333 Positioning movement amount 2 W A A

UM 00334 Dwell time 1 W A A

UM 00335 (Reserved for system) - - -

UM 00336-UM 0033F

The parameters (10 words) which are
the same configuration as thoese for
table no. 1 are allocated.

Table no. 2

Same as Table No.
1.

UM 00340-UM 00349 Table no. 3

UM 0034A-UM 00353 Table no. 4

UM 00354-UM 0035D Table no. 5

UM 0035E-UM 00367 Table no. 6
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Unit memory number
(Hex.) Content Access

unit R W

UM 00368-UM 00371 Table no. 7

UM 00372-UM 0037B Table no. 8

UM 0037C-UM 00385 Table no. 9

UM 00386-UM 0038F Table no. 10

UM 00390-UM 00399 Table no. 11

UM 0039A-UM 003A3 Table no. 12

UM 003A4-UM 003AD Table no. 13

UM 003AE-UM 003B7 Table no. 14

UM 003B8-UM 003C1 Table no. 15

UM 003C2-UM 003CB Table no. 16

UM 003CC-UM 003D5 Table no. 17

UM 003D6-UM 003DF Table no. 18

UM 003E0-UM 003E9 Table no. 19

UM 003EA-UM 003F3 Table no. 20

UM 003F4-UM 00425 (Reserved for system) - - -

UM 00426 Control code

Table no. 1

CH1

1 W A A

UM 00427 Control pattern 1 W A A

UM 00428 Positioning acceleration time 1 W A A

UM 00429 Positioning deceleration time 1 W A A

UM 0042A-UM 0042B Positioning target speed 2 W A A

UM 0042C-UM 0042D Positioning movement amount 2 W A A

UM 0042E Dwell time 1 W A A

UM 0042F (Reserved for system) - - -

UM 00430-UM 00439

The parameters (10 words) which are
the same configuration as thoese for
table no. 1 are allocated.

Table no. 2

Same as Table No.
1.

UM 0043A-UM 00443 Table no. 3

UM 00444-UM 0044D Table no. 4

UM 0044E-UM 00457 Table no. 5

UM 00458-UM 00461 Table no. 6

UM 00462-UM 0046B Table no. 7

UM 0046C-UM 00475 Table no. 8

UM 00476-UM 0047F Table no. 9

UM 00480-UM 00489 Table no. 10

UM 0048A-UM 00493 Table no. 11

UM 00494-UM 0049D Table no. 12

UM 0049E-UM 004A7 Table no. 13

UM 004AB-UM 004B1 Table no. 14

UM 004B2-UM 004BB Table no. 15
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Unit memory number
(Hex.) Content Access

unit R W

UM 004BC-UM 004C5 Table no. 16

UM 004C6-UM 004CF Table no. 17

UM 004D0-UM 004D9 Table no. 18

UM 004DA-UM 004E3 Table no. 19

UM 004E4-UM 004ED Table no. 20

UM 004EE-UM 0051F (Reserved for system) - - -

UM 00520 Control code

Table no. 1

CH2

1 W A A

UM 00521 Control pattern 1 W A A

UM 00522 Positioning acceleration time 1 W A A

UM 00523 Positioning deceleration time 1 W A A

UM 00524-UM 00525 Positioning target speed 2 W A A

UM 00526-UM 00527 Positioning movement amount 2 W A A

UM 00528 Dwell time 1 W A A

UM 00529 (Reserved for system) - - -

UM 0052A-UM 00533

The parameters (10 words) which are
the same configuration as thoese for
table no. 1 are allocated.

Table no. 2

Same as Table No.
1.

UM 00534-UM 0053D Table no. 3

UM 0053E-UM 00547 Table no. 4

UM 00548-UM 00551 Table no. 5

UM 00552-UM 0055B Table no. 6

UM 0055C-UM 00565 Table no. 7

UM 00566-UM 0056F Table no. 8

UM 00570-UM 00579 Table no. 9

UM 0057A-UM 00583 Table no. 10

UM 00584-UM 0058D Table no. 11

UM 0058E-UM 00597 Table no. 12

UM 00598-UM 005A1 Table no. 13

UM 005A2-UM 005AB Table no. 14

UM 005AC-UM 005B5 Table no. 15

UM 005B6-UM 005BF Table no. 16

UM 005C0-UM 005C9 Table no. 17

UM 005CA-UM 005D3 Table no. 18

UM 005D4-UM 005DD Table no. 19

UM 005DE-UM 005E7 Table no. 20

UM 005E8-UM 00619 (Reserved for system) - - -

UM 0061A Control code

Table no. 1 CH3

1 W A A

UM 0061B Control pattern 1 W A A

UM 0051C Positioning acceleration time 1 W A A
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Unit memory number
(Hex.) Content Access

unit R W

UM 0051D Positioning deceleration time 1 W A A

UM 0051E-UM 0051F Positioning target speed 2 W A A

UM 00520-UM 00521 Positioning movement amount 2 W A A

UM 00522 Dwell time 1 W A A

UM 00523 (Reserved for system) - - -

UM 00624-UM 0062D

The parameters (10 words) which are
the same configuration as thoese for
table no. 1 are allocated.

Table no. 2

Same as Table No.
1.

UM 0062E-UM 00637 Table no. 3

UM 00638-UM 00641 Table no. 4

UM 00642-UM 0064B Table no. 5

UM 0064C-UM 00655 Table no. 6

UM 00656-UM 0065F Table no. 7

UM 00660-UM 00669 Table no. 8

UM 0066A-UM 00673 Table no. 9

UM 00674-UM 0067D Table no. 10

UM 0067E-UM 00687 Table no. 11

UM 00688-UM 00691 Table no. 12

UM 00692-UM 0069B Table no. 13

UM 0069C-UM 006A5 Table no. 14

UM 006A6-UM 006AF Table no. 15

UM 006B0-UM 006B9 Table no. 16

UM 006BA-UM 006C3 Table no. 17

UM 006C4-UM 006CD Table no. 18

UM 006CE-UM 006D7 Table no. 19

UM 006D8-UM 006E1 Table no. 20

UM 006E2-UM 00713 (Reserved for system) - - -

UM 00714-UM 00907 (Reserved for system) - - -
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13.4 Unit Memory Detailed Information

13.4.1 Alarm/Error/Warning

■ Error alarm setting

Unit memory
No. (Hex) Name Setting range and description

UM 00062 Error alarm setting Set whether or not to announce abnormality when a double word
access error or warning occurs.

Setting value (UM 00062）

Bit no. Settings Default Setting range and description R W

b0-b7 (Reserved for system) ― ― ― ―

b8 Double word access
error annunciation 0: Announce

0: Announce
1: Not announced

A A

b9 Warning annunciation 0: Announce
0: Announce
1: Not announced

A A

b10-b15 (Reserved for system) ― ― ― ―
 

(Note 1) This is set in the "Multi I/O Unit Setting" screen of tool software FPWIN GR7 (Available since Ver.1.1),
or using a user program.

 

■ Alarm / Error / Warning codes

Unit memory
No. (Hex) Name Setting range and description R W

UM 00063 Double word access
error occurrence address

Stores the address of a user program that an abnormal
access was made when the double word access error
has occurred.

A ―

UM 00064

Unit alarm code
(H type only)

Stores the alarm code when the following alarm occurs.
U20: Unit alarm

A ―

Unit error code 1
Stores the error codes when the following errors occur.
U1: Double word access error

A ―

UM 00065 Unit warning code

Stores the warning codes when the following warnings
occur.
U1: Interrupt setting error
U2: Output setting error
U3: Input voltage setting error
U4: Pulse output setting error
U5: PWM output setting error

A ―

UM 00066 Unit error code 2

Stores the error codes when the following errors occur.
U26: System error
U44: Positioning Error
U45: Unit processing error

A ―
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13.4.2 Input setting

■ Input setting

Unit
memory No.
(Hex)

Name Default Setting range and description R W

UM00100

Input voltage/
Input time
constant setting
(X0-X7)

H 2222

Set values indicating input voltage and input time
constant. A A

UM00101

Input voltage/
Input time
constant setting
(X8-XF)

H 2222

Allocation of unit memories

UM number UM00101 UM00100

Bit no. b15-b12 b11-b8 b7-b4 b3-b0 b15-b12 b11-b8 b7-b4 b3-b0

I/O no.
Input voltage

XF,XE,XD,XC XB,XA,X9,X8 X7,X6, X5,X4 X3,X2, X1,X0

I/O no.
Input time
constant

XF,XE XD,XC XB,XA X9,X8 X7,X6 X5,X4 X3,X2 X1,X0

Setting value
Initial value
(Hex)

H2 H2 H 2 H 2 H 2 H 2 H 2 H 2

They are set by writing the following values which indicate the input voltage and input time
constant for two inputs to the four bits of each unit memory. When allocating them using the tool
software, it is not necessary to write them.

Setting value Input voltage Input time constant effective pulse width

H0 5V-24V mode 0

H 1 1 µs

H2 (Default) 2 µs

H 3 4 µs

H 4 8 µs

H 5 16 µs

H 6 2 ms

H 7 4 ms

H8 12V-24V mode 0

H9 1 µs

HA 2 µs

HB 4 µs

HC 8 µs
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Setting value Input voltage Input time constant effective pulse width

HD 16 µs

HE 2 ms

HF 4 ms

Precautions when making settings with programs
● Input voltage should be set in increments of four external input terminals (four groups).
● When the voltage settings of the higher two groups and lower two groups of input voltage are

different, the 5V-24V mode takes priority.
● Input time constant should be set in increments of two external input terminals (eight

groups).
● As the input voltage and input time constant are set for external input terminals, the settings

are effective after the allocation of each function corresponding to inputs X0 to XF.

■ Input setting (Input time constant high resolution)

Unit
memory
No. (Hex)

Name Default Setting range and description R W

UM00070
Input time
constant setting
(X0-X7)

H FFFF
Set values indicating input time constant (high
resolution). A A

UM00071
Input time
constant setting
(X8-XF)

H FFFF

Allocation of unit memories

UM number UM00071 UM000070

Bit no. b15-b12 b11-b8 b7-b4 b3-b0 b15-b12 b11-b8 b7-b4 b3-b0

I/O no.
Input time
constant

XF,XE XD,XC XB,XA X9,X8 X7,X6 X5,X4 X3,X2 X1,X0

Setting
value
Initial value
(Hex)

H F HF HF HF HF HF HF HF

The value (Hex) of input time constant (for two inputs) is written to the four bits of the unit
memory. When allocating them using the tool software, it is not necessary to write them.

Setting value Valid/Invalid Input time constant effective pulse width

H0

Valid

0.5 µs

H 1 1.5 µs

H 2 32 µs

H 3 64 µs

H 4 96 µs

H 5 128 µs

H 6 256 µs
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Setting value Valid/Invalid Input time constant effective pulse width

H 7 8 ms

H8-HF Invalid -

Precautions when making settings with programs
● When the setting value is that in the range of H8 to HF, the setting is invalid.
● When the setting value is that in the range of H0 to H7, the input time constant setting is

given priority over UM100-UM101.
● On the unit Ver.1.0x, the above input time constant values (the setting area of unit memories

UM00070 and UM00071) cannot be set with the tool softwrae (FPWIN GR7).
When the input time constants above are set in the tool software for the unit Ver.1.0x, they
are set as 2 µs. These values can be set by writing them into the unit memories using
programs.

13.4.3 Output Setting

■ Output terminal polarity setting

Unit memory
No. (Hex) Name Default Setting range and description R W

UM00104 Output polarity
setting H FFFF

Set the value indicating output polarity. 4
points for 4 output terminals are allocated to 1
digit (4 bits).

A A

Allocation of unit memories

UM number UM00104

Bit no. b15-b12 b11-b8 b7-b4 b3-b0

Terminal number B18-B15 B14-B11 A18-A15 A14-A11

I/O no. YF-YC YB-Y8 Y7-Y4 Y3-Y0

Setting value
Initial value (Hex)

H F H F H F H F

The values (Hex) of terminal number and I/O number (for four outputs) are written to the four
bits of the unit memory. When allocating them using the tool software, it is not necessary to
write them.

Setting value Output logic / Output polarity

H0 Sink output / Negative logic (The low side turns on when the operation result is TRUE (1).)

H 1 Source output / Positive logic (The high side turns on when the operation result is TRUE (1).)

H 2 Push-pull output/negative logic (Low side ON/high side OFF when the operation result is TRUE
(1))

H 3 Push-pull output/positive logic (High side ON/low side OFF when the operation result is TRUE
(1))

H4 to HE Disabled(Note 1)

HF (Default) Not used (Note 2) Output OFF
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(Note 1) Do not use this setting.
(Note 2) The default value when the power is on has been set to ""Not used"".
 

Precautions when making settings with programs
● Output polarity should be set in increments of four external input terminals (four groups).
● Although it is possible to specify different polarities in the same unit, be very careful with the

wirings.
● As the output polarities are set for the external output terminals (A11 to A18, B11 to B18),

each function corresponding to the outputs X0 to XF is also effective for the allocated
terminals.

● If different polarities are mixed in UM00104, a warning occurs to pay attention to the wiring.
(The ERR. LED on this unit flashes.)
To disable warning announcement, set "Warning annunciation" to ""Not announce"" in the
""Multi I/O Unit Setting"" screen of tool software FPWIN GR7. (Available since Ver.1.1.) Or,
set the bit 9 of UM00062 to 1.

● Set to agree the poloarities of outputs to wirings. For details of the output specifications, refer to
""3.1.3 Output Specifications"".

■ Output contact terminal interrupt setting

Unit memory
No. (Hex) Name Default Setting range and description R W

UM00105
Output contact
terminal interrupt
setting

H FFFF Set the I/O numbers allocated to terminal
numbers. A A

Allocation of unit memories

UM number UM00105

Bit no. b15-b12 b11-b8 b7-b4 b3-b0

Terminal number B18-B15 B14-B11 A18-A15 A14-A11

I/O no. YF-YC YB-Y8 Y7-Y4 Y3-Y0

Setting value
Initial value (Hex)

H F H F H F H F

The values (Hex) of terminal number and I/O number (for four outputs) are written to the four
bits of the unit memory.

Setting value Output contact

H0 Y0-Y3

H 1 Y4-Y7

H 2 Y8-YB

H 3 YC-YF

H4 to HE Disabled(Note 1)

HF (Default) Basic arrangement(Note 2)

 

(Note 1) Do not use this setting.
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(Note 2) The default value when the power is on has been set to ""Not used"".
 

13.4.4 Interrupt Setting Area

■ Interrupt setting

Unit
memory
No. (Hex)

Name Default Setting range and description R W

UM00108
Interrupt setting
(INT0-INT3)

H FFFF
Specify conditions to occur the interrupts INT0
to INT7 when using the interrupt function. A A

UM00109
Interrupt setting
(INT4-INT7)

H FFFF

Allocation of unit memories

UM number UM00109 UM00108

Bit no. b15-b12 b11-b8 b7-b4 b3-b0 b15-b12 b11-b8 b7-b4 b3-b0

INT number INT7 INT6 INT5 INT4 INT3 INT2 INT1 INT0

Setting
value
Initial value
(Hex)

H F H F H F H F H F H F H F H F

They are set by writing the following values which indicate the condition for an interrupt to the
four bits of each unit memory. When allocating them using the tool software, it is not necessary
to write them.

Setting value Interrupt
Function

Connect to Interrupt occurrence condition

H0

Used

Comparison Output
Function(Note 1)

(CMP0 to CMP7)

When the set value and comparison value
match (=condition)H 1

H 2 Input terminal
(X8 to XF)

OFF→ON

H 3 ON > OFF(Note 2)

H4 to H7 Disabled(Note 3)

H8

Used
Comparison Output
Function(Note 5)(Note 6)

(CMP0 to CMP7)

Comparison
OFF > ON/ON > OFFH9

HA Comparison output OFF to ON

HB Comparison output ON to OFF

HC to HE Disabled(Note 3)

HF (Default) Not used(Note 4)

 

(Note 1) INT0 to INT7 correspond to CMP0 to CMP7 respectively. When the relation between the comparison
output set value and comparison value agrees with the condition set for the comparison counter
allocation, the interrupt occurs.
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(Note 2) Always execute the interrupt clear instruction after setting, when selecting this setting.
(Note 3) Do not use this setting.
(Note 4) The default value when the power is on has been set to ""Not used"".
(Note 5) INT0 to INT7 correspond to CMP0 to CMP7 respectively. The interrupt occurs at the same timing as

the comparison output function.
(Note 6) This condition cannot be set as an interrupt condition on the unit Ver.1.0x.

Note that the interrupt setting itself is set to "not used" if the above condition is set as the interrupt
condition in FPWIN GR7 (Ver.2.12 or later).

 

● Target channels of the match interrupt when using the comparison output function are specified
in the area of the comparison output function.Refer to "13.4.7 Comparison Output Setting
Area".

● The above INT numbers are different from interrupt program numbers INTPG.

13.4.5 Counter Mode Setting Area

■ Counter mode setting

Unit
memory
No. (Hex)

Name Default Setting range and description R W

UM0010C
Counter mode
setting
(CH0-CH1)

H 0F0F
Specify a counter mode. Each channel is
allocated 8 bits (input mode in 4 bits, function
in 4 bits).

A A

UM 0010D
Counter mode
setting
(CH2-CH3)

H 0F0F

Allocation of unit memories

UM number UM0010D UM0010C

Bit no. b15-b12 b11-b8 b7-b4 b3-b0 b15-b12 b11-b8 b7-b4 b3-b0

Setting
channel CH3 CH2 CH1 CH0

Setting item Input
mode Functions Input

mode Functions Input
mode Functions Input

mode Functions

Setting
value
Initial value
(Hex)

H0 H F H0 H F H0 H F H0 H F

The values (Hex) of setting channel and setting item are written to the four bits of the unit
memory. When allocating them using the tool software, it is not necessary to write them.

13.4 Unit Memory Detailed Information

13-30 WUME-FP7MXY-06



Setting value (Input mode)

Setting value Functions Multiplication function

H0 (Default) Direction distinction(Note 1)
None

H 1 Individual input

H 2

Phase input

1 multiple

H 3 2 multiple

H 4 4 multiple

H5 to HF Not used
 

(Note 1) It shows the default value on the unit side.
 

Setting value (Function)

Setting value Count mode Elapsed value hold mode

H0 Ring
Not used

H 1 Linear

H 2 Ring
Used(Note 3)

H 3 Linear

H4 to HE Disabled(Note 1) Disabled

HF (Default) Not used(Note 2)

 

(Note 1) Do not use this setting.
(Note 2) It shows the default value on the unit side.
(Note 3) The counters CH2/CH3 cannot be used in the elapsed value hold mode.
 

13.4.6 Counter Monitor Setting Area

Unit
memory
No. (Hex)

Name Default Setting range and description R W

UM 00110
UM 00111

Counter elapsed
value (CH0)

K 0

Stores counter elapsed values. They can also
be written using user programs.
Setting range: -2,147,483,648 to
+2,147,483,647
Signed 32-bit integer

A A

UM 00112
UM 00113

Counter elapsed
value (CH1)

UM 00114
UM 00115

Counter elapsed
value (CH2)

UM 00116
UM 00117

Counter elapsed
value (CH3)

UM 00114
UM 00115

Counter elapsed
value
Hold value (CH0) K 0

Stores the elapsed values at the time of the
input of trigger signals when using the counter
elapsed value hold function. They can also be
written using user programs.
Setting range: -2,147,483,648 to
+2,147,483,647

A A
UM 00116
UM 00117

Counter elapsed
value
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Unit
memory
No. (Hex)

Name Default Setting range and description R W

Hold value (CH1) Signed 32-bit integer

UM 00118
UM 00119

Counter preset
value (CH0)

K 0

Input the preset value when the counter is
reset.
Setting range: -2,147,483,648 to
+2,147,483,647
Signed 32-bit integer

A A

UM 0011A
UM 0011B

Counter preset
value (CH1)

UM 0011C
UM 0011D

Counter preset
value (CH2)

UM 0011E
UM 0011F

Counter preset
value (CH3)

UM 00120
UM 00121

Counter lower
limit value (CH0)

K -2147483648

Set the counter lower limit value.
Setting range: -2,147,483,648 to
+2,147,483,647
Signed 32-bit integer

A A

UM 00122
UM 00123

Counter lower
limit value (CH1)

UM 00124
UM 00125

Counter lower
limit value (CH2)

UM 00126
UM 00127

Counter lower
limit value (CH3)

UM 00128
UM 00129

Counter upper
limit value (CH0)

K 2147483647

Set the counter upper limit value.
Setting range: -2,147,483,648 to
+2,147,483,647
Signed 32-bit integer

A A

UM 0012A
UM 0012B

Counter upper
limit value (CH1)

UM 0012C
UM 0012D

Counter upper
limit value (CH2)

UM 0012E
UM 0012F

Counter upper
limit value (CH3)

UM 00130
UM 00131

Counter input
Frequency
measurement
value (CH0)

H0

Stores the measurement values of
frequencies of counter input.
Range: 0 to 500,000
Unsigned 32-bit integer
Unit: Hz

A ―

UM 00132
UM 00133

Counter input
Frequency
measurement
value (CH1)

UM 00134
UM 00135

Counter input
Frequency
measurement
value (CH2)

UM 00136
UM 00137

Counter input
Frequency
measurement
value (CH3)

 

(Note 1) UM00114 and UM00115 can be used for either counter elapsed values (CH2) or counter hold values
(CH0). UM00116 and UM00117 can be used for either counter elapsed values (CH3) or counter hold
values (CH1).

 

13.4 Unit Memory Detailed Information

13-32 WUME-FP7MXY-06



13.4.7 Comparison Output Setting Area

Unit
memory
No. (Hex)

Name Default Setting range and description R W

UM 00140

Comparison
counter
allocation
(CMP0-CMP3)

HFFFF
Specify conditions to turn on the comparison
outputs CMP0 to CMP7 when using the
comparison function. 1 digit and 4 bits are
allocated to 1 comparison contact.

A A

UM 00141

Comparison
counter
allocation
(CMP4-CMP7)

HFFFF

UM 00142

Comparison
output enable
setting
(CMP0-CMP3)

HFFFF
Specify whether or not to enable the
comparison outputs CMP0 to CMP7 when
using the comparison function. 1 digit and 4
bits are allocated to 1 comparison contact.

A A

UM 00143

Comparison
output enable
setting
(CMP4-CMP7)

HFFFF

UM 00144
UM 00145

Comparison
value (CMP0)

K 0

Set when using the comparison function. They
can also be written using user programs.
Setting range: -2,147,483,648 to
+2,147,483,647
Signed 32-bit integer
The setting range of the channel for which the
positioning function is set is different.
For interpolation axis control: -1,073,741,824
to +1,073,741,823
For interpolation axis control: -8,388,608 to
+8,388,607

A A

UM 00146
UM 00147

Comparison
value (CMP1)

UM 00148
UM 00149

Comparison
value (CMP2)

UM 0014A
UM 0014B

Comparison
value (CMP3)

UM 0014C
UM 0014D

Comparison
value (CMP4)

UM 0014E
UM 0014F

Comparison
value (CMP5)

UM 00150
UM 00151

Comparison
value (CMP6)

UM 00152
UM 00153

Comparison
value (CMP7)

Allocation of unit memories （UM00141/UM00140）: Comparison counter allocation

UM number UM00141 UM00140

Bit no. b15-b12 b11-b8 b7-b4 b3-b0 b15-b12 b11-b8 b7-b4 b3-b0

CMP
number

CMP7 CMP6 CMP5 CMP4 CMP3 CMP2 CMP1 CMP0

Setting
value
Initial value
(Hex)

H F H F H F H F H F H F H F H F
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Set by writing the values below to the 4 bits allocated to each comparison output number. When
allocating them using the tool software, it is not necessary to write them.

Setting value (UM00141/UM00140)

Setting value Functions

Comparison output setting Counter channel to be compared

H0

ON when elapsed value is
smaller than setting value

HSC-CH0

External input counter
H 1 HSC-CH1

H 2 HSC-CH2

H 3 HSC-CH3

H 4

ON when elapsed value is
larger than or equal to setting
value

HSC-CH0

External input counter
H 5 HSC-CH1

H 6 HSC-CH2

H 7 HSC-CH3

H8

ON when elapsed value is
smaller than setting value

PLSC-CH0

Pulse output/PWM output
counter

H9 PLSC -CH1

HA PLSC -CH2

HB PLSC -CH3

HC

ON when elapsed value is
larger than or equal to setting
value

PLSC-CH0

Pulse output/PWM output
counter

HD PLSC -CH1

HE PLSC -CH2

HF (Default) PLSC -CH3

Allocation of unit memories （UM00143/UM00142）: Comparison output enable
setting

UM number UM00143 UM00142

Bit no. b15-b12 b11-b8 b7-b4 b3-b0 b15-b12 b11-b8 b7-b4 b3-b0

CMP
number

CMP7 CMP6 CMP5 CMP4 CMP3 CMP2 CMP1 CMP0

Setting
value
Initial value
(Hex)

H F H F H F H F H F H F H F H F

Settings to enable/disable the comparison output and the output destination are set by writing
the values on the next page to the 4 bits allocated to each comparison output number. When
allocating them using the tool software, it is not necessary to write them.

Setting value Functions

Comparison output
setting

Output destination

H0
Enabled

External terminal/Internal I/O(Note 1)

H 1 Internal I/O only(Note 2)(Note 3)

H2 to HE Disabled Disabled
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Setting value Functions

Comparison output
setting

Output destination

HF (Default) Disabled Disabled
 

(Note 1) If it conflicts with the deviation counter clear when setting the positioning function for the positioning
unit (H type), the external terminal cannot be selected as the output destination.

(Note 2) For the unit Ver.1.0x, ""Internal I/O only"" cannot be selected as the output destination. When ""Internal
I/O only"" is selected in the tool software, the comparison output function is set not to be used.

(Note 3) When ""Internal I/O only"" is set as the output destination, the terminal is the general-purpose I/O.
 

13.4.8 Pulse Output / PWM Output Setting Area

Unit
memory
No. (Hex)

Name Default Setting range and description R W

UM 0015C

Pulse/PWM
Function
Settings
(PLS0-PLS3/
PWM0-PWM3)

H FFFF

Specify the data update timing and output
mode of pulse output or PWM output when
using the pulse output function or PWM output
function. 1 digit and 4 bits are allocated to 1
output channel.

A A

UM 0015D

Pulse/PWM
pulse counter
function setting
(PLS0-PLS3/
PWM0-PWM3)

H FFFF Set to use the pulse output counter. 1 digit and
4 bits are allocated to 1 output channel. A A

Allocation of unit memories: Pulse/PWM function setting

UM number UM0015D UM0015C

Bit no. b15-b12 b11-b8 b7-b4 b3-b0 b15-b12 b11-b8 b7-b4 b3-b0

Setting
channel

PLS3 PLS2 PLS1 PLS0 PLS3 PLS2 PLS1 PLS0

PWM3 PWM2 PWM1 PWM0 PWM3 PWM2 PWM1 PWM0

Setting
value
Initial value
(Hex)

H F H F H F H F H F H F H F H F

Set this by writing the following value to the 4 bits allocated to each channel. When allocating
them using the tool software, it is not necessary to write them.

Setting value （UM0015C）

Setting value Functions

Function
s

Data update timing Output mode

H0
PWM

When PWMx start signal rises
-H 1 When PWMx start signal rises or comparison output is

executed
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Setting value Functions

Function
s

Data update timing Output mode

H 2 When PWMx start signal rises or data is updated

H 3

PLS

When PLSx start signal rises
Direction distinction

H 4 Individual

H 5 When PLSx start signal rises or comparison output is
executed

Direction distinction

H 6 Individual

H 7
When PLSx start signal rises or data is updated

Direction distinction

H8 Individual

H9
When PLSx start signal rises

Individual phase

HA Comparison match
stop

HB
When PLSx start signal rises or comparison output is
executed

Individual phase

HC Comparison match
stop

HD
When PLSx start signal rises or data is updated

Individual phase

HE Comparison match
stop

HF (Default) Not used

Setting value （UM0015D）

Setting value
Functions

Usage of pulse output counter

H0 Used

H1 to HE Not used

HF (Default) Not used

13.4.9 Pulse Output/PWM Output Monitor Setting Area

■ Status Flag

Unit
memory
No. (Hex)

Name Default Setting range and description R W

UM 0015E

Pulse/PWM status
flag
(PLS0-PLS1/
PWM0-PWM1)

H 1414
The setting status can be monitored when
using the pulse output function or PWM output
function. 1 byte (8 bits) are allocated to every 1
point on the Pulse output/PWM output counter.

A ―

UM 0015F

Pulse/PWM status
flag
(PLS2-PLS3/
PWM2-PWM3)

H 1414
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Allocation of unit memories: Pulse/PWM status flag

UM number UM0015F UM0015E

Bit no. b15-b8 b7-b0 b15-b8 b7-b0

Setting
channel

PLS3 PLS2 PLS1 PLS0

PWM3 PWM2 PWM1 PWM0

Monitor
value
Initial value
(Hex)

H1 H4 H1 H4 H1 H4 H1 H4

Monitor values （UM0015F / UM0015E）

Bit no.
Settings Value

Functions 1 0

b8 b0 Pulse output start logic(Note 1) ON start OFF start

b9 b1 Duty error 100.1% or more 0.0% to 100.0%

b10 b2 Duty 0% setting flag 0 Other than 0

b11 b3

Frequency setting error flag
During pulse output

500001 Hz or more Less than 100001 Hz

Frequency setting error flag
During PWM output

100001 Hz or more Less than 100001 Hz

b12 b4 Frequency 0Hz setting flag 0 Hz Other than 0 Hz

b13 b5 Flag when setting PWM output Setting Unset

b14 b6 Flag when setting pulse output Setting Unset

b15 b7 Busy flag During output Output Off
 

(Note 1) Since Multi I/O Unit Ver.1.1, it is possible to select "ON start" or "OFF start" for starting the pulse
output with the pulse output function. In the Ver.1.0x unit, only "OFF start" is available. (Cannot
change)

 

■ Monitor Area

Unit
memory
No. (Hex)

Name Default Setting range and description R W

UM 00160
UM 00161

PLS/PWM output
frequency (CH0)

H0

Stores the frequencies of pulse output or
PWM output. They can also be written using
user programs.
(During Pulse output)
Range: 0 to 500,000
Unsigned 32-bit integer
(During PWM output)
Range: 0 to 100,000
Unsigned 32-bit integer

A A

UM 00162
UM 00163

PLS/PWM output
frequency (CH1)

UM 00164
UM 00165

PLS/PWM output
frequency (CH2)

UM 00166
UM 00167

PLS/PWM output
frequency (CH3)

UM 00168
UM 00169

PWM output duty
(CH0) H0

Stores the duty ratios of PWM output. They
can also be written using user programs.
Range: 0 to 1,000 (0.0% to 100.0%)

A A
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Unit
memory
No. (Hex)

Name Default Setting range and description R W

UM 0016A
UM 0016B

Unsigned 32-bit integer

PWM output duty
(CH1)

UM 0016C
UM 0016D

PWM output duty
(CH2)

UM 0016E
UM 0016F

PWM output duty
(CH3)

UM 00170
UM 00171

PLS/PWM output
counter elapsed
value (CH0)

K 0

Stores the counter elapsed values when using
the pulse output/PWM output function. They
can also be written using user programs.
Setting range: -2,147,483,648 to
+2,147,483,647
Signed 32-bit integer
(Note 1)

A A

UM 00172
UM 00173

PLS/PWM output
counter elapsed
value (CH1)

UM 00174
UM 00175

PLS/PWM output
counter elapsed
value (CH2)

UM 00176
UM 00177

PLS/PWM output
counter elapsed
value (CH3)

UM 00178
UM 00179

PLS/PWM output
counter lower
limit value (CH0)

K -2147483648

Set the lower limit value of the counter for
pulse output/PWM output.
Setting range: -2,147,483,648 to
+2,147,483,647
Signed 32-bit integer
(Note 2)

A A

UM 0017A
UM 0017B

PLS/PWM output
counter lower
limit value (CH1)

UM 0017C
UM 0017D

PLS/PWM output
counter lower
limit value (CH2)

UM 0017E
UM 0017F

PLS/PWM output
counter lower
limit value (CH3)

UM 00180
UM 00181

PLS/PWM output
(CH0)

K 2147483647

Set the upper limit value of the counter for
pulse output/PWM output.
Setting range: -2,147,483,648 to
+2,147,483,647
Signed 32-bit integer
(Note 2)

A A

UM 00182
UM 00183

PLS/PWM output
counter upper
limit value (CH1)

UM 00184
UM 00185

PLS/PWM output
counter upper
limit value (CH2)

UM 00186
UM 00187

PLS/PWM output
counter upper
limit value (CH3)

 

(Note 1) The ""PLS/PWM counter elapsed value"" of a channel for which the positioning function is selected
cannot be rewritten.

(Note 2) The ""PLS/PWM counter lower limit value"" and ""PLS/PWM counter upper limit value"" of a channel
for which the positioning function is selected cannot be rewritten. Even if they are set, the settings are
invalid.
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13.5 Unit Memory Detailed Information (H type)

13.5.1 Common Area

A: Available, -: Not available

Unit
memory
No. (Hex)

Name Default Content R W

UM 00200 Axis setting H0

Stores used channels (axes) and usage methods.
Monitor using binary display.

bit no. Settings

0 Not use CH0 (0) / Use (1)

1 Not use CH1 (0) / Use (1)

2 Not use CH2 (0) / Use (1)

3 Not use CH3 (0) / Use (1)

7-4 Disable the setting

8 Use CH0/CH1 as interpolation axis
Not use (0)/Use (1)

9 Use CH2/CH3 as interpolation axis
Not use (0)/Use (1)

15-10 Disable the setting

A A

UM 00201 Positioning repeat
count (CH0) H0 Stores the repeat count in decimal when using the

repeat control in the position control.

Setting
value Operation

0 or 1 Not repeat an operation.

2 to 254 Repeat an operation for a specified
number of times.

255 or
more

Repeat an operation infinitely.

A A

UM 00202 Positioning repeat
count (CH1) H0 A A

UM 00203 Positioning repeat
count (CH2) H0 A A

UM 00204 Positioning repeat
count (CH3) H0 A A

UM 00204
-UM 00206

Reserved for system ― ― ― ―

UM 00207 Error code H0

Stores a generated positioning error code in Hex
format (hexadecimal) when using the pulse output
function (table setting mode).
* The higher 8 bits indicate the channel number and
the lower 8 bits indicate the error code.

A A

UM 00208 Reserved for system ― ― ― ―

UM 00209 Starting table number
(CH0) H0

Specify the table number to be started when a
positioning start signal is input.
Setting value: 1 to 20
When setting 0, the table number is 1.

A A

UM 0020A Starting table number
(CH1) H0 A A

UM 0020B Starting table number
(CH2) H0 A A

13.5 Unit Memory Detailed Information (H type)

WUME-FP7MXY-06 13-39



Unit
memory
No. (Hex)

Name Default Content R W

UM 0020C Starting table number
(CH3) H0 A A

UM 0020D
-UM 0020F

Reserved for system ― ― ― ―

UM 00210 Simultaneous starting
table number (CH0) H0

Specify the table number to be started when a
positioning simultaneous start signal is input.
Setting value: 0
Specified channels do not start simultaneously.
Setting value: 1 to 20
Specified channels start with the set table number.

A A

UM 00211 Simultaneous starting
table number (CH1) H0 A A

UM 00212 Simultaneous starting
table number (CH2) H0 A A

UM 00213 Simultaneous starting
table number (CH3) H0 A A

UM 00214
-UM 002D

Reserved for system ― ― ― ―

13.5.2 Axis Information Area

A: Available, -: Not available

Unit
memory
No. (Hex)

Name Default Content R W

UM 0021E Active or execution
done table (CH0) H0

Stores the monitor values of the positioning table
numbers during the execution or on the completion of
each channel.

A ―

UM 0021F Repeat count
current value (CH0) H0

Stores the repeat count during the operation of each
channel. The execution start time is counted as "1".
When the repeat count exceeds the upper limit, it
returns to "0". When the repeat operation is not
enabled, "0" is stored at the positioning control start
time.
Stored value: 0 to 65535

A ―

UM 00220
-UM 00221

Elapsed value
(Current value
coordinate) (CH0)

K0

Stores the elapsed values (current value cooridnate)
of each channel.
Range: -1,073,741,824 to +1,073,741,823
For the interpolation control, the setting range is as
follows.
-8388608 to +8388607

A A

UM 00222
-UM 00227

Reserved for system ― ― ― ―

UM 00228 Active or execution
done table (CH1) H0 Same as CH0. A ―

UM 00229 Repeat count
current value (CH1) H0 Same as CH0. A ―
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Unit
memory
No. (Hex)

Name Default Content R W

UM 0022A
-UM 0022B

Elapsed value
(Current value
coordinate) (CH1)

K0 Same as CH0. A A

UM 0022C
-UM 00231

Reserved for system ― ― ― ―

UM 00232 Active or execution
done table (CH2) H0 Same as CH0. A ―

UM 00233 Repeat count
current value (CH2) H0 Same as CH0. A ―

UM 00234
-UM 00235

Elapsed value
(Current value
coordinate) (CH2)

K0 Same as CH0. A A

UM 00236
-UM 0023B

Reserved for system ― ― ― ―

UM 0023C Active or execution
done table (CH3) H0 Same as CH0. A ―

UM 0023D Repeat count
current value (CH3) H0 Same as CH0. A ―

UM 0023E
-UM 0023F

Elapsed value
(Current value
coordinate) (CH3)

K0 Same as CH0. A A

UM 00240
-UM 00245

Reserved for system ― ― ― ―

13.5.3 Axis Setting Area

A: Available, -: Not available

Unit
memory
No. (Hex)

Name Default Content R W

UM 00264 Pulse output control
code H0

Stores the settings of pulse output, home position,
near home position, and limit signal of each channel.
Monitor in binary format.

bit no. Item Settings

0 Output method 0: Pulse/Sign
1: CW/CCW

1 Rotation
direction

0: Elapsed value +
Direction is CW.
(Forward OFF/Reverse
ON)
1: Elapsed value +
Direction is CCW.
(Forward ON/Reverse
OFF)

A A
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Unit
memory
No. (Hex)

Name Default Content R W

bit no. Item Settings

2 Home position
logic

0: Normal Open (A
contact)
1: Normal Close (B
contact)

3 Near home
input logic

4 Limit (+) logic

5 Limit (-) logic

6-15 Disable the
setting

UM 00265
-UM 00266

Startup Speed U100
Stores the settings of the startup speed for each
operation of each channel in decimal.
Setting range: 1 to 100,000

A A

UM 00267 Home return method HFF

Stores the settings of home return patterns of each
channel.
H0: DOG method 1
H1: DOG method 2
H2: DOG method 3
H3: Setting error
H4: Setting error
H5: Home position method (Z phase method)
H6: Data set method
HFF: Not use

A A

UM 00268 Home return
direction H0

Stores the settings of home return operation direction
in decimal.
0: Elapsed value decreasing direction (Limit -
direction)
1: Elapsed value increasing direction (Limit +
direction)

A A

UM 00269 Home return
acceleration time U100

Stores the settings of the acceleration time for the
home return of each channel in decimal. It indicates
the time from the startup speed to the home return
target speed.
Setting range: 1 to 10,000 (ms)

A A

UM 0026A Home return
deceleration time U100

Stores the settings of the deceleration time for the
home return of each channel in decimal. It indicates
the time from the home return target speed to the
startup speed.
Setting range: 1 to 10,000 (ms)

A A

UM 0026B
-UM 0026C

Home return target
speed U1000

Stores the settings of the target speed for the home
return of each channel in decimal.
Setting range: 1 to 100,000

A A

UM 0026D
-UM 0026E

Home return creep
speed U100

Stores the settings of the creep speed for the home
return of each channel in decimal.
Setting range: 1 to 100,000

A A

UM 0026F Deviation counter
clear time U1

Stores the settings of the deviation counter clear
signal ON time after the completion of home return of
each channel in decimal.

A A
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Unit
memory
No. (Hex)

Name Default Content R W

ON time setting range: 1 to 100 (ms)
In the case of 0, no deviation counter clear signal is
output.
In the case of 100 or more, the ON time is set to 100
ms.

UM 00270
-UM 00271

Coordinate origin K0

Stores the elapsed values (current value) after the
home return.
Range: -1,073,741,824 to +1,073,741,823
For the interpolation control, the setting range is as
follows.
-8388608 to +8388607

A A

UM 00272 JOG acceleration
time H0

Stores the settings of the acceleration time for the
JOG operation of each channel in decimal. It
indicates the acceleration time from 0 Hz to 100 kHz.
Setting range: 0 to 10,000 (ms)

A A

UM 00273 JOG deceleration
time H0

Stores the settings of the deceleration time for the
JOG operation of each channel in decimal. It
indicates the deceleration time from 100 kHz to 0 Hz.
Setting range: 0 to 10,000 (ms)

A A

UM 00274
-UM 00275

JOG operation
target speed U1000

Stores the settings of the target speed for the JOG
operation of each channel in decimal.
Setting range: 1 to 100,000

A A

UM 00276
-UM 00277

J point change
target speed U1000

Stores the settings of the target speed for changing
the J-point control speed for each channel in decimal.
Setting range: 1 to 100,000

A A

UM 00278 Emergency stop
deceleration time U100

Stores the settings of the deceleration time for the
emergency stop operation of each channel in
decimal. It indicates the deceleration time from 100
kHz to 0 Hz.
Setting range: 0 to 10,000 (ms)

A A

UM 00279 Limit stop
deceleration time U100

Stores the settings of the deceleration time for the
limit stop operation of each channel in decimal. It
indicates the deceleration time from 100 kHz to 0 Hz.
Setting range: 0 to 10,000 (ms)

A A

UM 0027A
-UM 00281

Reserved for system ― ― ― ―

 

(Note 1) The unit memory numbers in the table above are for CH0. For the numbers for CH1 to CH3, refer to
"Correspondence table of unit memory numbers".

(Note 2) The emergency stop deceleration time and limit stop deceleration time indicates the deceleration time
in the section from 100 kHz to 0 Hz. When the speed during the operation is less than 100 kHz, the
actual acceleration/deceleration time is shorter than the set time.

 

■ Correspondence table of unit memory numbers

Name
Unit memory number (Hex.)

CH0 CH1 CH2 CH3

Pulse output control code UM00264 UM00282 UM002A0 UM002BE
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Name
Unit memory number (Hex.)

CH0 CH1 CH2 CH3

Startup Speed
UM00265
-UM00266

UM00283
-UM00284

UM002A1
-UM002A2

UM002BF
-UM002C0

Home return method UM00267 UM00285 UM002A3 UM002C1

Home return direction UM00268 UM00286 UM002A4 UM002C2

Home return acceleration time UM00269 UM00287 UM002A5 UM002C3

Home return deceleration time UM0026A UM00288 UM002A6 UM002C4

Home return target speed
UM0026B
-UM0026C

UM00289
-UM0028A

UM002A7
-UM002A8

UM002C5
-UM002C6

Home return creep speed
UM0026D
-UM0026E

UM0028B
-UM0028C

UM002A9
-UM002AA

UM002C7
-UM002C8

Deviation counter clear time UM0026F UM0028D UM002AB UM002C9

Coordinate origin
UM00270
-UM00271

UM0028E
-UM0028F

UM002AC
-UM002AD

UM002CA
-UM002CB

JOG acceleration time UM00272 UM00290 UM002AE UM002CC

JOG deceleration time UM00273 UM00291 UM002AF UM002CD

JOG operation target speed
UM00274
-UM00275

UM00292
-UM00293

UM002B0
-UM002B1

UM002CE
-UM002CF

J point change target speed
UM00276
-UM00277

UM00294
-UM00295

UM002B2
-UM002B3

UM002D0
-UM002D1

Emergency stop deceleration
time UM00278 UM00296 UM002B4 UM002D2

Limit stop deceleration time UM00279 UM00297 UM002B5 UM002D3

Reserved for system
UM0027A
-UM00281

UM00298
-UM0029F

UM002B6
-UM002BD

UM002D4
-UM002DB

13.5.4 Positioning Table Area

A: Available, -: Not available

Unit
memory
No. (Hex)

Name Default Content R W

UM 0032C Control code H0

Stores the settings of the position specification method for
the positioning operation.

bit no. Item Settings

0 Control method 0: Increment mode
1: Absolute mode

1-15 Disable the
setting

A A

UM0032D Control pattern H0 Stores the settings of single axis and interpolation operation
pattern of positioning operation. In the interpolation A A
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Unit
memory
No. (Hex)

Name Default Content R W

operation, the setting for the axis with the smallest number
in an axis group is effective.

UM0032E
Positioning
acceleration
time

U100

Stores the settings of the acceleration time for the
positioning operation. It indicates the acceleration time from
the startup speed to the target speed. However, in the case
of J-point table, it indicates the acceleration time from 0 Hz
to 100 kHz.
Setting range: 1 to 10,000 ms

A A

UM0032F
Positioning
deceleration
time

U100

Stores the settings of the deceleration time for the
positioning operation. It indicates the deceleration time from
the target speed to the startup speed. However, in the case
of J-point table, it indicates the deceleration time from 100
kHz to 0 Hz.
Setting range: 1 to 10,000 ms

A A

UM00330
-UM00331

Positioning
target speed U1000

Stores the settings of the target speed for the positioning
operation. In the interpolation operation, the setting for the
axis with the smallest number in an axis group is effective.
Setting range: 1 to 100,000

A A

UM00332
-UM00333

Positioning
movement
amount

K0

Stores the settings of the movement amount for the
positioning operation.
Setting range: -1,073,741,824 to +1,073,741,823
For the interpolation control, the setting range is as follows.
-8388608 to +8388607

A A

UM00334 Dwell time H0
Stores the settings of dwell time.
Setting range: 0 to 32,767 ms

A A

UM00335 Reserved for
system ― ― ― ―

 

(Note 1) The unit memory numbers in the table above are for CH0. For the numbers for CH1 to CH3, refer to
""Correspondence table of unit memory numbers"" given below.

 

■ Correspondence table of unit memory numbers

Table
No. Name

Unit memory number (Hex.)

CH0 CH1 CH2 CH3

1

Control code UM0032C UM00426 UM00520 UM0061A

Control pattern UM0032D UM00427 UM00521 UM0061B

Positioning
acceleration time UM0032E UM00428 UM00522 UM0061C

Positioning
deceleration time UM0032F UM00429 UM00523 UM0061D
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Table
No. Name

Unit memory number (Hex.)

CH0 CH1 CH2 CH3

Positioning target
speed

UM00330
-UM00331

UM0042A
-UM0042B

UM00524
-UM00525

UM0061E
-UM0061F

Positioning movement
amount

UM00332
-UM00333

UM0042C
-UM0042D

UM00526
-UM00527

UM00620
-UM00621

Dwell time UM00334 UM0042E UM00528 UM00622

Reserved for system UM00335 UM0042F UM00529 UM00623

2

Control code UM00336 UM00430 UM0052A UM00624

Control pattern UM00337 UM00431 UM0052B UM00625

Positioning
acceleration time UM00338 UM00432 UM0052C UM00626

Positioning
deceleration time UM00339 UM00433 UM0052D UM00627

Positioning target
speed

UM0033A
-UM0033B

UM00434
-UM00435

UM0052E
-UM0052F

UM00628
-UM00629

Positioning movement
amount

UM0033C
-UM0033D

UM00436
-UM00437

UM00530
-UM00531

UM0062A
-UM0062B

Dwell time UM0033E UM00438 UM00532 UM0062C

Reserved for system UM0033F UM00439 UM00533 UM0062D

3

Control code UM00340 UM0043A UM00534 UM0062E

Control pattern UM00341 UM0043B UM00535 UM0062F

Positioning
acceleration time UM00342 UM0043C UM00536 UM00630

Positioning
deceleration time UM00343 UM0043D UM00537 UM00631

Positioning target
speed

UM00344
-UM00345

UM0043E
-UM0043F

UM00538
-UM00539

UM00632
-UM00633

Positioning movement
amount

UM00346
-UM00347

UM00440
-UM00441

UM0053A
-UM0053B

UM00634
-UM00635

Dwell time UM00348 UM00442 UM0053C UM00636

Reserved for system UM00349 UM00443 UM0053D UM00637

4

Control code UM0034A UM00444 UM0053E UM00638

Control pattern UM0034B UM00445 UM0053F UM00639

Positioning
acceleration time UM0034C UM00446 UM00540 UM0063A

Positioning
deceleration time UM0034D UM00447 UM00541 UM0063B

Positioning target
speed

UM0034E
-UM0034F

UM00448
-UM00449

UM00542
-UM00543

UM0063C
-UM0063D

Positioning movement
amount

UM00350
-UM00351

UM0044A
-UM0044B

UM00544
-UM00545

UM0063E
-UM0063F

Dwell time UM00352 UM0044C UM00546 UM00640
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No. Name

Unit memory number (Hex.)

CH0 CH1 CH2 CH3

Reserved for system UM00353 UM0044D UM00547 UM00641

5

Control code UM00354 UM0044E UM00548 UM00642

Control pattern UM00355 UM0044F UM00549 UM00643

Positioning
acceleration time UM00356 UM00450 UM0054A UM00644

Positioning
deceleration time UM00357 UM00451 UM0054B UM00645

Positioning target
speed

UM00358
-UM00359

UM00452
-UM00453

UM0054C
-UM0054D

UM00646
-UM00647

Positioning movement
amount

UM0035A
-UM0035B

UM00454
-UM00455

UM0054E
-UM0054F

UM00648
-UM00649

Dwell time UM0035C UM00456 UM00550 UM0064A

Reserved for system UM0035D UM00457 UM00551 UM0064B

6

Control code UM0035E UM00458 UM00552 UM0064C

Control pattern UM0035F UM00459 UM00553 UM0064D

Positioning
acceleration time UM00360 UM0045A UM00554 UM0064E

Positioning
deceleration time UM00361 UM0045B UM00555 UM0064F

Positioning target
speed

UM00362
-UM00363

UM0045C
-UM0045D

UM00556
-UM00557

UM00650
-UM00651

Positioning movement
amount

UM00364
-UM00365

UM0045E
-UM0045F

UM00558
-UM00559

UM00652
-UM00653

Dwell time UM00366 UM00460 UM0055A UM00654

Reserved for system UM00367 UM00461 UM0055B UM00655

7

Control code UM00368 UM00462 UM0055C UM00656

Control pattern UM00369 UM00463 UM0055D UM00657

Positioning
acceleration time UM0036A UM00464 UM0055E UM00658

Positioning
deceleration time UM0036B UM00465 UM0055F UM00659

Positioning target
speed

UM0036C
-UM0036D

UM00466
-UM00467

UM00560
-UM00561

UM0065A
-UM0065B

Positioning movement
amount

UM0036E
-UM0036F

UM00468
-UM00469

UM00562
-UM00563

UM0065C
-UM0065D

Dwell time UM00370 UM0046A UM00564 UM0065E

Reserved for system UM00371 UM0046B UM00565 UM0065F

8

Control code UM00372 UM0046C UM00566 UM00660

Control pattern UM00373 UM0046D UM00567 UM00661

Positioning
acceleration time UM00374 UM0046E UM00568 UM00662
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No. Name

Unit memory number (Hex.)

CH0 CH1 CH2 CH3

Positioning
deceleration time UM00375 UM0046F UM00569 UM00663

Positioning target
speed

UM00376
-UM00377

UM00470
-UM00471

UM0056A
-UM0056B

UM00664
-UM00665

Positioning movement
amount

UM00378
-UM00379

UM00472
-UM00473

UM0056C
-UM0056D

UM00666
-UM00667

Dwell time UM0037A UM00474 UM0056E UM00668

Reserved for system UM0037B UM00475 UM0056F UM00669

9

Control code UM0037C UM00476 UM00570 UM0066A

Control pattern UM0037D UM00477 UM00571 UM0066B

Positioning
acceleration time UM0037E UM00478 UM00572 UM0066C

Positioning
deceleration time UM0037F UM00479 UM00573 UM0066D

Positioning target
speed

UM00380
-UM00381

UM0047A
-UM0047B

UM00574
-UM00575

UM0066E
-UM0066F

Positioning movement
amount

UM00382
-UM00383

UM0047C
-UM0047D

UM00576
-UM00577

UM00670
-UM00671

Dwell time UM00384 UM0047E UM00578 UM00672

Reserved for system UM00385 UM0047F UM00579 UM00673

10

Control code UM00386 UM00480 UM0057A UM00674

Control pattern UM00387 UM00481 UM0057B UM00675

Positioning
acceleration time UM00388 UM00482 UM0057C UM00676

Positioning
deceleration time UM00389 UM00483 UM0057D UM00677

Positioning target
speed

UM0038A
-UM0038B

UM00484
-UM00485

UM0057E
-UM0057F

UM00678
-UM00679

Positioning movement
amount

UM0038C
-UM0038D

UM00486
-UM00487

UM00580
-UM00581

UM0067A
-UM0067B

Dwell time UM0038E UM00488 UM00582 UM0067C

Reserved for system UM0038F UM00489 UM00583 UM0067D

11

Control code UM00390 UM0048A UM00584 UM0067E

Control pattern UM00391 UM0048B UM00585 UM0067F

Positioning
acceleration time UM00392 UM0048C UM00586 UM00680

Positioning
deceleration time UM00393 UM0048D UM00587 UM00681

Positioning target
speed

UM00394
-UM00395

UM0048E
-UM0048F

UM00588
-UM00589

UM00682
-UM00683
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CH0 CH1 CH2 CH3

Positioning movement
amount

UM00396
-UM00397

UM00490
-UM00491

UM0058A
-UM0058B

UM00684
-UM00685

Dwell time UM00398 UM00492 UM0058C UM00686

Reserved for system UM00399 UM00493 UM0058D UM00687

12

Control code UM0039A UM00494 UM0058E UM00688

Control pattern UM0039B UM00495 UM0058F UM00689

Positioning
acceleration time UM0039C UM00496 UM00590 UM0068A

Positioning
deceleration time UM0039D UM00497 UM00591 UM0068B

Positioning target
speed

UM0039E
-UM0039F

UM00498
-UM00499

UM00592
-UM00593

UM0068C
-UM0068D

Positioning movement
amount

UM003A0
-UM003A1

UM0049A
-UM0049B

UM00594
-UM00595

UM0068E
-UM0068F

Dwell time UM003A2 UM0049C UM00596 UM00690

Reserved for system UM003A3 UM0049D UM00597 UM00691

13

Control code UM003A4 UM0049E UM00598 UM00692

Control pattern UM003A5 UM0049F UM00599 UM00693

Positioning
acceleration time UM003A6 UM004A0 UM0059A UM00694

Positioning
deceleration time UM003A7 UM004A1 UM0059B UM00695

Positioning target
speed

UM003A8
-UM003A9

UM004A2
-UM004A3

UM0059C
-UM0059D

UM00696
-UM00697

Positioning movement
amount

UM003AA
-UM003AB

UM004A4
-UM004A5

UM0059E
-UM0059F

UM00698
-UM00699

Dwell time UM003AC UM004A6 UM005A0 UM0069A

Reserved for system UM003AD UM004A7 UM005A1 UM0069B

14

Control code UM003AE UM004A8 UM005A2 UM0069C

Control pattern UM003AF UM004A9 UM005A3 UM0069D

Positioning
acceleration time UM003B0 UM004AA UM005A4 UM0069E

Positioning
deceleration time UM003B1 UM004AB UM005A5 UM0069F

Positioning target
speed

UM003B2
-UM003B3

UM004AC
-UM004AD

UM005A6
-UM005A7

UM006A0
-UM006A1

Positioning movement
amount

UM003B4
-UM003B5

UM004AE
-UM004AF

UM005A8
-UM005A9

UM006A2
-UM006A3

Dwell time UM003B6 UM004B0 UM005AA UM006A4

Reserved for system UM003B7 UM004B1 UM005AB UM006A5
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CH0 CH1 CH2 CH3

15

Control code UM003B8 UM004B2 UM005AC UM006A6

Control pattern UM003B9 UM004B3 UM005AD UM006A7

Positioning
acceleration time UM003BA UM004B4 UM005AE UM006A8

Positioning
deceleration time UM003BB UM004B5 UM005AF UM006A9

Positioning target
speed

UM003BC
-UM003BD

UM004B6
-UM004B7

UM005B0
-UM005B1

UM006AA
-UM006AB

Positioning movement
amount

UM003BE
-UM003BF

UM004B8
-UM004B9

UM005B2
-UM005B3

UM006AC
-UM006AD

Dwell time UM003C0 UM004BA UM005B4 UM006AE

Reserved for system UM003C1 UM004BB UM005B5 UM006AF

16

Control code UM003C2 UM004BC UM005B6 UM006B0

Control pattern UM003C3 UM004BD UM005B7 UM006B1

Positioning
acceleration time UM003C4 UM004BE UM005B8 UM006B2

Positioning
deceleration time UM003C5 UM004BF UM005B9 UM006B3

Positioning target
speed

UM003C6
-UM003C7

UM004C0
-UM004C1

UM005BA
-UM005BB

UM006B4
-UM006B5

Positioning movement
amount

UM003C8
-UM003C9

UM004C2
-UM004C3

UM005BC
-UM005BD

UM006B6
-UM006B7

Dwell time UM003CA UM004C4 UM005BE UM006B8

Reserved for system UM003CB UM004C5 UM005BF UM006B9

17

Control code UM003CC UM004C6 UM005C0 UM006BA

Control pattern UM003CD UM004C7 UM005C1 UM006BB

Positioning
acceleration time UM003CE UM004C8 UM005C2 UM006BC

Positioning
deceleration time UM003CF UM004C9 UM005C3 UM006BD

Positioning target
speed

UM003D0
-UM003D1

UM004CA
-UM004CB

UM005C4
-UM005C5

UM006BE
-UM006BF

Positioning movement
amount

UM003D2
-UM003D3

UM004CC
-UM004CD

UM005C6
-UM005C7

UM006C0
-UM006C1

Dwell time UM003D4 UM004CE UM005C8 UM006C2

Reserved for system UM003D5 UM004CF UM005C9 UM006C3

18

Control code UM003D6 UM004D0 UM005CA UM006C4

Control pattern UM003D7 UM004D1 UM005CB UM006C5

Positioning
acceleration time UM003D8 UM004D2 UM005CC UM006C6
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CH0 CH1 CH2 CH3

Positioning
deceleration time UM003D9 UM004D3 UM005CD UM006C7

Positioning target
speed

UM003DA
-UM003DB

UM004D4
-UM004D5

UM005CE
-UM005CF

UM006C8
-UM006C9

Positioning movement
amount

UM003DC
-UM003DD

UM004D6
-UM004D7

UM005D0
-UM005D1

UM006CA
-UM006CB

Dwell time UM003DE UM004D8 UM005D2 UM006CC

Reserved for system UM003DF UM004D9 UM005D3 UM006CD

19

Control code UM003E0 UM004DA UM005D4 UM006CE

Control pattern UM003E1 UM004DB UM005D5 UM006CF

Positioning
acceleration time UM003E2 UM004DC UM005D6 UM006D0

Positioning
deceleration time UM003E3 UM004DD UM005D7 UM006D1

Positioning target
speed

UM003E4
-UM003E5

UM004DE
-UM004DF

UM005D8
-UM005D9

UM006D2
-UM006D3

Positioning movement
amount

UM003E6
-UM003E7

UM004E0
-UM004E1

UM005DA
-UM005DB

UM006D4
-UM006D5

Dwell time UM003E8 UM004E2 UM005DC UM006D6

Reserved for system UM003E9 UM004E3 UM005DD UM006D7

20

Control code UM003EA UM004E4 UM005DE UM006D8

Control pattern UM003EB UM004E5 UM005DF UM006D9

Positioning
acceleration time UM003EC UM004E6 UM005E0 UM006DA

Positioning
deceleration time UM003ED UM004E7 UM005E1 UM006DB

Positioning target
speed

UM003EE
-UM003EF

UM004E8
-UM004E9

UM005E2
-UM005E3

UM006DC
-UM006DD

Positioning movement
amount

UM003F0
-UM003F1

UM004EA
-UM004EB

UM005E4
-UM005E5

UM006DE
-UM006DF

Dwell time UM003F2 UM004EC UM005E6 UM006E0

Reserved for system UM003F3 UM004ED UM005E7 UM006E1
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13.6 Dimensions

(Unit: mm)

13.6 Dimensions
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Record of changes

Manual numbers can be found at the bottom of the manual cover.

Date Manual No. Record of Changes
Apr. 2016 WUME-FP7MXY-01 1st Edition

Apr. 2016 - -
Error correction
● Corrected terminal layout diagram and

external connection diagram (Section 3.1.2)
● Correction common method for input

specifications (Section 3.1.3)
● Corrected other errors.

Sep. 2016 WUME-FP7MXY-02 2nd Edition
Added model
● H type AFP7MXY32DWDH
Added functions
● Added Interrupt Start Condition
● Added Pulse Output Start Logic
● Added error annunciation specifications

Jun. 2022 WUME-FP7MXY-04 4th Edition
Changed manual format

May 2023 WUME-FP7MXY-05 5th Edition
Add Push-In Connector
"3.4.1 About Push-In Connector"

Apr. 2024 WUME-FP7MXY-06 6th Edition
Change in Corporate name
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105-FADBU-RD-04(R1)

Order Placement Recommendations and Considerations 

The Products and Specifications listed in this document are subject to change (including 
specifications, manufacturing facility and discontinuing the Products) as occasioned by the 
improvements of Products. Consequently, when you place orders for these Products, Panasonic 
Industry Co., Ltd. asks you to contact one of our customer service representatives and check 
that the details listed in the document are commensurate with the most up-to-date information. 

[Safety precautions] 
Panasonic Industry Co., Ltd. is consistently striving to improve quality and reliability. 

However, the fact remains that electrical components and devices generally cause failures 
at a given statistical probability. Furthermore, their durability varies with use environments 
or use conditions. In this respect, check for actual electrical components and devices under 
actual conditions before use. Continued usage in a state of degraded condition may cause the 
deteriorated insulation. Thus, it may result in abnormal heat, smoke or fire. Carry out safety 
design and periodic maintenance including redundancy design, design for fire spread prevention, 
and design for malfunction prevention so that no accidents resulting in injury or death, fire 
accidents, or social damage will be caused as a result of failure of the Products or ending 
life of the Products. 

The Products are designed and manufactured for the industrial indoor environment use. Make 
sure standards, laws and regulations in case the Products are incorporated to machinery, system, 
apparatus, and so forth. With regard to the mentioned above, confirm the conformity of the 
Products by yourself. 

 Do not use the Products for the application which breakdown or malfunction of Products may 
cause damage to the body or property. 
i) usage intended to protect the body and ensure security of life
ii)application which the performance degradation or quality problems, such as breakdown,

of the Products may directly result in damage to the body or property
It is not allowed the use of Products by incorporating into machinery and systems indicated 

below because the conformity, performance, and quality of Products are not guaranteed under 
such usage. 
i) transport machinery (cars, trains, boats and ships, etc.)
ii) control equipment for transportation
iii) disaster-prevention equipment / security equipment
iv) control equipment for electric power generation
v) nuclear control system
vi) aircraft equipment, aerospace equipment, and submarine repeater
vii) burning appliances
viii) military devices
ix) medical devices except for general controls
x) machinery and systems which especially require the high level of reliability and safety

[Acceptance inspection] 
In connection with the Products you have purchased from us or with the Products delivered 

to your premises, please perform an acceptance inspection with all due speed and, in connection 
with the handling of our Products both before and during the acceptance inspection, please 
give full consideration to the control and preservation of our Products. 

[Warranty period] 
Unless otherwise stipulated by both parties, the warranty period of our Products is three 

years after the purchase by you or after their delivery to the location specified by you. 
The consumable items such as battery, relay, filter and other supplemental materials are excluded 
from the warranty. 

[Scope of warranty] 
In the event that Panasonic Industry Co., Ltd. confirms any failures or defects of the Products 

by reasons solely attributable to Panasonic Industry Co., Ltd. during the warranty period, 
Panasonic Industry Co., Ltd. shall supply the replacements of the Products, parts or replace 
and/or repair the defective portion by free of charge at the location where the Products were 
purchased or delivered to your premises as soon as possible. 
However, the following failures and defects are not covered by warranty and we are not responsible 

for such failures and defects.  
(1) When the failure or defect was caused by a specification, standard, handling method,

etc. which was specified by you.
(2) When the failure or defect was caused after purchase or delivery to your premises by

an alteration in construction, performance, specification, etc. which did not involve
us.

(3) When the failure or defect was caused by a phenomenon that could not be predicted by
the technology at purchasing or contracted time.

(4) When the use of our Products deviated from the scope of the conditions and environment
set forth in the instruction manual and specifications.

(5) When, after our Products were incorporated into your products or equipment for use, damage
resulted which could have been avoided if your products or equipment had been equipped
with the functions, construction, etc. the provision of which is accepted practice in
the industry.

(6) When the failure or defect was caused by a natural disaster or other force majeure.
(7) When the equipment is damaged due to corrosion caused by corrosive gases etc. in the

surroundings.

The above terms and conditions shall not cover any induced damages by the failure or defects 
of the Products, and not cover your production items which are produced or fabricated by using 
the Products. In any case, our responsibility for compensation is limited to the amount paid 
for the Products. 

[Scope of service] 
The cost of delivered Products does not include the cost of dispatching an engineer, etc. 
In case any such service is needed, contact our sales representative. 

Panasonic Industry Co., Ltd. 
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Panasonic Industry Co., Ltd.
1006, Oaza Kadoma, Kadoma-shi, Osaka 571-8506, Japan
https://industry.panasonic.com/

Please visit our website for inquiries and about our sales network.
© Panasonic Industry Co., Ltd. 2016-2024
April, 2024
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